
POWER AMPLIFIER KALKULATOR SPREADSHEET USER GUIDE

 FOR PAK-1V0-NM 
 (Non Macro version). User Guide compiled 1 November 2012 

available from [PakLaunchSite.jimdo.com] 
 free under Creative Commons share alike attribution license version 3.0 

( http://creativecommons.org/licenses/by/3.0/ ) 

An open source spreadsheet for evaluating transistor power

amplifier circuits using large-signal explicit equations involving

the Lambert W-function. Explicit solutions for currents, voltages

and gains can be now written for many elementary circuits using

the inverse of the Lambert W-function.

Example for a simple Push-Pull output stage using large-signal equations (Sheet 14) 

Shows calculated currents, gains and distortions at optimum quiescent current of 90mA. 
Unlike SPICE Newton-Raphson is not used. PAK plots THD at each input voltage step 

(SPICE does not plot multiple THD's like this). Covered in Section 15.
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Preface
The aim of this public project is to compile a library of royalty free transistor circuit solution 
including elementary current mirrors, current sources, differential amplifiers (LTP), push-pull 
output stages. Previously, the only way to find the current, gain and distortion in a transistor circuit 
was to solve the equations numerically using a simulator such as SPICE. But now using Thomas 
Banwell's examples, bipolar amplifiers can be solved analytically and large-signal currents, 
voltages and gains can be calculated directly rather than simulated. Distortion can also be estimated. 
Designers can see how a circuit works and behaves in symbolic form at the large signal level and 
can optimise circuits better for a lower distortion or a lower temperature drift.

It was originally hoped that the elementary circuits in the PAK spreadsheet can be used as building 
blocks for complete power amplifier circuits solutions. It was found that transistor circuits that use 
global negative feedback remains unsolvable in an exact form. Approximate solutions have been 
found in most cases that are sufficiently accurate for many situations. Recursion can then be 
invoked to reduce the residual error to any required level without fear of non-convergence. Finding 
good approximations is a time consuming task and this project should help to spread the workload.

This spreadsheet and User Guide could be developed into a web 'Wiki' if there is sufficient interest 
and support. If you can help see Feedback.

This spreadsheet and User Guide can be integrated into teaching material without cost but copyright 
laws still apply under the terms of the Creative Commons share alike attribution license version 3.0 
[http://creativecommons.org/licenses/by/3.0/] although a copyright waver is granted to small 
portions ('small' being defined as no more than a total of one A4 page of normal print material). 
PAK equation solutions give valuable insights into SPICE models and their limitations for students 
and designers. 

Why the '-NM' (Non Macro) version? It completely removes any danger of malicious macros being 
propagated through the spreadsheet. The '-NM' version requires more columns to calculate the 
equations than a macro version ('-ME' or Macro Enabled). Spreadsheet User Defined Function's 
(UDF's) allow in-line BASIC style of coding which makes a '-ME' spreadsheet compact. UDF's also 
allow recursion for more accurate result with approximated solutions. Recursion in a '-ME' 
spreadsheet is the next level of development for PAK. Anyone is invited to work on this aspect. It 
would be good if PAK-NM is developed as well as a virus-free environment for educational use.

A futuristic role for PAK is to eliminate the remaining non-convergence problems in SPICE related 
to exponential terms in diode and transistor models. The developers of SPICE did not have the 
Lambert W function solution available so their diode and transistor model equations involve 
exponential functions without the physical limitations on slope at high and low currents due to 
realistic series and shunt resistances. Now the diode and BJT models can be reformulated to 
eliminate most of the remaining non-convergence problems in SPICE. 

To be clear, the PAK spreadsheet is just a framework to demonstrate the circuit equations by 
providing plots like a SPICE simulator. Worksheets can be distributed to others to 'Run' them 
similar to SPICE simulators. This User Guide contains Tutorial help to get started. Developers of 
new circuit equations can learning from the examples provided in the User Guide. Developers are 
encouraged to use the original PAK format to ensure their worksheets are compatible with other 
PAK users. See the User Guide for the format rules and branch versions.

Free eBook EditionFree eBook Edition
p4        Power Amp Kalkulator User Guide PAK-1v0-NM November 1, 2012  Contents 

http://creativecommons.org/licenses/by/3.0/


 POWER AMPLIFIER KALKULATOR

SPREADSHEET USER GUIDE

Chapter 1
Working with this spreadsheet
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 1. QUICK HELP FOR PAK-1v0-NM SPREADSHEET
Table 1. A 'How To' summary for the PAK spreadsheet

View a circuit Go to a circuit - Click bottom-left tab eg Sheet4 

Run a circuit Go to a circuit, Turn a circuit ON, type ON (u/c or l/c) in the cell, Enter.

View a plot View the graph. Plots can be moved to anywhere convenient to see changes. Each plot 
should have a Title (eg in the X-axis caption area).

Move a plot
Click to select the plot. Drag with the mouse. When changing a parameter mode the plot 
to the same area to see the changes in the plot. You can also relocate the Plot Pointer 
array to under the plot (to turn ON/OFF any of the curves).

Move the 
PlotPointer

Select the Plot Pointer array and title. Cut (Ctr+X) and paste in the first cell of the new 
position (usually under the plot).

Turn a curve 
OFF or turn 
another ON

The Plot Pointer array is the same order as the legend for each curve apart from the first 
cell which is the X-axis pointer. If you want to turn off the 3rd curve in the legend list 
then change to 4th pointer cell and enter the column with 'Spare'. (A pointer entry can 
also be deleted but Calc then displays 'Error 505').

Change curve 
to different 
series

Read the column letter for the new data series to display, then the first cell ref of that 
column, enter this cell reference in the Plot Pointer at the cell for the new data series (eg 
an empty pointer cell). More curves can be added -- see the User Guide.

Zoom and/or 
offset a curve

Right click on the X-axis or Y-axis main bar. Choose Format Axis, Scale, then enter Max 
and Min values to zoom and/or offset. Use Undo to return to the original view. Create a 
duplicate using Copy/Paste if you want to keep a custom zoomed view.

Copy Plot
Click to select plot. Copy & Paste to another sheet or document. If a document can't 
accept the format use 'PrtScr' key then Paste into a picture program eg MS Paint, select 
graph, then Paste (or Save As then import a Picture from File).

Modify a 
component 
value

To change all values in a column you only change the top number (under yellow row). A 
copy equation makes all values below the uppermost one the same value.

Modify a Step 
range

Stepping a component or voltage generates a plot. The yellow cell is set as the starting 
value, the next cell copy equation uses <Cell>+1/<N> to increment by a small amount. 
Copy down from the first cell to update each cell in the column. View the graph. 

Step a 
different 
component or 
voltage

First turn off the presently stepped component. Remove 'Step' after the component name. 
Add an appropriate increment to the second cell then drag-copy down to update the 
column. Add "Step" after the component name for the plot Legend. Change the first X-
axis pointer to the new stepped column. View plot and adjust the increment to suit the 
range.
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 2. A tutorial for getting started 
for Spreadsheet PAK-1v0-NM (Non Macro version)

1. Run the spreadsheet. A spreadsheet can be saved to open at the last worksheet area. This is 
useful if you want someone to look at a particular view such as a plot. To work through this 
tutorial Run the program and then choose Sheet3 (see Figure 2.1) 

The Contents list appears the 
same on all sheets except the 
highlighting changes

To select a different sheet  
clicking on the Sheet tab at the 
bottom

Figure 2.1. Contents is the same on all sheets except for the highlighting

2. CTRL+Home key returns you to the Contents. The Contents appears the same on all the 
sheets since it is copied using equations from Sheet1 Contents. The current worksheet is 
highlighted yellow. 

The page to the Right of Contents is the circuit page, see Figure 2.2 showing one of Sheet3 
circuits. The on/off switch can be used to turn off large spreadsheets when not in use to prevent 
them slowing down other sheets. Figure 2.3 Left screen shot shows AR and AS columns OFF 
and the columns show “n/a”. Right screen shot shows the cells ON. 2. The ON/OFF switch only 
disables the calculation cells used for the circuit, it does not blank out the data area. This can be 
useful if you want to see which is data separate from equations results. Notice also the 
calculation area header background is blue-grey and the data area header is grey.
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Spreadsheet version
and creation date

Circuit diagram 
for this sheet

Turn on/off (turned off large ones when not in use)

 

Figure 2.2. Circuit diagram and the equation On/Off switch

  
Figure 2.2a. The ON/OFF switch disables the calculation cells but not the data area. 

Left shows AR and AS columns OFF showing “n/a”. Right shows the cells ON.

3. Figure 2.3 shows various areas in the data entry section. Part of the plot area is obscured 
and to see the plot use the scroll bar or mouse-roller to move around. Change to Normal View 
for most things select View>Normal. (Before closing the spreadsheet it is helpful to set the view 
to Page Break View and place the cursor on the sheet number). 

This circuits input voltage Vin is swept from 0 to 1.2V. 

Values for components are set or changed in the top one only – all the values in the column 
change once you press enter. This is done with an equation in the second row that copies the 
first row, then the second is copied down. 

With mouse-over on a curve you can read the value at that point (x,y) and identify the 
parameter name easier than using the legend. The legend is useful to tell you what curves are 
plotted (it's not so easy to see which one is which).
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Horizontal scroll barDrag Legend

The TOP cell changes ALL values under it  (enter data in the top row only)

Drag plots anywhere (eg to where you change a value). Enlarge plots.

You change
curves easily

Cursor-over for values

CommentsCircuit title

Swept values

 

Figure 2.3. Various areas in the data entry area. Part of the plot is obscured. Use the scroll 
bar or mouse-roller to move around. Use View>Normal for most things and View> Page 
Layout when finished.

4. Use the spreadsheets Undo and Redo as a to repeat changes (mouse click on the icons) – 
look carefully at the plot area and you should see how curves change. Hint: drag the Plot to 
above where the area value is to be changed to see the curves move repeatedly using Undo and 
Redo.

5. Plots can be modified in many ways but it is not so easy to scale just one curve relative to 
the others. The easiest way is to copy a plot and paste it nearby, then remove the plots that are 
the largest so the smaller ones can be displayed (plots have Auto scaling on by default). Another 
option is to Insert a column next to the one to be scaled, then use an equation to scale the 
original one and change the plot pointer to the new scaled column. A temporary way to zoom is 
to zooming-all by right-click on the Y-axis and choose Format Y-axis, choose Scale and set the 
Y-Max and Y-Min to a suitable zoom range. When done use Undo to return to original scaling. 
It seems best if the scaling is left on Auto (ticked boxes) so changes in sweep ranges are 
automatically tracked.

Other things that can be changed in plots are the background shading can be turned off, the 
legend font type and size can be changed, the legend area can be moved or enlarged.

6. The plot-array sets which data appears in the plots (Figure 2.6). There are 8 user settable 
plots plus the x-axis. Normally the plot array is parked above the plotting columns at the right-
hand end of the spreadsheet but it can be Cut/pasted to anywhere you like. 
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Pointer array – change the letters to the column
 you want to plot 

X-axis pointer 
Headings are imported automatically from 
the column headings (once you enter the 
pointer cell)

Figure 2.6. The Plot Array (the top orange row). It sets which data gets into the plot area

The Pointer Array allows the plots to be changed easily without repeating the Chart Wizard. It 
allows one X-axis and up to eight Y-axis curves in X-Y 'scatter' format. Try changing the plot 
pointer H71 to GV71 and you will see the new heading appear below it and then in the plot 
itself. Note the Legend has been changed to the new heading. 

7. There is a Quick Help guide in the spreadsheet (Sheet1 below the Intro page). This area 
that can be printed from the spreadsheet (page 3 of sheet1 but always check Preview first). The 
same sheet is printable from this User Guide (see Quick Help) 

8. The PAK spreadsheet uses a subset of SPICE transistor and diode models (SPICE 
MOSFETs can be included too!). Figure 2.3 shows diode parameters Is and Rs. These 
parameters can be Copy/Pasted from Sheet2 Model Library. Notice in the Library there are 
columns of parameters. The first library 'block' is used by permission, courtesy of Bob Cordell 
from www.CordellAudio.com. You can also Copy/Paste any model variants that you want to 
keep from your worksheets back to the Model Library (Sheet2). 

This introduction to PAK should allow you to find your way around and play with settings and 
plots. The next Section 3 provides a list of the circuits and their development status. Section 4  of 
this chapter provides brief explanation of how PAK differs from a SPICE simulator. Chapter 2 
provides more help if you want to create your own Spreadsheet sheets and plot the results. Chapter 
3 provides help if you want to create your own equations and check them against LTspice plots. 
Chapter 4 covers the derivation of the equations used in the LTspice circuits and in the PAK 
spreadsheet.

… continues to Section 3
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 3. Table of Circuits in PAK-1v0-NM spreadsheet
 Table 3. Circuit solutions in PAK-1v0-NM at 1 November 2012 

Sh
ee

t

Topic
Variants

Future?
(wish list)See 

Footnote No's
In 

UG?
In 

SS?
1  How PAK spreadsheet works N/A √ N/A - -
2  How to derive equations N/A √ N/A - -
3  Solving Diode & R circuits √ √ 2,8
4  Solving single BJT circuits 1,3,4 √ √ 2,5
5  The Complementary pair 1,3,4 √ √ 2,5
6  The CE plus CC pair (VAS+VF) 1 √ √UC 2,3,4,5
7  The Darlington pair √ UC* 1,2,3,4,5
8  The Differential pair √ √* 1,2,3,4,5
9  Current Mirrors √ √ Wilson
10  Current Sources √ √ 1,2,3,4,5
11  Vbe multipliers √ √ 1,2,3,4,5
12  Basic push-pull output stage 1,4 √ √ 2,3,5,6
13  CFP Push-Pull output stage 1 √ √ 2,3,4,5,6
14  Darlington PP output stage 1 √ √* 2,3,4,5,6
15  Distortion estimates (CE) 1,7 √ √* 2,3,4,5,6
16  HF frequency effects (CE) - - - SE & PP
17  [Spare]
18
19
20 SIT SE Common Source pending v1.1

Notes: SE Single Ended, CE Common Emitter, CC Common Collector (aka VF Voltage Follower), PP Push Pull, FB 
Feedback, NFB Negative Feedback. * earlier equations (usable – awaiting an update)  
Variants: 1 Vce saturation, 2 includes Tj, 3 includes Early effect, 4 includes Rin>0, 5 includes Beta-fall, 6 includes 
HF roll-off, 7 includes TLD (not self-heating), 8 includes self-heating, 9 [spare], 10 [spare]. 
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 4. Overview of PAK-1v0-NM Spreadsheet
PAK-1v0-NM spreadsheet directly calculates currents in a circuit using the general solution 
equations for each type of circuit. The spreadsheet is a way to view the plots from these circuit 
equations. This User Guide Chapter 4 provides details on the derivation of the equations used in the 
PAK spreadsheet in. 
Each circuit type requires a custom equation set. The PAK spreadsheet allows X-Y oscilloscope like 
chart plotting that is user-selectable so you can change to another set of results without having to set 
up a new chart each time. (Spreadsheet programmers do not make it easy to assign an arbitrary 
range of cells to data labels in a chart, according to John Walkenbach's Excel 2002 Review at PC 
World www.pcworld.com/article/49607/first_look_excel_2002.html]). 
General solutions for bipolar transistor circuits were not available until the year 2000 some 50 years 
after bipolar transistors were developed. Now, 10 plus years later, very few circuit solutions had 
been worked out. This spreadsheet covers a few of the basic building blocks for audio power 
amplifiers. This spreadsheet also provides a way to solve more of the elementary circuits in an open 
source framework. 
The first version of PAK is limited to making solution details public through the User Guide but it 
could be done more quickly and efficiently using Wiki software [Comparison_of_wiki_software]. 
Anyone interested in moderating and hosting a site should see Feedback.

PAK-1v0-NM spreadsheet is arranged with each circuit type or topology on a separate worksheet. A 
worksheet from one persons spreadsheet can be imported to another using Copy/Paste to a blank 
sheet with the caveat that no cross-sheet linking is used (the one exception is the Contents list from 
Sheet1).
SPICE models are used in PAK. They are the DC parameters and a few AC parameters for later 
PAK versions that will include HF analysis. Temperature dependency parameters will also be 
included in later PAK versions therefore the PAK library of models should include temperature 
parameters from the beginning.
Within a worksheet several circuit variants can be run. Each variant 'block' has 10 or 20 rows with 
one variable stepped by incrementing values in that column. You can step any variable, but only one 
variable at a time in each block. Each block includes an ON/OFF switch to turn off blocks that are 
not needed and are slowing down calculations (with only a few sheets in a spreadsheet all circuits 
can be left ON). The Tutorial in the previous of this chapter demonstrated these features (Section 2).
PAK-1v0-NM spreadsheet is targeted for OpenOffice.org Calc. It can run under Excel without any 
changes. To convert the OpenOffice version use Save As Excel 97/2000/XP (.xls) file (being the 
latest option in OOo-Calc v3.3). Chapter 2 lists known problems and things to avoid to ensure cross 
compatibility. The Excel version runs about 2 times faster than Calc and Excel has some useful 
editing features not available in Calc such as changing a chart legend order and global sheet 
changes. However, Open Office Calc editing of equations provides a readout of partial results for 
debugging functions within functions providing a tree listing.
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 POWER AMPLIFIER KALKULATOR

SPREADSHEET USER GUIDE

Chapter 2
Customising aPAK spreadsheet
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 1. Guidelines for customising the PAK spreadsheet
Thank you (in anticipation) for contributing to PAK. 

General guidelines for contributors:

• This is an Open Source project so your contribution must be given in accordance with the 
Open Source Licence. This Licence allows your additions to be distributed and/or modify 
under the terms of the Creative Commons Attribution License, version 3.0 
[http://creativecommons.org/licenses/by/3.0] or later, and of course all trademarks 
mentioned belong to their legitimate owners. 

• Anyone is welcome to add anything from PAK User Guide material to other Open Source 
projects such as Wikipedia with appropriate acknowledgement of the source and author(s) or 
by citing as a reference. I would be pleased to assist anyone wishing to include any of the 
PAK User Guide material in teaching aids such as textbooks or course material (depending 
on the availability of free time). Developers of simulators are also welcome to include any 
of the PAK equations or User Guide material in their software under the terms of the 
Creative Commons share alike attribution license, version 3.0 or later 
[http://creativecommons.org/licenses/by/3.0].

• By adding to this User Guide document or a PAK spreadsheet or providing links from this 
document to a website you are thereby agreeing to the Creative Commons Attribution 
License for all that material. 

• If anyone is interested in starting and/or operating a User Group or a Blog page for PAK 
then please see Feedback. A Google search may provide a quicker way to see new 
developments or new contact details.

• An editable OpenOffice .odt User Guide is available on request via Feedback. Please 
include some information on any changes or additions you wish to make to the User Guide 
or to your version of the PAK spreadsheet. Please enter a contact address either in the added 
chapter or add a 'mailto' hyperlink in 'Brief description' cell of the 'Modifications and 
updates' section of page 2. 

• Please use the standard formatting rules for PAK. These are outlined below (more may 
appear later). Format rules aim to preserve forward compatibility with similar spreadsheets. 
For example, User A with an old version of PAK can export to User B with a more recent 
PAK spreadsheet version. 

• Format rules also aim to make PAK extensible (expandable) to allow a large (or small) 
number of circuits. One circuit topology is assigned to one Sheet. No inter-sheet cross 
referencing is to be used to other sheet to allow one sheets to be exported to other 
spreadsheets as a stand alone circuit solution. Sheets can be given meaningful names. Eg, 
“JDcct1” and as short as possible. 

• Another aim of standard PAK formatting is make the spreadsheet “printer friendly” (if such 
a thing is even possible). When PAK is run under Excel 2002 (ver 10 for XP) or under 
OpenOffice Calc there are minor differences that can upset a page layout. Excel and Calc 
handle Header & Footer and margins slightly differently (see details later). The OpenOffice 
Calc default Row Height and fixed Column Width should be used for all cells in the 
spreadsheet and no column widths should be changed from the default (see below if you 
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want wider columns using merging).

• Anyone can develop alternate (branch) spreadsheets that are not compatible with the original 
(or future) PAK versions. Incompatible versions with the original PAK-1v0-NM spreadsheet 
should not include “PAK” in their name to avoid confusion. 

 1.1. Excel and OpenOffice.org Page breaks for printing 
Note: The printing margins in PAK are not the default settings for either Calc or Excel so they must 
be manually set if you create a spreadsheet from scratch. Assuming A4 paper use the following 
settings: Left & Right 1cm, Top & Bottom 1.5cm. Header and Footer in Excel are defined 
differently to Calc – in Excel Page Setup set Header and Footer to 1.5cm and Top & Bottom to 2cm. 
Calc uses the AutoFit default so Calc does not need non-standard settings for the Header and Footer 
section.

PAK spreadsheet uses the OOo-Calc default Row/Col spacings

PAK spreadsheet uses the OOo-Calc default Row/Col spacings to (try to) ensure the page view is 
consistent when converting to Excel. This is because Open Office Calc has the larger of the default 
column spacing. 

Please do not change any Column spacings in the PAK spreadsheet

If you need a wider column to display text longer than 10 spaces then merge two adjacent column 
cells then to get a block of merged cells drag to copy down as many as are required. (The merge in 
Excel is the icon next to the Align Right icon). Similarly to get more height for larger fonts etc then 
merge two adjacent row cells. If you want to un-merge then select the area and click the merge icon 
again (it's the same procedure in OOo Calc). 

Please use the standard formatting rules for PAK. These are outlined below (more may appear 
later). Format rules aim to preserve forward compatibility with similar spreadsheets. For example, 
User A with an old version of PAK can export to User B with a more recent PAK spreadsheet 
version. 

Format rules also aim to make PAK extensible (expandable) to allow a large (or small) number of 
circuits. One circuit topology is assigned to one Sheet. No inter-sheet cross referencing is to be used 
linking to other sheets – this is for stand alone circuit solution to allow a circuit solution sheets to 
be exported to other spreadsheets “as is”. Please give shared Sheets a human readable (meaningful 
name), eg, “JDcct1” and try to make it as short as possible. 

 1.2. Formatting for Sheet1 –  Contents & Help sheet 
1.  See Figure 1.2 (or Sheet1 of the spreadsheet). Each Sheet in PAK starts with the same 

Contents information as Sheet1 Contents. The Contents page of Sheet1 contains the header 
“PAK Power Amplifier Kalkulator Spreadsheet” in Cell B1:G3. Cell B1:G3 is merged as one 
cell. Cell A1 is the current version “PAK-0v1-MN” and Cell A2 is the creation date.

2. The comment “Contents list is copied from Sheet1 –  change Sheet1 ONLY” is a message 
intended to remind us that you must change the Contents page information by going to Sheet1. 
This is because the Contents cells in Sheet1 are copied into all other Sheets using equations (so 
only cells with information are copied and empty cells still show as empty).
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Figure 1.2: The Contents section. Sheet1 has its heading highlighted.
3. Sheet1 is set up to be printed to A4 Portrait. The default setting for PAK is “Page Break 

Preview” to view a full page and the Zoom is preset to 55% (the default is 60%). Before you 
print always check the print boundaries using File>Print Preview. This will show whether the 
Header and Footer cause unexpected page breaks. The print order is set to Over (horizontal) 
then Down. Notice the Quick Help Guide is Page 3 and can be printed from the spreadsheet (or 
this User Guide), first read the page number in Print Preview (eg page 4) and in the Print 
options enter this page number (eg 4 to 4). Alternatively select the Quick Help Guide area and 
use File>Print and choose 'Selection'.

4. Page break bottom setting. The best position for the bottom of the sheet print boundary line 
is row 59 (assuming default Row and Column values – see Section 3.2 for default settings).

  Figure 1.2a.
5. The Contents list can be extended to the area below for more circuits than the first 50 on 

page 1. All other Sheets need to have this area reserved for future Circuit entries (but you can 
park plots in that area at any time).

6. An additional Help page is available from cell I121 (as page 6).

 1.3. Formatting for Sheet2 – Model Library sheet 
1. The Model Library sheet can be used in whatever way you like. PAK 1.0 is supplied with 

Bob Cordell's model library with permission from www.cordellaudio.com. You Copy/Paste a 
model set from this sheet to the equation area for your circuit equations. Usually you copy only 
those parameters that are relevant to your circuit equations. Do not use cross referencing in your 
equations to Sheet2 cells so your sheet can be used in other's spreadsheets (and their spreadsheet 
may have a different Model Library to yours!).

2. The standard view is Page Break View. But to work on a sheet return to the Normal View 
(View>Normal, or speed keys Alt V N. To return to Page Break View Alt V P.

3. The model data list begins at Cell L2 (Page2). This allows longer text entries to spill into 
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Columns J & K using the Center format for the entire Column L (see Figure 1.3) 

Figure 1.3.
4. If you have changed a Model's parameters and want to save your custom version then you 

can Copy/Paste them back to Sheet1 for archiving. If you want to create more space below the 
original model then select a block (eg J10:AO10) and Insert>Shift Down. Don't select the entire 
column to insert because this upsets the Contents page. The same applies to any sheet when 
Inserting a Row – only select a local block – never an entire Row. 

5.  Parameter entries can be printed. If you only want to print the list of model names then 
either select the area and use Print>Selection.

6.  Future parameter lists may include non-SPICE parameter labels to suit Label recognition of 
equation variables by the spreadsheet. EG: Rb, Rc, Re may be changed to Rbp, Rcp, Rep in 
future to avoid confusion with external resistors labelled as Rb, Rc, Re (the suffix 'p' refers to 
'parasitic' meaning internal resistances to the transistor). A spreadsheet may become available in 
future to import and rename such parameters for complete library files with minimal human 
input (Section 2.4 pending).

 1.4. Formatting for Sheet3 and all others – Circuit Equations sheets
1. As mentioned each Sheet in PAK starts with the same Contents information as Sheet1 

Contents. See Figure 1.4 for Sheet3 (or go to Sheet1 of the spreadsheet). 

Fig1.4
2. The standard view is Page Break View. But to work on a sheet return to the Normal View 

(View>Normal, or speed keys Alt V N. To return to Page Break View Alt V P.
3. Variants: A circuit sheet can contain any number of 'variants' of a topology. A 'variants' could 

be the same circuit but with a different parameter is stepped. These are standard for SPICE 
users. A 'variant' may include different model levels where some parameters are disabled to see 

Free eBook EditionFree eBook Edition
p17        Power Amp Kalkulator User Guide PAK-1v0-NM November 1, 2012  Contents 



their effect. Each variant is a separate block of equations, generally starting on the next page 
below to leave extra space if needed for a larger step range. Note in Fig 1.4 the Contents 
includes a column for the variants presently defined in each Sheet.

4.  Each circuit Sheet contains a circuit image on Page2 and further circuits are added below it 
(and then on the next page below Page2). There is no limit to the number of circuits that can be 
added to a Sheet – it is only constrained by system RAM and processing speed. 

5. Each circuit image can have any number of equation blocks (for parameter stepping). The 
first equation block starts at cell R3 being one column beyond the start of the 3rd sheet (see 
Figure 1.4a). Cell R2 is used for the Circuit Title which is generated using ="CIRCUIT 
"&A8&" "&B8&" - "&L26 where A8 and B8 are the Contents text and L26 is the text added 
just below the On/Off switch cell. 

 Figure 1.4a.
6. A whole block can be copied to create another variant. You only need to copy the top 5 rows 

(because you can create all the others later by drag-copy down (see next).
7. In PAK you use drag-copy down to extending the parameter sweep range. You copy the 2nd 

row of equations because the first row is reserved for entering values. The second row copies 
the first row data with an equation, so the second row is the first row that is the same for all 
rows below it. (It all makes sense when you see how it's done and why). 

8. Figure 1.4b shows the circuit equation area (for Sheet3). It appears after the components 
and models are defined. The Vt column is standard in circuit equations and is highlighted to 
show where the circuit equations start. The circuit equation section background is also changed 
(to Blue Grey).

  Figure 1.4b.
All equations in the circuit equation section include the common equation 
“=IF($B33="OFF","n/a","eqn")” where $B33 is the cell references ON/OFF column at the start 
of the block (which in turn references to the On/Off switch cell (eg Cell M25). Note this 
equation is not used in any of the data entry cells. You enter your equation at the end in place of 
“eqn” (no equals is used since it is provided by the “=IF” part).

9. Next is the plot area. The first part is greyed out because it should not be changed. It is a 
pointer table for the main plot area, generally used for generating the X-Y plots like an 
oscilloscope. See Figure 1.4c. A section is included on creating an modifying plots.
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 Figure 1.4c. Plot are used for User Selectable plots
10. The Number formats that were found useful were Vin & Vsp & Re's as 3 decimal places. 

For high value resistors in the k or Meg range the following Custom format is useful 
##0.0E+0 eg 3k3 is 3.3e+3, or use ##0E+0 for no decimal places so 120k is 120e+3. Most of 
the general equation calculations can be done with general format (since very small numbers 
use exponents). For the final calculations such as IL or VL set the format to a more readable 
form. Note you can change your plots axis Number format to single digit increments once 
they are created.

 2. Creating and editing X-Y Charts in PAK
Charts are quite complicated to edit the source data settings. Usually it is quicker and easier to 
create a new chart then delete the old one (if it looks as you want). But if you need to edit an 
existing chart then the following may be useful.

 2.1. Have you added more rows and want to include them in an existing chart?
If you add more rows to an existing plot area then to include the new points in an existing chart you 
need to update the Source Data > Series and change the address range for all the X and Y series 
listed. If you have added more rows and want to increase the range for the plot data to include them 
then right click on the chart (double click first in Open Office Calc) then choose Source Data 

Figure 1.4d. Editing the Source Data range. You can see the present range selected.

Figure 1.4d shows the dialogue box. You click on the Data Range Icon (on the right) and you can 
view the present Data Range selected. You can drag the selection to where you want or you can type 
the new row number in the Data Range section. Click the X to close the smaller Data Range 
dialogue, and OK for the larger Source Data dialogue. View the plot. It should show all the new 
data.

 2.2. Have you created a new block and need to add a Chart? 
• Select the data area (AZ3:BH20 here). Notice this does not include the column with 'X-axis' 

(in this example exclude the AY column). 
• Choose Insert Chart (or Chart icon) for the Wizard, choose 'XY (Scatter)' > sub-type 'Scatter 

with data points' > Next > Check Data Range in Columns > Go to Series and view the 
Legend, if OK click 

• Enter a Chart Title (no need for X or Y titles), Grid-lines tick X-axis Major gridlines > Next 
check 'As object in Sheet#'. All done. The chart may need Y-axis scaling to give the best 
view (see the section Sheet style format on scaling Y-axis), eg, Format y-axis to Min 0, 
Max 20. If one plot is still too small then you need to insert a new column to create a scaled 
value to view it better in the plot with all the others (see the Sheet style format section on 
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Scale or offsetting only one curve).
• If you want to the X-axis to appear in the Legend then you need to add it as a Data Series. 

This means you can use the Plot Pointer to change which column of data is used as the X-
axis (without having to edit the X-axis Title test). To start: Right Click on the chart area, 
select Source Data, click Add Series, click the icon in the name panel, select the cell with 
'X-axis' (AY3 here) then select the cell below it (either hold the mouse and drag down or 
hod the Shift and second click on the cell below), click the X (close) and view the Legend 
(should show the X-axis as the last entry), click OK. Done. You can rearrage the Legend 
order in Excel (but not Calc).

 2.3. Or do you want to create a new block
The easiest way to create a new block is to copy the first 5 rows of an existing block. You don't need 
to copy the entire block since all the equations can be generated below the 4th using drag-copy. 
• Select a block of the first 5 rows all the way to the end of the plot area (R2:BI6 here). To do 

this click on Cell R2 then scroll to BI6 and hold down the Shift key, then click on BI6. 
• Copy (Ctrl+C). 
• Scroll to the cell where you want to start the new block, eg, click Q62 then Paste (Ctrl+V). 

You now have a new block ready to drag-copy. 
• To drag-copy down, click on the first cell (Q66 here) then scroll to the last (BI66 here). Drag 

the corner tab down (at BI66 here) until you have enough rows. You may need to check the start 
to see whether the stepped parameter is large enough then return to the scroll tab and move up or 
down. You are now ready to add a chart –  See the section on adding a chart.

 2.4. Or do you need to create a chart for the first time?
The easiest way to add a the equations that generate a chart area is to copy the first 5 rows of the 
plot area equations from another sheet (as seen in Figure 1.4d). 

To create the chart area equations from scratch you only need to enter the equations for 3 key cells 
and all the others are created by drag-copy. In our example the first cell is in the LHS pointer table, 
say starting at CU31 which contains =DF30 (ie first cell in the Pointer array). CU31 can be drag-
copied to DC31. 

The second key cell is CU32 =ADDRESS(ROW(CU31)+1,COLUMN(INDIRECT(CU31))) . All 
other cells from CU2:DCxx can be drag-copied from cell HL72 (horizontally then vertically). This 
completes the pointer table. These are set to grey to remind users not to edit them (select the area, 
Format>Cells>Font>Colour eg Grey 40%). 

The third key equation is in the plot table, say starting at DF31 enter=INDIRECT(DF30) . Cells 
from DF31:DN31 can be drag-copied , then select DF31:DN31 and drag-copy down. 

Set up a pointer array DF30:DN30 above the plot area. Enter the cells for the data you want plotted. 
The first one DF30 is usually the X-axis which will be the swept parameter usually near the start of 
the block, eg you could use A31 with is the row number 1-n as the X-axis values, but C31 is usually 
the first possible column that can be stepped. For any of the plot columns you don't want to use 
enter a reference to a spare column, ie it has the text 'Spare' in entered – this gets displayed in the 
Legend and prevents an Error in the plot data (helpful for Calc users). If you don't want the '0' to 
appear in the legend (for a blank cell) then enter a ' (the single quote) in the cell (it will be invisible 
too, but visible in the edit bar if selected).
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The last thing is to add the text 'X-axis' in a spare column to the left of the pointer area (DE31 in 
this example). This appears on the Legend so the X-axis parameter can be selected using the plot 
array, in this case the first cell in the plot pointer. So the next cell below being DE32 has the 
equation =DF31 ( first cell in the plot pointer). The remainder of this column can be left blank, or 
use '- (single quote plus minus) to place a minus sign as text in each unused cell.

 3. Known spreadsheet problems and solutions
 3.1. Converting from Excel 'xls' versions to OpenOffice Calc 'ods' (vice versa)
If you are working with Excel and want to globally change all sheets at once 

You can globally change all sheets at once but be careful and don't forget to turn off the 
global select after you have finished. To select All Sheets in a Excel, Right-click a sheet tab, 
and then click Select All Sheets on the shortcut menu. 

 Converting from Excel 'xls' versions to OpenOffice: 
Excel allows empty cell ranges to be set using ={0} but when converting to OpenOffice this 
converts to a null entry in the Data Range and when saved as an ods and reopened the plot 
crashes (it is converted to a copied plot table unrelated to the spreadsheet cells all but one 
plot is corrupted). 
This was found to occur when the text “X-axis Vin” is imported into the Legend table (to 
indicate which variable is currently used for the X-axis) and this is a very useful feature for 
this pointer-reconfigurable plotting regime. Creating the spreadsheet in Excel then importing 
to OpenOffice has some benefits; for successful conversions back to Excel (which opens, 
saves and runs faster) and default plot settings are better in Excel reducing the need to 
change OpenOffice plots (default lines are too thick in OpenOffice) and you can change te 
Legend order too. 
Work around: To prevent this plot crash enter the X-axis Range for the Legend for “X-axis 
xyz” (same as the other plot variable). Then for the Y-axis range set the range to the first cell 
below the “X-axis” “xyz” cells which is can be an empty cell of a “-” (dash using the minus 
key). If the Format Data Series>Options are set to Plot Missing Values is set to Gap then 
only one point appears on the plot while the Legend shows the line and marker. Any Spare 
plot lines can be reduced to a single point using this method. (Setting unwanted plot lines to 
be Invisible and No Symbol prevents the line from being selected to return it to visible! If 
this happens then Remove the Data Series (copy the Range for Name to clipboard first) and 
re-enter it.)

 Converting from OpenOffice Calc to Excel xls: 
An annoying thing when saving a Calc file in Xls (2000/XP) format is the Page Break 
Preview view loses the zoom setting. It is resets to 100% (but going the other way Excel to 
Calc retains the Excel zoom setting). 
Work around: To restore Excel to the standard zoom for PAK, select all the sheets (right 
click mouse on a sheet tab) then View>Zoom>Custom 60%, then turn off the Grouping of 
all sheets by clicking on a different sheet tab. You can see if sheets are all selected in the 
Filename (title) bar where it adds “[Group]”. If you need to reset the Normal view zoom, for 
PAK it is 85%. 

When converting between these the scaling of the plots seems to reset to their original aspect ratio. 
Also the legend can change its position. Knowing this, it may be better to not change the aspect 
ratio of the plots. 
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 3.2. Excel & OpenOffice Calc spreadsheet rows & column default settings 

Col Width Row width Font size # Char wide Padding L=R
Excel 1.77 cm 8.11 units* 0.47 cm 13.2 U 10 6 1 char ea
Calc 2.27 cm 12.3 units* 0.43 cm 12.2 U 10 8 1mm ea

*Units are number of character spaces (including padding)

How Excel and Ooo-Calc calculate column spacings:
Excel Opt. Col Width 10 Font =1.44+(n-1)*1.33
Scale by Font No/10 gives padding of 1 character on each side

Default setting is cm 0.2cm padding (1mm each side)
OOo-Calc Opt. Col Width 10 Font =0.2+n*0.1*2.54

Default Excel col width gives 6 x 10 Font characters (Excel 8.11 units, OOo-Calc shows as 1.77cm)
Default OOo-Calc Col Width gives 8 x 10 Font Characters  (OOo-Calc 2.27 cm, Excel shows as 
12.3 units).

 3.4. On Printouts
 Excel and OpenOffice.org Page View and Page breaks (for printing) 

PAK spreadsheet uses the OOo-Calc default Row/Col spacings

PAK spreadsheet uses the OOo-Calc default Row/Col spacings to (try to) ensure the page view is 
consistent when converting to Excel. This is because Open Office Calc has the larger of the default 
column spacing. 

Please do not change any Column spacings in the PAK spreadsheet

If you need a wider column to display text longer than 10 spaces then merge two adjacent column 
cells then to get a block of merged cells drag to copy down as many as are required. (The merge in 
Excel is the icon next to the Align Right icon). Similarly to get more height for larger fonts etc then 
merge two adjacent row cells. If you want to un-merge then select the area and click the merge icon 
again (it's the same procedure in OOo Calc). 

Open Office Calc has a slightly smaller default column spacing causing a difference of 1 row per 
page (60 rows/page for Excel and 59 for Ooo-Calc). Therefore a buffer of one row should be 
provided at the top of following sheets in case the page break settings return to their default in either 
Excel or Calc for some reason (they generally stay where they are manually set – seen as a solid 
page break blue line in page view). 

Page settings for Excel and Open Office are shown in the table below. These set the default page 
break positions. 

L/R margin Top/Bottom  Header/Footer
Excel 1 cm 1 cm 2 cm 2 cm 1.5 cm 1.5cm
Calc 1 cm 1 cm 1.5 cm 1.5cm 0.9 cm 0.9 cm

Excel margin settings are viewed in File>Page Setup>Sheet.
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OpenOffice.org Calc in Format>Page>Page or Header or Footer.

Note: The printing margins in PAK are not the default settings for either Calc or Excel! They 
must be manually set if you create a new spreadsheet from scratch (to follow the original PAK page 
format setting). Assuming A4 paper use the following settings: Left & Right 1cm, Top & Bottom 
1.5cm. Header and Footer in Excel are defined differently to Calc – in Excel Page Setup set Header 
and Footer to 1.5cm and Top & Bottom to 2cm. Calc uses the AutoFit default so Calc does not need 
non-standard settings for the Header and Footer section. 

Printing on Letter (US standard size) has not been tested. Hopefully printer setup options can handle 
printing A4 on Letter size.

The print direction can be set as down then across or vice versa. PAK has all sheets set to the default 
of across then down. Use print preview before printing and be sure to specify a range to prevent 
large numbers of unwanted sheets being printed.

 3.5. Excel equation label problems
 3.5.1 The Excel Label interpreter can messes up equations sometimes
Using Search/Replace to convert R/C addresses to Labels sometimes creates bad label names. When 
the label interpreter looks at the mess it suggests a problem fix, often by adding single quotes to 
various labels. Accepting this suggestion can convert double quotes to single quotes which is 
unwanted. EG the equation
  =IF($S5="OFF","n/a",Rc1_/Beta2+Re2_*(Beta2+1)/Beta2) gets converted to 
  =IF($S5='off',"n/a",'Rc1_'/'Beta2'+'Re2_'*(Beta2+1)/Beta2)
where the “OFF” is converted to 'off'. This does not prevent the equation from generating the 
correct numbers but now it cannot be copied down by dragging the corner handle. Worse, in Win7 
the program crashes when trying to edit this equation. Drag/Copy down gives (next cell down)
  =IF($S6=#NAME?,"n/a",'Rc1_'/'Beta2'+'Re2_'*(Beta2+1)/Beta2) and the error message 
“#Name?” in each cell below the first. Excel crashed trying to edit this in the edit bar.

A tell-tale indicator of this is the top equation when selected and clicked in the edit bar to show 
which cells are referenced selects one lonely cell about 40 rows below it that is unrelated to the 
equation labels (a mystery). 

To correct the equations fix the first equation with “OFF” then copy down. Check all other first 
equations for the same problem (either by copying down all in the first row equations, but only 
those with the IF($S$5 ….) test, or scan each cell in the edit bar using the right arrow for the next.

To prevent Search/Replace and the Label interpreter causing this problem in the first place add a 
single quote to the label in cell S3 to 'ON/OFF. This prevents ON/OFF from being interpreted as a 
Label name (without the quote the OFF is interpreted as one of two possible labels for that cell – 
may be useful sometime).

 3.5.2. Label name issues
Labels are very useful in spreadsheets – it allows complicated equations to be human-readable. Also 
editing a label name in the header automatically appears in all the equations (sometimes you may 
need to wait till an equation is edited to see the changes). Labels make it easy to transfer an 
equation from LTspice ABM's directly into a spreadsheet equation if the label names are set up the 
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same as the ABM equations (or very close apart from underscores).

But care is needed to ensure label names are not interpreted as specific cell references instead. To 
prevent say R2 from being interpreted as a cell use R2_ instead (the equations are still human-
readable). Some are not so obvious. Re2 is outside the Excel column limit (256 cols, it's 1024 in 
OOo) but Re has a special significance for some reason. Adding an underscore Re2_ is not be 
interpreted as a cell but the Label interpreter does not recognise the label and needs 'Re2_' with 
single quotes to accept the equation. Also Rc (without numbers) needs to be quoted as 'Rc' but I 
don't know why (or as Rc_ without quotes). You can use the label editor to automatically insert the 
quotes for all equations at once if you change Rc_ to Rc in the label header (it knows if it needs 
quoting).

A similar complication can occur if a label name includes brackets like We(X1) and can be 
interpreted as a function and searches for a label 'We'. To prevent ambiguity add single quotes to 
these sorts of label names 'We(X1)'.

Label names that do not include a numeral are generally acceptable (apart from a few exceptions 
mentioned). Three letters (or more) followed by a number are no problem. 

It is advised that two lettered labels with numbers that lie outside the present spreadsheets valid 
range of Excel which is 256 columns (last valid column is IV) should still include an underscore to 
make it compatible with future spreadsheets if/when the valid ranges are extended. Note OOo Calc 
with 1024 columns so to be compatible with Excel 2002 (for XP) you should not go beyond the 256 
limit. OOo Calc has a valid range includes 3 letters plus a number (first is letter 'A') so beware that 
Excel Label interpreter may recognise AAA1 as a Label, but in OOo Calc it will think it is a cell 
reference so the equations will not work in OOo!

Notes: Neither Excel or Calc recognise upper/lower case distinctions in Label names.

Both Excel 2002 and Open Office 3.3 recognise Names as Addressing and this function is active by 
default. To turn this function off, choose Tools - Options - OpenOffice.org Calc - Calculate and 
clear the 'Automatically Find Column and Row Labels' check box.

See Help “Naming cells” excerpt:
“If you want a name to be automatically recognized by Calc, the name must start with a letter and 
be composed of alphanumeric characters. If you enter the name in the formula yourself, enclose the 
name in single quotation marks ('). If a single quotation mark appears in a name, you must enter a 
backslash in front of the quotation mark, for example, 'Harry\'s Bar'.”

 3.6. Excel equation Exp(x) range limit
The Exp(x) function gives #Num error if x>710 or x<-20. The following can be used to hard limit 
the argument EXP(MIN(x,700)) to prevent an error. But this limits the range for the W(Exp(Y)) 
calculation and causes the calculated current to reach a limit below what it should actually be. The 
same limit also applies to OpenOffice Calc. 

An unlimited result for W(Exp(Y)) is needed for calculating currents. LTspice had a similar Exp(x) 
range error (from x>70) and the W(Exp(Y)) = (Y-1) x>70 to give unlimited range (Section 12.2.2). 
The equations for calculating W(Exp(X1_)) for unlimited Y is:
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=IF(X1_<700,LN(1+EXP(X1_))*(1-LN(1+LN(1+EXP(X1_)))/(2+LN(1+EXP(X1_)))),X1_-1)

A similar error occurred as a divide by zero in long equations in Sheet 12 block 2 “Sw1_”.
=1/(1+1/LN(1+(1+0.5*EXP(MIN(x,500)))/(1+EXP(MIN(-MAX(x,-35),500))) ))
where x more negative than -36 causes a #Div/0! error. This is prevented by the Min(x,35) function 
above [implemented using double negatives in MIN(-MAX(x,-35),500)].

==============<·>==============

 4. A spreadsheet tool for importing SPICE models
  [an 'importer' is under development] contact a developer, see Feedback 
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POWER AMPLIFIER KALKULATOR

SPREADSHEET USER GUIDE

Chapter 3
Working with circuit equations in LTspice 

Free eBook EditionFree eBook Edition
p26        Power Amp Kalkulator User Guide PAK-1v0-NM November 1, 2012  Contents 



 1. Introduction – Running circuit files
LTspice circuit files are supplied with the PAK spreadsheet in the download ZIP. These circuit files 
were used to validate the equations for the PAK spreadsheet equations. The LTspice circuit files 
have several uses:

1.  As a helpful Tutorial while working through the equations in Chapter 4. You can Run the 
circuits in LTspice and see the equations operating and generating the same plots as the user 
Guide. This interactive approach will help higher-level circuit analysis courses.

2.  They demonstrate how you can develop your own circuit equations and then check them 
against LTspice.

3.  They can be used to generate circuit drawings for importing into documents for course 
material or assignments and for sharing over the Internet.

If you have developed equations and want to add them to the PAK project then you can generate 
your own spreadsheet Sheet and if possible compile a new Section (or a new Chapter) for inclusion 
in a future version of the official the PAK User Guide. A developers section is planned at the 
PakLaunchSite.jimdo.com where work in progress can be viewed before an official public release 
(a login is required). For details visit the site.

The advantage of putting your equations in a spreadsheet is that they can be viewed by those who 
don't have LTspice (or don't know how to use LTspice). Spreadsheets are now a universal 
environment and can share files across nearly all computer platforms. 

 2. QUICK HELP – Getting started with LTspice ABM 
equations
The LTspice circuit files are supplied as standard with the PAK spreadsheet in the download ZIP 
file. You need to unzip these before running them. They do not need to be placed within the LTspice 
program directory tree as long as any model files are also present in your directory with the 
extracted files. Some of the circuits may require Cordell-Models.txt, and if this models file is not 
present then you can download it from www.cordellaudio.com.

To Run a file double click the ...asc file (not the ...plt file). This assumes you have already installed 
the LTspice program. LTspice can be obtained via BobCordell's site link – and while you are at 
Bob's site read about how to stop temporary files bloating your computer hard-disk, or get his 
Tutorial files if you want to learn how to use LTspice from scratch. Bob's tutorial circuits are best 
used with his book since several chapters are devoted to learning how to use LTspice from scratch 
(and some advanced things as well). 

3. PAK Circuits Overview
Figure 3.1 shows the various areas of a typical circuit file for PAK.
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Circuit A Circuit B Plot switch

Circuit A equations

Model definitions

User Functions

C
irc

ui
t v
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Plot helper

Figure 3.1 shows the various section of a typical circuit file for PAK

 3.1 Why use circuit pairs?
Most of these circuits are drawn as pairs in the circuit files  because they they usually similar where 
one circuit part is added to develop equations for a complete circuit. Often equations are built from 
the most basic form into a more complex version and this needs to be done step by step as more 
effects are included. Both circuits to be plotted together for comparisons and make it easier to 
develop equations for the next stage of equations. 

Circuit pairs have plotting switches that allow various curves to be turn ON or OFF without needing 
to delete previous curves. Generally you turn one circuit ON and the other OFF. This also allows for 
first-time users to view the plots shown in the User Guide. This works if the '...plt' file included with 
the same plot variables as the User Guide plots used (and most are set the same).

 3.2 Why include '.model ...' in circuits?
Circuits are placed at the top. Equations are in the middle area. Model definitions and User 
Functions are at the bottom area. When a lot of model definitions are needed then they can be 
placed on the RHS (for screens with a 'wide' aspect ratio). Alternatively they can be put into a 
special model file and called using the command line '.Include MyFile.txt'. 

By having model definitions on screen means you can custom set the models quickly and easily to 
suit your equations. For example, normally Beta-fall and Early effect are disabled while developing 
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lower level circuit equations. 

 3.3 Why use .Function?
User Functions enable complex formula that are used several times over to be defined only once. 
This reduces the number of Behavioural Current sources considerably. But there may be a limit to 
how many terms can be used in a Function because all the terms are 'flattened' into one equation 
before executing. You can see this if an error message is generated by bad syntax. One case did 
appear to overflow some limit, maybe it's a 256 character limit? If this happens then split the 
equation into parts with 2 ABM sources. 

A useful function is '.function Vk(Is,N,Req) {N*Vt*ln(N*Vt/(Is*Req)) -Is*Req}'. Vk is calculated a 
lot and this is useful if Req becomes a function of Vin (as in the CFP with Rbe added such as 
circuits “Fig5s4s5” and “Fig5s6”). But there's a catch –  you can't define '.param 
Vk=N*Vt*ln(N*Vt/(Is*Req)) -Is*Req' anywhere in the circuit when this function is defined 
because “Vk”is already allocated to the function (even if it is never invoked!). So you have to use 
another name like 'Vk1=N*Vt*ln(N*Vt/(Is*Req)) -Is*Req' (or use 'VkA=...' for circuit A).

 3.4 Why use “Plot Helpers”?
Several plot helpers are included. A 1A current source (I1) feeds a 1R resistor (label R1) and these 
generate a 1A and 1V reference voltage for plotting. For example, you a Behavioural Current source 
equation generates a current and gets displayed on a plot with the units of Amps, but if the 
calculation is actually a transconductance gain then you want it displayed with units of Amps/Volt 
so it can appear with the same scaling as say a plot of d(Ic(Q1)) when Vin is the X-axis. 

Another example is if a Behavioural Current source equation generates a Beta value then you want 
it to appear with the same scaling as a plot of Ic(Q1)/Ib(Q1). To do this divide the Behavioural 
Current source by I(R1) where R1 carries 1A and you get a non-dimensional number for plotting.

Yet another is for the plot switch where a Behavioural Current source say I(B9) is set to either 1A or 
0A, then a particular plot say Ic(Q1) is multiplied by I(B9)/I(R1) giving the equation in the plot area 
of, eg, Ic(Q1)*I(B9)/I(R1). This will force the plot to 0 when I(B9) is switched to zero so you an 
uncluttered the plot area without deleting previously set up curves. This makes it easier for first 
time users to view the same plots as shown in the User Guide simply by running the circuit 
(assuming the circuit has the plot .plt file included as a set). 

If Voltage, Current and gain plots are used then you can turn off the gain plots by multiplying the 
gain plots by 0 to turn them off when not wanted, eg, I(B9)/I(R1)*0 or I(B9)/I(R1)*1 to turn them 
on.

 3.5 Exporting plots
When exporting plots (as .wmf files) for use in a User Guide etc you can avoid the clutter of the 
legend names being exported by deleting the curves that are not needed. But before you delete the 
curves save the standard plots first, that way you can get back to the full set again after exporting 
the plots and deleting the display window then re-running the circuit. Another tip: just before you 
export the plots check the X and Y scales are the right range.

 3.6 Importing plots in Vector format
In OpenOffice you can import .wmf plot and circuit files into a document using 
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Insert>Picture>From File then browse to get to the .wmf file and once converted it will appear in 
the document that fits the page width. Then right click and Anchor>As character to lock it to text. 
Then Ctrl+drag a corner to resize. 

 3.7 Importing circuits as Drawings in Vector format
If you import a circuit file and usually you want to be able to edit a circuit to change text or remove 
unwanted text so you need to import the file into a Drawing. In a drawing you can add arrows and 
more text or change line widths and Fonts etc. In a drawing all the  imported components are 
retained in vector format which is good for publishing and retains sharpness of text and curves 
when zooming (great for PDF's).

Usually you can work from a document and Insert>Object>OLE Object>OpenOffice Drawing and 
this will open a Drawing window. You then use Insert>Picture>From File and get the file. Once 
inserted you usually right click >Break (to edit it). Once broken it remains selected so you can 
reposition and scale it (Ctrl+drag). A tip is to press F4 to get the Position and Size dialogue then 
enter 0 X offset and 0 Y offset and Enter and it will be located at the top LH corner, then Ctrl+drag 
to resize it to suit (it is better to resize it in the drawing than to resize after closing the drawing 
window). 

A tip for editing text in the Drawing window – select a text box you want to edit then press F4 to 
get the Position and Size dialogue, in the bottom right turn on Adapt>Fit Width to Text and Fit 
Width to Text tick boxes then OK. Once this is set you an double click to edit the text and the box 
will expand to fit (otherwise more text gets squashed up or less text gets stretched!). When an item 
is selected you an use the keyboard arrow pad to move in major grid increments (left, right, up, 
down).

If you want the zoom ability for a drawing then you need to Sect All (all your imported drawing 
contents), then open a Drawing using File>New>Drawing, then paste the contents. You can save it 
as a Drawing file or copy and paste it back to you drawing window. Alternatively, to get some zoom 
with smaller circuits in a Drawing and in a document you can enlarge the drawing window and 
select and enlarge the circuit (if you need more zoom then use the document View>Zoom or zoom 
slider at bottom RHS), when all changes are done then resize the circuit to the original and reset the 
window back to the original. 

 3.8 Importing LTspice equations into a spreadsheet 
The equations used in LTspice can be Copy/Pasted into a spreadsheet equation with little 
modification if certain steps are takes to prevent format errors occurring. To make this work in the 
spreadsheet you use labels and the spreadsheets auto label recognition is now turned on by default 
in OpenOffice Calc and MS Excel. So you want the equations in LTspice to be as close as possible 
to acceptable labels for the spreadsheet to recognise. But you also want to use equation terms that 
look good in an equation write-up in the User Guide. This means you need to add a few single 
quotes to the spreadsheet terms so the spreadsheet knows they are labels and not cell addresses. (A 
macro could be written to automatically reformat the equations if you need to do a lot of equations 
like this). More information on importing equations and label names is provided in Known 
spreadsheet problems and solutions (Ch 2 Section 3).

 3.9 How to build a new circuit and equations
You can start with an existing multiple-circuit file, eg “Fig 3s1-4”, or a single-circuit file eg 
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“Fig5s6”. The “Fig 3s1-4” file is a good one to start from because it includes several circuits that do 
not have the equations yet and it is set up ready to enter equations. 

In a multiple circuit file you can use a general value for Re then you can use {Rs1} and {Rs2} for 
the various series resistors in circuit 1, circuit 2 respectively. You assign .param Rs1=Rs and another 
.param Rs2=Rs. Now you can step .Step param Rs List 10, 100 and both circuits will step together. 
If you want to offset one circuit then you can use .param Rs2=Rs+2 then the circuit 1 will be 2 
ohms more than circuit 2. This was used for offsetting Vsp1 and Vsp2 in the CPF push-pull circuit 
(eg Fig13s1).

Step1: Run the existing circuit. Then File>Save As> choose a name, copy the name to the 
clipboard, Save. The click on the Plot and File>Save Plot As> and paste the name (remove .asc and 
put .plt).

Step2: You can now start building your equations. First add the curly brackets to the resistors and 
voltages. The components can have the same name as in the curly brackets but it may get confusing 
so name the parts with 1 and 2 suffixes. If you have two circuits each with 2 or more transistors 
then I call then Q1a, Q2a in Circuit A and Q1b, Q2b in Circuit B. Notice the Plot switches are also 
labelled as CircuitA and CircuitB. Having added the curly brackets enter the component values as 
.para Re=10 as the default settings. Run the circuit to check the values are being recognised.

You can set you signal source to be programmable using curly brackets, eg, .dc Vin {-VinPk} 
{VinPk} 1m generates a DC sweep from -VinPk to +VinPk in 1mV increments, where .parm 
VinPk=1V defines “VinPk” as 1V. (You can now use this to step VinPk, eg using .Step param VinPk 
1 2 4 or whatever).

Step 3: Next define the “Equations independent of Vin”. These are equations that are NOT affected 
by Vin. Typical examples are Req equations (involving Re, Rb, Rin and Beta) or Vk equations 
(involving IS, NF, Req). These equations are calculated only one over a swept input but are 
recalculated for Stepped parameters. Run to check for errors. Save. If you want to look at the value 
of a .param then enter the term into one of the Plot Helpers (for voltage, or a Current source for 
current but its no bid deal if the units are displayed wrong in the plot readout, just that the value 
looks about right). Run and click the probe on the plot helper output.

Step4: Define the “Equations dependent on Vin”. These equations all involve Vin somewhere in the 
chain of ABM's. Add one equation at a time and Run to check it for errors. You can click on the 
source to plot the value. If you want to plot a voltage then enter the I(Bn) n=number  in the plot 
helper, Run and click the probe on the plot helper output.

You can build your equations until they are all defined. If you want to set the Voltage and Current 
plots to be controlled from the circuit settings then add the equations to the plots, as covered in 
Section 3.4 above (Why use “Plot Helpers”?).

Step5: Now your with equations that Run and plot you can now step various parameters to see if 
the equation plots track the LTspice circuit plots. You can set up to 3 stepped parameters in LTspice. 
You can do a “rat's nest” stepping plot to show up any areas where the plots diverge, eg, see Figure 
5.3b. 

3.9.1 The following now assumes you chose “Fig5s6”.
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Step1: First Run the existing circuit. Then File>Save As> choose a name, copy the name to the 
clipboard, Save. The click on the Plot and File>Save Plot As> and paste the name (remove .asc and 
put .plt).

Now delete any of the old equations, models, etc. But leave the headings as a guide. Change title 
and name to suit. If you want to keep the line of ABM (current sources I(B1) to I(Bn)) for n 
elements, then edit their equations and set them to I=1 including the Plot Helpers to V=1.

Draw your circuit. You can start with fixed component values then later change them to use curly 
brackets such {Re} for an emitter resistor – that allows the parameter to be used in the equation, 
the value can then be stepped, and other components can be assigned the same term (or a scaled 
version to track other parts). 

Now Run your circuit. You get error messages reporting where errors are. If they are in an ABM 
(current or voltage source) the you get an indication of where in the equation the problem is. But 
in .param equations there is no error reporting apart from the next equation that need that value spits 
the dummy, so you need to look at what terms are used and then check each equation that generates 
those terms. If you get stuck then a tip is to copy the .param equation into an ABM (minus the 
.param bit) to get the interpreter to show where the error lies, then pasted the fixed equation back 
into the .param line. 

Once you get your circuit to run use the cursor to select a value to plot. You can delete the existing 
plot but most of the unknown terms will just disappear when you get it to run so just delete any 
remaining traces (F5 or delete key or right click and choose Delete this trace). Save the circuit and 
the plot.

Go to Step 2 to 5 above.

------------------------- -----------------------

 2. Overview of Circuit files with PAK-1v0-NM 
Table 2 lists the circuits that are supplied with the PAK spreadsheet and User guide. They can be 
run in LTspice. Those still under construction are listed as “UC” where the circuits plot the LTspice 
values but the equations have yet to be defined. The footnotes show the known problems with 
operating equation circuits (most problems do not stop plots being obtained) and will be hopefully 
fixed for later versions (or fixes may be available later via Feedback). The Fig8-to-11-ABM file 
does not generate a plot but you can read voltages and currents using the probe after you close the 
'.op' results window.

Table 2. Circuits in PAK-1v0-NM 
PAK-LTspice Circuit Files Circuits Status

PAK-UG-Cct-Fig3s1 Diode + Rs √
PAK-UG-Cct-Fig3s1-PP Diode Push-Pull demo √
PAK-UG-Cct-Fig3s1PPs5pp Diode Push-Pull (Rin no Rs) UC
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PAK-LTspice Circuit Files Circuits Status
PAK-UG-Cct-Fig3s1-to-s4 Two diode combinations (4) UC
PAK-UG-Cct-Fig3s5 1 Shunt 2 series diodes & Offset UC
PAK-UG-Cct-Fig4s1s2 SE CE transistor & Rf √
PAK-UG-Cct-Fig4s3s4-CC SE CC/VF (2) √
PAK-UG-Cct-Fig5s1s2s3 CE CFP (3) √
PAK-UG-Cct-Fig5s4s5 CE CFP with Re & Rin (2) √
PAK-UG-Cct-Fig5s6 CE with Re & Rf √*
PAK-UG-Cct-Fig6s1s2 CE + CC (VAS+VF) OL*&CL No CL
No Fig 7 circuits in V1.0 - -
PAK-UG-Cct-Fig8s1-LTP LTP √
No Fig7 for Ver 1.0 SE Darlington -
PAK-UG-Cct-Fig8-to-11-ABMs LTP, Mirror, CCS (2) √
PAK-UG-Cct-Fig8-to-11-LTP-mirror-CCS Circuits only (no equations) UC
PAK-UG-Cct-Fig12s1s2 Basic PP (2) √‡
PAK-UG-Cct-Fig12s2 Basic PP (plots current drive) √
PAK-UG-Cct-Fig12s3s4 Basic PP CC/VF UC
PAK-UG-Cct-Fig13s1 CFP (V drive) √†
PAK-UG-Cct-Fig14s1s2 Darlington pairs (2) UC
* overflow problem needs something (plots look OK)
† see the W(exp(Y)) function, something needs a fixed (n earlier function is used for now).
‡ needs the Alternate SPICE solver, to change in LTspice: Simulate>Control 
Panel>SPICE>Solver>Alternate.

 4.   [spare]
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 POWER AMPLIFIER KALKULATOR

SPREADSHEET USER GUIDE

Chapter 4
Inside PAK-1v0-NM spreadsheet
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 1. How PAK-1v0-NM spreadsheet works
See Chapter 1 Section 4 Overview of PAK-0v1-NM Spreadsheet for an earlier introduction. A list of 
the circuits in the spreadsheet and User guide can be viewed in the Contents page or Table 3 in 
Chapter 1. Note there is a “Contents” link at the bottom of each page similar to Home links on 
websites.

This Chapter provides the derivation of the circuit equations used in the PAK spreadsheet. PAK a 
new approach. Numerical methods are not used like SPICE simulators. Equations are the only 
means for generating the plots. 

For a brief introduction on how SPICE solves circuit equations see Paul D. Mitcheson's 
introductory lecture notes [Paul D. Mitcheson, Imperial College, London, Lecture 1 slides, SPICE 
algorithms and internals http://www3.imperial.ac.uk/pls/portallive/docs/1/7292571.PDF]. He said, 

“This single nodal KCL equation [for a diode and resistor] is a transcendental (meaning it is 
an equation involving terms other than simple polynomials which generally cannot be 
rearranged so that the variable becomes the subject of the equation) and thus the equation 
can only be solved numerically” [emphasis added].

Now we can solve many diode and transistor circuits in an exact form using the Lambert W-
function [http://en.wikipedia.org/wiki/Diode_modelling#Explicit_solution ]. The PAK spreadsheet 
demonstrates the circuits that have been solved to date and hopefully many more circuit solutions 
will be found.

Thomas Banwell published the first general solutions for a few elementary diode and transistor 
circuits in 2000 [ref 1 IEEE paper]. Kevin Aylward appears to have been the first to use the Lambert 
W-function “in its application to transister circuits” [ref 9]. 

Chapter 4 repeats some of those solutions and adds more elements into his circuits. Other 
elementary circuits are added, including the Basic Current Mirror, the Vbe multiplier, the 
Differential pair, the CPF and Darlington pairs, and various Push-Pull output stages.

Thomas Banwell's solutions did not include collector voltage saturation nor any second-order 
effects such as Beta-fall at high currents and the Early effect. He mentions that they can be added. A 
few circuits in PAK-0v1-NM spreadsheet demonstrate how these effects can be included, but not 
all circuits include them due to the need to release the first version. See Table 3 in Chapter 1 for a 
summary of presently included effects. 

One of the powerful features of circuit solutions using the Lambert W-function approach is the first 
derivative or 'gain' function can be directly expressed in an analytic form once the current equation 
is obtained. This is brilliant for circuit designers. Gain equations give a direct indication of 
nonlinearities which give rise to nonlinear distortion. So we can now analyse distortion from 
general equations and optimise circuit behaviour in general without the necessity of specifying all 
component values (which SPICE solutions demand). 

With SPICE simulations distortion analysis in power amplifiers is tedious. Self-heating (aka electro-
thermal) feedback effects such as Thermal Lag Distortion (TLD) in SPICE becomes very tedious 
due to the large number of cycles needed to span large thermal time constants. But with the Lambert 
W-function approach it is now possible to calculate initial and final limits (with the help of 
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recursion if necessary) following conventional analysis with steady-state plus transient terms. 

From the start, PAK equations are based on SPICE diode and transistor model parameters. Presently 
PAK only uses the DC parameters. AC analysis involving complex R+jX and R∟θ notation can be 
included later and the PAK model library already includes the main AC parameters for future AC 
calculations. The present DC solutions are applicable for gain nonlinearity and distortion analysis 
up to the middle audio frequency range before transistor capacitances become important. 

This Chapter will be rather boring unless you have a keen interest in solving circuits that have never 
been solved before. This new approach offers treasures for those who dig. It will be require study to 
climb the learning curve. I'd love to see what you come up with. All the best.

 2. How to derive equations for elementary BJT circuits
The method used to rearrange the circuit equations in the following section is a bit like the 
derivation of the quadratic equation where you may recall completing the square 
[http://www.purplemath.com/modules/sqrquad.htm  and 
http://en.wikipedia.org/wiki/Quadratic_equation ]. In completing the square there is a balancing of 
each side to obtain a form that can then be resolved using the square-root function, and after that the 
equation is unpacked giving x equals …  

We will see this type of process below for solving exponential equations mixed with linear (non 
exponential) terms, by getting it into the form to allow the inverse of the Lambert W-function to 
provide the solution for I equals … 

Background on the Lambert W-function can be found at http://en.wikipedia.org/wiki/Lambert_W-
function or  http://mathworld.wolfram.com/LambertW-Function.html .

We will start with the simple diode plus resistor fed by a voltage source. But just before that, to 
refresh your memory on logs I'll mention “Ln(a) ” means the natural log of a with base “e”. The 
often used exponential and log identities in this chapter are:

exp(a)⋅exp(b)=exp(a+b)  & ln (a⋅b)=ln (a)+ln(b) & −ln (a)= 1
ln (a)

 but recall for ln (a+b)  there's no simpler form.
If the above equations are gobbledegook then the following chapter is worse! You will need to do a 
refresher or crash course in algebra before you can make any sense of this chapter.

Before starting out you may like to look at the LTspice circuit files. They are supplied with the 
spreadsheet and User Guide download as a ZIP. As mentioned they use the same equations that are 
presented below. When you Run the circuits in LTspice you will see SPICE plots from the equations 
and SPICE plots. You will see that most plots are so close that one line obscures the other, so you 
can see that the equations solutions are as accurate as the SPICE solution. These equations have 
been transferred into the PAK spreadsheet from LTspice so the equations used in the spreadsheet 
can be used with confidence. Why not Run the circuits files now in LTspice.

 3. Solving diode and resistor circuits 
This section starts 1) with the most basic example which is needed for solving transistor circuits. 
Several other diode circuits are presented in this section: 2) for two non-identical diodes in series 

Free eBook EditionFree eBook Edition
p36        Power Amp Kalkulator User Guide PAK-1v0-NM November 1, 2012  Contents 

http://mathworld.wolfram.com/LambertW-Function.html
http://en.wikipedia.org/wiki/Lambert_W-function
http://en.wikipedia.org/wiki/Lambert_W-function
http://en.wikipedia.org/wiki/Quadratic_equation
http://www.purplemath.com/modules/sqrquad.htm


and with a series resistor, 3) two non-identical diodes in series and one diode has a parallel resistor, 
3) two diodes in parallel where each diode has a series resistor. Solutions for 2), 3) 4) are also used 
later in transistor solutions. This is because the SPICE BJT for DC is accurately modelled by a 
number of diodes and resistors. 

 3.1. The solution for a diode and series resistor
Figure 3.1 shows the circuit of an ideal diode with a series resistor and fed by a voltage source.

Figure 3.1. Ideal diode D fed by a voltage source Vin and a series resistor Rs 
The equation for the current through an ideal diode is given by the Shockley diode equation 

Id = Is⋅(e
Vak
N⋅Vt −1)   (1)

 where Vt is the 'thermal voltage' given by Boltzman's constant kB, absolute temperature T, and qe is 
the electron charge, and N is the diode diodes non-ideality factor (1.0 for ideal). The Vt is 

Vt=
k B T
qe

 or ~26mV at 27°C 2/(2)

Using the voltage loop method we write
Vin= Id⋅R+Vak  (3)

We eliminate Vak in Equation (1) using 
Vak=Vin− Id⋅Rs  4/(4)

This gives 

Id − Is= Is⋅(e
Vin−Id⋅Rs

N⋅Vt )  5/(5)

We want to solve Equation (5) for Id in terms of the variable Vin. 

Here's how the Lambert W-function provides a solution.  The Lambert W-function is

w ew=x <=> W (x )=w 6/(6)
The inverse of the Lambert W-function allows us to find w in terms of x. W(x) is the inverse 
function that satisfies w ew=x . We can observe a few principle values of the inverse W(x) from 
0 e0=1  so we know W(1)=0. Also 1e1=e  so W(e)=1. Unfortunately, at this time most calculators 
and spreadsheets do not include the Lambert W-function as a standard function so we use an 
approximation involving multiple natural logs (more on this below). 

To solve Equation (6) we work to rearrange it into the same form as Equation (6). In this case in the 
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form

f 1( Id )e
f 1( Id )

= f 2 (Vin)  7/(7)

 where Id is only on the LHS involving w ew and Vin is only on the RHS. Comparing (6) and (7) 
we can identify that w=f1(Id) and x=f2(Vin). Note f1 must be exactly the same function ahead of the 
“e” as to-the-power-of “e” to allow a solution for these types of circuits. 

Now we have a roadmap for the solution lets start work on Equation (5) to get it into the form of 
Equation (7).

Step1. Start with Equation (5)

Id = Is(exp(Vin− Id⋅Rs
N⋅Vt )−1)  (8)

Then move Is to LHS

( Id+ Is)= Is⋅e
(Vin−Id⋅Rs

N⋅Vt )  (9)

Use the identity e^(a+b)=e^a·e^b 

( Id+ Is)= Is⋅e
( Vin

N⋅Vt )⋅e
(−Id⋅Rs

Vt )  (10)

Then move Id terms to LHS

( Id+ Is)e
( Id⋅Rs

N⋅Vt )= Is⋅e
( Vin

N⋅Vt )  (11)

Balance we^W on LHS by multiplying both sides by Rs/Vt 

( Id+ Is) Rs
Vt

e
( Id⋅Rs

N⋅Vt )= Is Rs
Vt

e
( Vin

N⋅Vt )  (12)

Introduce an IsR/Vt terms in the LHS exponent to completely balance we^w terms

( Id+ Is) Rs
N⋅Vt

e
( Id⋅Rs

N⋅Vt )e
( Is⋅Rs

N⋅Vt )= Is Rs
N⋅Vt

e
( Vin

N⋅Vt )e
( Is⋅Rs

N⋅Vt )  Or

 ( Id + Is)⋅Rs
Vt

e
( (Id +Is)⋅Rs

N⋅Vt )
=Is Rs

Vt
e
(Vin+ Is⋅Rs

N⋅Vt )
13/(13)

Step 2. We can now identify the two functions that are in Equation (7)

w=( Id+Is) Rs
N⋅Vt  (14)

and can now solve for Id using the Lambert W inverse function W(x) giving 

Id = N⋅Vt
Rs

W (x ) − Is  (15)

The notation w and W(x) are synonymous. The latter form is used as a reminder that we have to put 
a number x into the Lambert W-function to obtain a number for Id. 

Step 3. From the RHS of Equation (13) we can identify 
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x= Is⋅Rs
N⋅Vt exp(Vin+Is⋅Rs

Vt )  (16)

The closed form equation for Id is finally

Id = N⋅Vt
Rs

W ( Is⋅Rs
N⋅Vt

exp(Vin+ Is⋅Rs
N⋅Vt )) − Is  17/(17)

 where the function W(x) can be calculated using the approximation 

W (x )≃ln (1+x)(1− ln (1+ln(1+x))
2+ln(1+x ) )  18/(18)

Notice on the LHS the “–Is” subtracted after all the other is calculated. It is therefore written well to 
the RHS to make it obvious that it is separated from all the rest.

Step 4. It is more convenient if we write Equation (17) in the form 

Id (Vin)= N⋅Vt
Rs

W (exp(Vin−Vk
N⋅Vt )) − Is  where 19/(19)

Vk=N⋅Vt⋅ln( N⋅Vt
Is⋅Rs ) − Is⋅Rs 20/(20)

The steps to obtain constant Vk, the 'knee voltage'  (or why not the 'Omega voltage' VΩ ?), are

 
x=e

ln( Is Rs
N⋅Vt )e

((Vin+Is⋅Rs)
N⋅Vt )   => 

x=e
(Vin+ Is⋅Rs)

N⋅Vt
+ln( Is Rs

N⋅Vt )  => 
x=e

(Vin+ Is⋅Rs)
N⋅Vt

+
N⋅Vt ln( Is⋅Rs

Vt )
N⋅Vt

 

=> 
x=e

(Vin+ Is⋅Rs)
N⋅Vt

+
N⋅Vt ln( Is⋅Rs

N⋅Vt )
N⋅Vt

 => 
x=e

Vin+IsRs+N⋅Vt ln( Is⋅Rs
N⋅Vt )

N⋅Vt
 

 => 
x=e

(Vin+Is⋅Rs−N⋅Vt⋅ln( N⋅Vt
Is⋅Rs)

N⋅Vt )  

and finally x=exp(Vin−Vk
N⋅Vt )  where Vk=N⋅Vt⋅ln( N⋅Vt

Is⋅Rs ) − Is⋅Rs  

The knee voltage Vk is a very useful term for understanding circuit operation as well as simplifying 
the final equations. The knee voltage Vk is a similar term to the threshold voltage (Vth) of a FET. Vk 
is slightly more than the x-axis intercept on a linear-linear plot of Id versus Vin for the diode plus 
resistor circuit. The extra x-intercept voltage is about 2·N·Vt volts or typically 60mV higher than 
Vk and the current is about 3 times higher. This is shown below with parameters for the 
ThermalTrak sensing diode.

Figure 3.1a shows the diode current plot for a diode with a 1 ohm series resistance, a ThermalTrak 
sensing diode is used (Is=1e-10A, N=1.2, Rs=0.5 ohms) and the series resistance is increased to 1 
ohm for the sake of plotting the total conduction G, which ultimately is limited to 1A/V or 1/Rs. 
The calculated value of Vk from Equation (20) is 606.8mV. The x-axis intercept is about 680mV 
which is about 70mV higher than the calculated Vk value, or about 2.2·NVt. Note for this diode 
N=1.2 so the thermal voltage is 31mV at 27C in this case and not 26mV.

Free eBook EditionFree eBook Edition
p39        Power Amp Kalkulator User Guide PAK-1v0-NM November 1, 2012  Contents 



 

Figure 3.1a. Diode current and conductance plots for a diode with a 1 ohm series resistance. 
The cursor is at Vk of 606.2mV and conductance is measured as 353mS, or 35.3% of Rs.

Is there any meaningful relationship between Vk and the diode conductance or current levels? 
Placing a cursor at 606mV the total conductance is measured as 353mS, or 35.3% of Gs (where Gs 
is 1/Rs). 

Moving the cursor at the x-axis intercept voltage (680mV) and reading the conductance gives 
626mS or 63% of Gs. The input voltage for 50% of Gs is 638mV, or 30mV above that Vk (about 
1·NVt), or 40mV below the x-intercept (about 1.3Vt) . The currents at these 3 points are given in 
Table 3.1a. The currents increase by 1.7 times for each step in voltage or a factor of 3 times higher 
at Vk compared to the x-intercept voltage.

Table 3.1. Diode plus 1 ohms. Current and conductances at Vk
Vk Half G X-int.

Vin 607mV 638mV 680mV
Current 18mA 31mA 55mA

Total conductance 0.353mS 502mS 641mS

The value of Vk is not a fixed internal voltage of a diode but Vk is determined by the diodes 
saturation current (Is) and the external Thévenin resistance that the diode sees in a particular circuit 
(see http://en.wikipedia.org/wiki/Th%C3%A9venin%27s_theorem).

Looking further at Figure 3.1a for a significance of Vk voltage, the total conductance plot the Vk 
point appears to be the inflexion point, so a plot is generated of the second derivative to check this. 
Since LTspice can only generate the first derivative of a plotted value the second derivative was 
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obtained by calculating the first derivative in the circuit then using LTspice to plot the derivative of 
the derivative. The first derivative is calculated using 

d W (x )
dx

= 1
x

W (x )
(1+W (x ))  so G= 1

Rs
W {19}

(1+W {19})  where 

W {19}=W (exp(Vin−Vk
Vt ))

21/(21)

W{19} means the Lambert Inverse part of Equation (19) (the equation that was used to calculate the 
current). 

The value of G at Vk calculated using Equation (21) is W(e^0)/(1+W(e^0)) or 0.557/(1+0.557) or 
358mS and the value of G measured using the cursor on LTspice d(Id1) was 353mS so they do 
agree. 
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Figure 3.1c Plot of diode plus 0.5 ohm and then 1 ohm, showing plots of the first (brown) and 
second derivative (cyan). The peak demonstrates that inflexion does occurs at Vk (to within 

5mV in this test). The peak is 4.66A/V^2 at 602mV 

A plot of both the first and second derivatives is shown in Figure 3.1c.The second derivative is 
calculated using

d 2W ( x)
dx2 = 1

x2
W ( x)

(1+W (x ))3
 and 

dG
dVin

= 1
N⋅Vt⋅Rs

W {19}
(1+W {19})3

22/(22)

The peak value of the second derivative from Equation (22) is 1/0.031×0.557/(1+0.557)^3 or 4.77 
A/V^2. Notice when Rs is changed the first and second derivatives agree. The second derivative is 
calculated by the LTspice plot function and this agrees with the second derivative from Equation 
(22) when Rs is varied. Small differences in Id (and therefore derivatives) are assumed to be due to 
the Lambert W-inverse being approximate to around 1% on average. Higher derivatives can also be 
calculated directly and the general formula for the nth derivative is given by Corless Eq 3.5 & 3.6 
[ref 6 Corless] (but I haven't figured out how to convert it for a diode circuit).
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What have we achieved by solving the current in this simple circuit? 
Previously, placing a diode in a linear circuit with Resistors and Voltages (and/or Currents) meant 
we had to use a simulator to solve it numerically because there was no known analytical solution. 
Now we have an equation to solved the current through the diode given RTh and with no analytical  
approximations. The result from this calculation will be same as that using SPICE with the same 
model and parameters. Figure 3.1e shows the SPICE solution and the equation solutions together as 
I(D1) and I(B1). The plots are on top of each other and any differences are not visible. With an 
inbuilt Lambert W-function inverse the SPICE result will be less accurate because SPICE only 
iterates to a moderate accuracy; the default RelTol in LTspice is 0.1% (or AbsTol is 1e-12). 

As alluded to above, Rs in Figure 3.1 could represent a Thévenin (or Norton) equivalent resistance 
for a more complex circuit around the diode. It means we can now solve currents in more complex 
circuits incorporating one diode so far). 

It also opens up a new world to solving circuit equations for transistor circuits in the large signal 
domain when previously only the small signal domain could be analysed in detail. Bipolar 
transistors are modelled on the diode, so now transistor models can include the effects of series 
resistance in the actual model equations. Previously this has not been possible and the effect of 
series resistances were always solved outside the model by the numerical SPICE engine.

Since we are considering the practical relevance of Vk and the use of the diode plus resistor to 
model a transistor a two diode circuit is now used to represent a two transistor Class-AB output 
stage. Figure 3.1d show the basic circuit. Each diodes has a bias voltage set to Vk (606.8mV) and 
the diode currents are differenced for plotting a representation of the collector currents if two 
transistors were actually used. Here they are represented by a Beta of one. If you want a more 
realistic plot them multiply the curve by say 100. 

Rs1D2

Vsp

Vsp D3 Rs2

Vin
Iout

Figure 3.1d. Simple demo of Class-AB using the diode plus resistor equations

Figure 3.1e shows the plots using LTspice to solve the circuit and the plots from the calculated 
currents and gains using the above diode equations. The calculated currents and gains are very close 
to the SPICE results. 

We are interested here in the significance of biasing at Vk. The gain plot or “wingspread” plot when 
Vk is used as the biasing voltage looks slightly under-biased for minimum crossover distortion. The 
dip in the gain at Vin=0 is measured on the LTspice as 722.6mA/V or 72% of the ultimate value at 
high output current. This 72% value is twice the 36% seen above for one diode at Vin=Vk since 
there is a bias voltage added now to force Vk across each diode when Vin=0. 

When the bias voltage is increased by one NVt the wingspread curve looks more like optimum bias 
for minimum crossover distortion since any higher bias gives a larger overshoot in gain and 
distortion increases with one more NVt bias voltage than this. Recall from Table 3.1 one NVt above 
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Vk we get half the maximum conductance, so with two diodes we get 100% total conductance when 
Vin=0 and we see this in Figure 3.1e.
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d(I (D2) -I (D3) ) 0*I (R1) / V(1vref ) ( I (B7)+I (B8) ) / V(1Vref ) V(vp)
I (Rs1)- I (Rs2) I (B5) - I (B6)

 Figure 3.1e. Class-AB using diode plus resistor equations. LTspice circuit (red/pink) and 
equations (light and dark green). The bias spread voltage is stepped as Vk (607mV lower) and 

Vk+1·NVt (640mV upper) 

Another observation for Class-AB is the conductance curve in Figure 3.1d passes through a region 
where the curve appears to be straight. The second derivative shows the slope is never constant. 
However a small range of input voltages can be identified where the slope is within say 10% of its 
maximum. The voltages where the slope is more than 90% of the peak are 574mV and 634mV 
(centred about 604mV or Vk). 

What is interesting is a constant slope or gain ramp represents is a Square-Law relationship between 
Vin and Id. We can see an almost Square-Law exists over this 60mV region. This can be called the 
“Square-Law Class-AB” region. Figure 3.1f zooms in on this range and it can be seen that the gain 
variation is very small in this region. If the two diode slopes were straight in this region then there 
would be a constant gain and the distortion would be zero. But there is a small variation in gain 
because the diode slopes are varying from 90% of the peak to the peak then back again to 90% of 
the peak. With larger input swings the gain eventually begins to rise monotonically toward the limit 
determined by Rs. So this is another insight into the practical relevance of Vk in circuit design.

Designing a power amplifier to exploit this low distortion Square-Law Class-AB region has lead to 
a number of designs [ref Olsson Dec 1994, Hegglun EW 199 & L|A Vol.4]. The above diode circuit 
(which is indicative of bipolar transistor) can be exploited by reducing the values of the emitter 
resistors in series with the power transistors and making them as small as possible while still being 
able to stabilise their quiescent current as their junction temperatures change, then to obtain even 
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lower series resistance several output pairs can be paralleled (each with their own safe-value emitter 
resistors).

-150mV -120mV -90mV -60mV -30mV 0mV 30mV 60mV 90mV 120mV 150mV
-1Ω0. 0

-1Ω0. 1

-1Ω0. 2

-1Ω0. 3

-1Ω0. 4

-1Ω0. 5

-1Ω0. 6

-1Ω0. 7

-1Ω0. 8

-1Ω0. 9

-1Ω1. 0 d( I (D2) -I (D3)) 0*I (R1)/ V(1vref ) ( I (B7)+I (B8))/ V(1Vref )

Figure 3.1f. A good approximation to a Square-Law Class-AB region can be obtained when 
the bias voltage is Vk (607mV lower curves) and the input voltage is plus or minus one NVt 

(30mV). Red is LTspice, Re=1R, Upper curve Vsp=Vk+NVt (640mV).

The diode equation solution can give valuable insights for circuit designers of transistor power 
amplifiers. The 'knee voltage' Vk is a key term in Class-AB power amplifiers and optimum biased 
Class-AB is normally biased at around one NVt more than Vk for minimum distortion, while 
Square-Law Class-AB aims for bias at precisely Vk voltage for the best possible crossover function 
from each transistor. This gives an approximate Square-Law for plus or minus one NVt of input 
signal variation.

Incidentally, at Vin=Vk the inverse Lambert value is W(1) = Ω or the Omega constant with a value 
of approximately 0.5671432904097838729999686622, because an alternate name for the Lambert 
W-function is the Omega function. [http://en.wikipedia.org/wiki/Omega_constant ] Omega is the 
intersection of y=e^-x and y=x (or y=ln(x) and y= -x). The approximation used above returns 
W(1)=0.557 but the Omega constant is better stated as 0.567 to 3 significant figures (and 567 easier 
to remember).

So, maybe the knee voltage “Vk” should be called the 'Omega voltage' “VΩ“ instead? And, maybe, 
the BJT form of approximated Square-Law Class-AB which aims for bias at precisely the knee 
voltage Vk or Omega voltage “VΩ“ should be called Class-Ω (or Class-Omega)? 

 3.1.1 Alternative diode plus resistor solution
Back now to the task of how to derive circuit equations. Next we need to take a look at a second 
way to arrive at the same solution. This time starting with the diode voltage equation instead of the 
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current equation. It is helpful to be able to use either approach.

Recall in the solution above we used the form w ew=x  and W(x) is the inverse function – given 
x we can find w. An alternative form of the Lambert W-function is 

w=ln( x
w )  23/(23)

 obtained from two simple steps, by dividing both sides by w then taking the ln of both sides.

This form may be easier for some if diode voltages involving logs are used rather than diode 
currents involving exponentials because more complex circuits usually use meshing KVL voltage 
loop equations and in this form diode and transistor junction voltages pop up naturally in these 
equations. This will be seen later. 

So lets repeat the diode and resistor solution using the diode voltage log form rather the exponential 
current form. In this case we want to get an equation of the form of w=ln(x/w) where Vin only 
appears on the RHS, and Id terms on the LHS must match the Id terms in the denominator of 
the log, and the log has no terms in front of it.

Rewriting the Shockley diode equation in the log form we start with 

Vak=Vt ln( Id
Is +1)  (24)

Using Equation (4) Vak=Vin− Id⋅Rs we can eliminate Vak, giving

Vin− Id⋅Rs=Vt ln( Id
Is +1)  (25)

First, remove the Vt in from of the log. Then move Vin to the RHS, giving

s −Id⋅R
Vt =ln( Id+ Is

Is )− Vin
Vt  (26)

We look at the w term inside the log and need to invert it to get Id in the denominator (recall 
-ln(x/y)=ln(x/y)-1=ln(x/y) ) so we multiplying both sides by minus 1, giving

Id⋅Rs
Vt =ln( Is

Id+ Is)+Vin
Vt  (27)

We note Id in the denominator inside the log has a plus Is term so we change the LHS to have the 
same form. So we add Is Rs/Vt to both sides, giving

( Id + Is)⋅Rs
Vt =ln( Is

Id+ Is )+(Vin− Is⋅R
Vt )  (28)

We also need Rs/Vt in the denominator inside the log so we multiply the numerator and 
denominator by Rs/Vt inside the log, giving

( Id + Is)⋅Rs
Vt =ln( Is⋅Rs /Vt

( Id+ Is)⋅Rs /Vt )+(Vin− Is⋅Rs
Vt )  (29)

Now move the Vin parts inside the log, noting ln(exp(x))=x and ln(a)+ln(b)=ln(ab), giving
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( Id+ Is) Rs
Vt

=ln( Is⋅Rs
Vt exp(Vin− Is⋅Rs

Vt )
( Id+ Is) Rs

Vt
)  (30)

We now have the form required for w=ln(x/w). We identify w=( Id+ Is) Rs
Vt  which is the same as 

we obtained above (Eq.14) and x= Is⋅Rs
Vt exp(Vin+Is⋅Rs

Vt )  so we can write 

 x=exp(Vin−Vk
Vt )  where Vk=Vt⋅ln( Vt

Is⋅Rs ) −Is⋅Rs

Both paths lead to the same solution. Sometimes it is easier to use the voltage equation for a diode 
(as we will see later). When solving bipolar transistor circuits there are a number of two diode 
circuits that are helpful to solve first.

 3.2 A Solution for two diodes in series with different IS's and equal NF's

Rs

D2

D3

Vin

Figure 3.2. Two series diodes and Rs
The derivation for the current through two diodes in series with an equivalent resistance is similar to 
[Section 1.1] but we need to back up one step first and use the diode voltage equation 

V D1=Vt⋅ln( Id
Is1+1)  for D1 and V D2=Vt⋅ln( Id

Is2 +1)  and where Id flows through both diodes 

being in series. The voltage loop equation for two diodes in series plus a resistor is 

Vin=V D1+V D2+ Id⋅Rs  and substituting gives Vin=Vt⋅ln( Id
Is1+1)+Vt⋅ln( Id

Is2 +1)+ Id⋅Rs  so 

Vin=Vt⋅ln( Id 2

Is1⋅Is2)+Id⋅Rs  or Vin=Vt⋅ln(( Id
√( Is1⋅Is2))

2)+ Id⋅Rs  or 

Vin=2⋅Vt⋅ln( Id
√( Is1⋅Is2))+ Id⋅Rs  and Vin=Vt12eq⋅ln( Id

Is12eq)+ Id⋅Rs . where Vt12eq=2⋅Vt  and 

Is12eq=√( Is1⋅Is2) . This has reduced the two diodes to one equivalent diode with an equivalent 
saturation current of √( Is1⋅Is2)  and an equivalent thermal voltage of 2Vt. The solution for 
different NF's is not provided here.

A LTspice plot is given later in Section 3.4. The above equations have not been tested in LTspice 
and no equations for this circuit appear in the PAK Version 1.0 spreadsheet.

 3.3 Solution for two non-identical diodes in series and one diode has a parallel 
resistor [under construction]
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Rs

D4

D5

Vin

Figure 3.3. Two series diodes with one shunt Rs

No equation solutions are given in the LTspice circuit files or the PAK Version 1.0 spreadsheet for 
this circuit.

 3.4 Solution for two diodes in parallel where each diode has a series resistor.

Rs1

D9

D6

D7

D8

Vin

Rs2

Figure 3.4. Two 2 series parallel diodes and different Rs's.

Figure 3.1-4 shows a combined LTspice plot for Sections 3.1-4. No equation solutions are given in 
the LTspice circuit files or the PAK Version 1.0  spreadsheet for this circuit.

0. 2V 0. 4V 0. 6V 0. 8V 1. 0V 1. 2V 1. 4V 1. 6V 1. 8V
-18
-16
-14
-12
-10
-8
-6
-4
-2
0
2

Log10( I (D1)) Log10( I (D7)) Log10( I (D5)) Log10( I (D3))
Log10( I (B1)) Log10( I (D1)) Log10( I (D9))

Figure 3.1-4. Ln(Id) plots for 4 circuits with Rs stepped 0.5R and 1R: Sections 3.1 Single 
diode+R as Id1; Sections 3.2 as Id3; Sections 3.3 as Id5; Sections 3.4 as Id & Id9. 

Notice in Figure 3.1-4 that Id5 (Figure 3.3. Two series diodes with one shunt Rs) gives a knee like 
high current Beta-fall. This is discussed further in Section 4.1.3.
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 3.5 Solution for two diodes in anti-parallel with spread voltages and Rin (no Rs)
The solution of  Figure 3.5 is relevant to solving the Basic Push-Pull output stage Rin is large. In 
this circuit the diode series resistances (Rs) are removed so the effect of Rin can be solved without 
the complication of Rs.

Vin1

Rin

{Rin}

D4

DTTDVsp3
{VspB}

{VspB}
Vsp4

D5

DTTD

Vin

.Step param k List 0 1 2 3

.param k=0 ;Iq offset

.param VspB=Vk1+k*N*Vt  ;bias Vspread

.param Rin=Rs

Figure 3.5. Circuit of two anti-parallel diodes with Vspread, no Rs for each diode and Rin 
provides the series resistance.
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Figure 3.5a. 'Wingspread' Plot for two anti-parallel diodes with Vspread, no Rs for each 
diode. Rin=1R, IS=1e-10, N=1.2.

 4.  Solving single BJT circuits
The bipolar junction transistor (BJT) is usually modelled using the Ebers & Moll (EM) model from 
1954 and enhanced to the Gummel & Poon (GP) model in 1970 – both model the collector current 
in the normal forward mode on the intrinsic (internal) base to emitter voltage (Vbe) – intrinsic 
means after the parasitic resistance volt drops due to connections have been stripped away. 

In the EM and GP models the equation for the primary collector current is 

Ic= Is⋅exp( Vbe
N⋅Vt )  (31)

where Is is the collector-side saturation current and NVt is thermal voltage Equation (2) Vt=KT/q 
multiplied by a diode ideality slope factor N. 
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The collector side saturation current appears to have been chosen because it makes it easier to 
formulate the collector current equation free from the second order effects of base leakage current 
which are significant at low input voltages. But the use of collector side saturation current is 
counter-intuitive; people normally assume that a base-emitter voltage develops a base current and 
the base current then causes the collector current. But in the EM &GP models it is the base-emitter 
voltage that directly generates the collector current and the base current is a smaller fraction of the 
collector current. The generation of collector current directly as a result of the base-emitter voltage 
in the EM and GP models is primarily a field-effect device, a transconductance meaning a voltage 
to current conversion. 

When using the collector side approach the base current is Ic/Beta and the base current is calculated 
using 

Ib= Is
Beta⋅exp(Vbe

NVt )  (32)

The models used in the PAK spreadsheet usually use the collector side Is following these standard 
SPICE models. This means resistances on the base side of a transistor circuit are referred back to 
the collector side as in the following example to allow the Lambert W-function to solve the 
collector current. Once the collector current is found then the base current and other circuit voltages 
can be calculated as well.

 4.1 Common Emitter BJT with emitter degeneration and Rin & Rc

Q1

Re

Rc

Rin
Vcc

Vin

Vc

Vb

Ve

Figure 4.1. Single Ended Common Emitter amplifier 
Figure 4.1 shows a Single Ended BJT Common Emitter amplifier with an emitter degeneration 
resistor Re and a base resistor Rin and a collector load resistor Rc. Rin could be a base stopper 
resistor or it can be thought of as an equivalent output resistance for a signal generator or a 
preceding stage. If the preceding stage is actually a current source then Rin can be used as the 
Thévenin resistance that the current source develops an equivalent input voltage across (See section 
4.4). 

The next Figure 4.1a shows a BJT modelled by a base diode with a series base resistance Rin and 
the emitter resistance Re. The Re can be a parasitic (internal terminal) resistance or may be an 
external resistor such as an emitter degeneration resistor. The collector resistor resistance Rc is left 
out for now.
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D

Rin

Vin

Ic 

Re

 

Figure 4.1a. Common Emitter BJT with Rin emitter degeneration by Re. The basic BJT is 
modelled by a diode and controlled current source.

Incidentally, in circuit simulators the parasitic resistances ReP, RbP and RcP are all 'external' to the 
EM & GP BJT model equations and these models rely on the 'SPICE engine' to solves their effects 
in the circuit. Here we will merge these parasitic resistances (and the other circuit resistances) into 
an explicit equation solution for the circuit. When this is achieved we don't need a 'SPICE engine' to 
solve our circuit – and if we do need to generate sweep plots then we can use a simple spreadsheet 
and our equation solutions.

To solve the circuit in Figure 4.1a we first combine Re and Rin to simplify the circuit to one diode 
and one equivalent resistor (Req) (see Figure 4.1b) using 

Req= Rin
Beta +R e(1+Beta

Beta )  (33)

This is called referring the base resistance to the collector side. Rin is divided by Beta to bring it to 
the collector side since Ic=Beta·Ib. But why use the (Beta+1)/Beta for Re? Because resistor Re 
carries emitter current (not collector current) so 

Ie= Ic+Ib so Ie= Ic+ Ic
Beta = Ic(1+ 1

Beta) so Ie= Ic(Beta+1
Beta ) (34)

Why the collector side and not the emitter side? The Lambert W inverse solution is for Ic. If we 
need Ie instead if Ic then use the equation above to convert Ic to Ie.

D
Vin

Ic

Req= Rin
Beta +R e (1+Beta

Beta )

Figure 4.1b. Simplified BJT model with Rin brought into Req on the collector side.

We can now using our previous diode plus resistor solution to define the current as 

 Ic= N⋅Vt
Req

W (exp(Vin−Vk
N⋅Vt )) − Is  where Vk=N⋅Vt⋅ln( N⋅Vt

Is⋅Req) − Is⋅Req  and 

Req= Rin
Beta +R e⋅(1+Beta

Beta )
(35)

 where Is is the collector side saturation current as used in SPICE models. The “W(exp((Vin-
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Vk)/NVt))” part is the Lambert W-inverse function – it can be calculated using the approximation 
given in Equation (18). Incidentally, the base diode D in Figure 4.1b is not the actual diode we 
associate with Req. We need to imagine that Req is in series with a virtual diode “Deq” on the 
collector side and having a saturation current of Is (which is actually Beta times the saturation 
current of the base diode D). This virtual diode diode arises from the collector-side Ic equation 
adopted in the EM and GP models. If however, the emitter resistance had been referred to the base 
side (giving Req') then it makes more sense (to most people) because Req' in then series with the 
base diode D and the equations above would give a base current which then produces the collector 
current when multiplied by the Beta. Alternate views are discussed further in Section 4.1.3 (High-
current Beta-fall).

Anyhow, we have succeeded in solving a BJT circuit that includes emitter degeneration and a base 
resistance. We can now write equations for a Common Emitter amplifier with a collector resistor. 
The Common Collector circuit solution is essentially the same except the collector resistor is not 
used and the output is taken at the emitter instead of the collector.

The CE solution the output voltage Vc is calculated using Ic from above with
Vout=Vc= Ic⋅Rc  (36)

Figure 4.1c shows Ic and output voltages Vc for the CE case. No Vce saturation is included so Ic 
and Vce can exceed their physical limits. LTspice (red/pink) and ABM equations (cyan/gold). 
Vcc=10V, Rin=1k, Rc=1k, Re=1mR, 10R and 100R. 

0. 0V 0. 2V 0. 4V 0. 6V 0. 8V 1. 0V 1. 2V 1. 4V 1. 6V 1. 8V 2. 0V
-1V

0V

1V

2V

3V

4V

5V

6V

7V

8V

9V

10V

11V

-1mA

0mA

1mA

2mA
3mA

4mA

5mA

6mA

7mA

8mA

9mA

10mA

11mA

V(vc)*(I (B3) / I (R1) ) V(vp1)*( I (B3)/ I (R1) )
I (Rc)*I (B3)/ I (R1) I (B1)*( I (B3)/ I (R1))

Figure 4.1c. Single Ended Common Emitter amplifier. No Vce saturation effect is included so 
Ic and Vce can exceed their physical limits. LTspice (red/pink) and ABM equations 

(cyan/gold). Vcc=10V, Rin=1k, Rc=1k, Re=1mR, 10R and 100R. Beta=100.

 4.1.1  SE CE amplifier with Vce saturation 
Saturation can approximated by restricting the maximum collector current using 

Ic=Max ( IcGen , IcSat)  where IcSat=
Vcc−Vt⋅ln (Beta)

Rc+R e  (37)
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Where IcGen is an ideal current source that has no restrictions on the voltage across it. The Max 
function provides the hard limit at IcSat. 

0. 4V 0. 6V 0. 8V 1. 0V 1. 2V 1. 4V 1. 6V 1. 8V 2. 0V
0V
1V
2V
3V
4V
5V
6V
7V
8V
9V
10V

0mA
1mA
2mA
3mA
4mA
5mA
6mA
7mA
8mA
9mA
10mA

V(vc) V(vceq) I (Rc) I (B1)

 0. 0V 0. 2V 0. 4V 0. 6V 0. 8V 1. 0V 1. 2V 1. 4V 1. 6V 1. 8V 2. 0V
0V
1V
2V
3V
4V
5V
6V
7V
8V
9V
10V
11V

0mA

1mA

2mA

3mA

4mA

5mA

6mA

7mA

8mA

9mA

10mA

V(vc)*( I (B3) / I (R1)) V(vp1)*( I (B3) / I (R1)) I (Rc)*I (B3) / I (R1)
I (B11)*( I (B3) / I (R1))

Figure 4.1d. Single Ended Common Emitter amplifier. Ic saturation using Max(Ic, IcSat)Left: 
Vcc=10V, Rin=1k, Rc=1k, Re=10R and 100R, Beta=100. Right: Beta stepped 10 and 100, 

Rin=Rc=1k, Re=100R.

The current limit used here is based on a Vce saturation voltage of Vt·Ln(Beta) since it is supposed 
that the base-collector diode carries Beta times the excess base current while the base-emitter 
junction carries Ic/Beta as usual. This means in moderate saturation 

Ibc
Ibe

=Beta  and NF
NR

⋅Vt⋅ln(Beta ) (38)

 where NF and NR are the ideality factors which are assume to be the same for convenience here. 
Some rounding can be included using an alternative user defined Max function with 0.1mA of 
rounding for a maximum current of 10mA in this example. 

A more accurate saturation solution is on the wish-list for a later PAK version. A better approach 
may be to collapse BetaEff fron Beta to zero in the limit as Vin becomes large causing Ic to reach a 
saturation limit and then Ic is used in Vcc-Ic·RTot to give the output voltage. The Tanh(x) function 
can be used as a switch since it involves the Exponential function and gives a similar slope to actual 
transistors going into saturation.

 4.1.2  SE CE amplifier with the Early effect
Adding second order effects such as the Early effect to a Lambert W solution adds unwanted 
complications to otherwise relatively simple solutions. But these effects are desirable to include 
because they can contribute a significant amount of additional nonlinearity and therefore distortion. 
Also it is helpful to include them, to show that their effect is insignificant in certain cases and can 
be neglected, to allow simpler and easier equations solutions.

The Early effect is where collector to emitter voltage adds a nonlinear current component collector 
current source. Since the Early effect current varies with applied collector-emitter voltage it is 
modelled as a shunt resistance across the current source that passes the collector current which is 
free of the Early effect. This shunt resistance is really a variable conductance represented by the 
slope dIce/dVce. The average slope of a dIce/dVce curve is a straight line passing through a 
common point on the -Vce x-axis called the Early voltage -VA . Since dIce/dVce is approximated to 
a straight line the Early voltage -VA is independent of Ic and the slope is directly proportional to the 
collector current. This means the shunt conductance for the Early effect is directly proportional to 
the collector current, or the shunt conductance is given by go=Ico/VA . 
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This equation allows the Early effect to be added to the transistor equation model. If there was no 
emitter resistance then Ico is independent of the current through the shunt conductance go. This 
allows the shunt conductance go to be included in the next stage as a source resistance to allow the 
solution for output current of the second stage drive by the first stage. 

Emitter resistance provides some local feedback which reduces the effective shunt conductance 
go=Ico/VA (it increases the shunt resistance). If we assume that Ico is not affected by the current 
through the shunt conductance go then local feedback from Re raises the effective Early voltage and 
a general solution is possible using the general feedback equation with loop gain gm·Re where gm0 

is calculated along with the Lambert W solution for Ico (with the Early effect added to gm0). This 
gives a higher effective Early voltage 

Vaeff (Re)=Va(1+Re⋅gm0(1+Vce
Va ))  (39)

 The collector current with the Early effect and Re local feedback is 

Ic (Re ,Va)= Ico(1+ Vce
(Vaeff ))  40/(40)

for a constant Vce (no resistors in the collector and the subtractive effect of VRe on Vce can be 
neglected). 

Rb

Vin

Re

Q1 Vcc

Rc

Ro

Figure 4.1e. Common Emitter amplifier. The equivalent shunt resistance across collector-
emitter is due to the Early effect.

Next, Vce will vary over a wide range with Ic. Since Ic(Va) depends on Vce and Vce depends on 
Ic(Va) another equation must be solved involving the effect of the load resistance Rc and Re on 
Vce. With Figure 4.1e we use Equation (40) above and write 

Vce=Vcc− Ic (Va ,Re)⋅Rc− Ic(Va , Re)(Beta+1
Beta )⋅Re  41/(41)

 where the current through Ro is included in Ic(Va). Substituting Vce gives 

Ic (Re ,Va)= Ico(1+ Vcc
(Va eff ))− Ic(Va , Re)⋅Ico( Rc

VaEff
+(Beta+1

Beta )⋅Re
VaEff )  and collecting terms 

gives 
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Ic (Re ,Va)=
Ico(1+Vcc /(VaEff ))

1+ Ico
VaEff

(Rc+R e( Beta+1
Beta ))  Where 

Vaeff (Re)=Va(1+gm0 R e(1+
Vceest

Va )) & Vceest≈Vcc− Ico(Rc+Re)

(42)

 where gm0 is calculated along with the Lambert W solution for Ico. Note the Re in the Ic(Re,Va) 
equation does not include the base resistance referred to the emitter (since the equation is derived 
from the voltage drop across Re due to Ie).

We can check this, first setting Rc=0 and Re=0 giving the expected result
Ic (Va)= Ico(1+Vcc /(VaEff )) . If we set Re=0 and Rc=Ro (=Ico/VaEff) then 

Ic (Va)= 1
2

Ico(1+Vcc /(VaEff )) which is expected since Ro drains half the current away from Rc 

(effectively forming a current divider). 

The above solution can be used for the Voltage Follower by setting Rc=0 and Re is now RL 
(alternatively, Re may appear in parallel with Re).

The above can also be used for the Common Emitter stage (with emitter degeneration and/or base 
resistance). The VAS stage in a power amplifier is an example. Figure 4.1f shows an additional 
loading stage with resistance RL and terminated to an arbitrary voltage Vo. This circuit can be 
solved using superposition where 

VccEff =Vcc( RL

RL+Rc )+Vo( Rc
RL+Rc )  & RcEff =Rc∥RL (43)

Rb

Vin

Re

Q1 Vcc

Rc

Ro

Vo

RL

Figure 4.1f. Common Emitter amplifier with the Early effect with a generalised load RL

 4.1.3  High current Beta-fall [under construction] 
Power amplifiers commonly use a CC Voltage Follower output stage and therefore Beta variations 
in the output transistors can affect the loading on the VAS stage. This means equations for output 
stages should include the high current Beta-fall effect, if only to see if Beta-fall is significant or not.

Figure 4.1g shows an Gummel plot for a power transistor with Ikf=10A and Bf=100. The usual 
effects of Rb and Re at high current have been made very small so we can see the intersection of the 
base current line and the collector current line at high current at “A”. The ratio of collector current 

Free eBook EditionFree eBook Edition
p54        Power Amp Kalkulator User Guide PAK-1v0-NM November 1, 2012  Contents 



to base current (effective Beta) is shown as a third line (blue). The effective Beta peaks at around 
85% of the value set in the model (here it is 100). 

The bell shape curve for the effective Beta is created by base leakage current at the low current 
LHS. “B” marks the intersection where the leakage current equals the collector current. The leakage 
current looks like a second diode in parallel with the main base diode (the one that gives a Bf=100) 
and this is how the EM and GP models show it in an equivalent circuit to represent the model 
equations.
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Figure 4.1g. Beta derived from Gummel plot with Ikf=10A and Rb and Re effects have been 
made close to zero effect. Red is collector current and green is the base current. Blue is the 

calculated current gain (Ic/Ib).
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Figure 4.1h. Beta derived from Gummel plot with typical MJL21194C Rb and Re values. Note 
how the base voltage falls over for Vin above 0.7V due to Rb and Re degeneration effects.

Interestingly, at high currents a Gummel plot with effects of Rb and Re stripped away shows the 
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base current versus base-emitter voltage continuing rise after we see the collector current change to 
another slope above the Ikf knee. It shows that the base current remains “ideal” and is not affected 
by what is happening in the collector part. This can be used as evidence that the collector current is 
not produced by the base current intrinsically but instead the collector current arises from the base-
emitter voltage as is assumed by EM and GP model equations. 

As mentioned above, this leads to the concept of a virtual diode at the collector side with a larger 
saturation current than the base diode (Bf times) and it is this virtual diode that changes it's ideality 
factor Nf (or slope) from its normal value at low currents to a higher value at high currents (lower 
slope). It means the junction transistor effectively operates as a field controlled device. One possible 
explanation is an offset voltage to Vbe that moves the virtual diode plot to the left by Nf·Vt·ln(Bf) 
volts as shown by “C” (120mV for Bf=100). This offset voltage is related to the base width; the 
thicker the base the less offset voltage is 'seen' by the collector. 

EM and GP noticed that generally the slope at high current halves so Nf eventually becomes 2·Nf. 
This is generally obscured on a typical Gummel plot and requires special effort to see this effect. 
Figure 4.1h when compared to Figure 4.1g shows how the base voltage falls over for Vin above 
0.7V due to Rb and Re degeneration effects and obscured the internal base-emitter voltage 
relationship from being noticed. It may be thought that Rb and Re swamp the effect of Beta-fall and 
we can ignore it but Rb and Re degeneration do not affect the base current relationship with the 
collector current and this is seen in the beta curve still showing fall in current gain even at moderate 
currents of 5A here where Ikf is 14A so we are still well below the knee current.

The Ebers-Moll BJT model used a parameter θ to model the knee point for the transition and 
Gummel-Poon BJT used a similar term “Ikf”. The change of ideality slope of N to 2N represents a 
change from the normal diode current relationship with Vbe to a square-root of the normal current. 
The transition from one to the other turns out to be a solution of a quadratic equation which can be 
written using the quadratic formula. Recall, N=1 means the slope of Ic vs Vbe gives a change of 1 
decade of current for 60mV, so a half slope with N=2 requires 120mV per decade of current.

Gummel-Poon BJT model high current Beta-fall is modelled using 

Ib= Ic
Bf

(1+Ic / Ikf )
 (44)

   where IKF is the collector current where Beta-falls to 50% of Beta with no Beta-fall. Since Ic 
appears in this equation twice the collector current must be found using the quadratic equation 

Ic=√1+4 Ico/ Ikf −1
2/ Ikf

  where Ico=Bf⋅Ib (45)

Ico is the collector current calculated from the ideal diode equation with no Beta-fall. This shows 
that Ico follows the square-root of Ico at high currents (Ico>>IKF) as shown on the Gummel plot. 
But when Ico is <<IKF the binomial expansion gives Ic~Ico which is a straight line on the Gummel 
plot. 

Including Ikf in the Lambert W solution for the CE stage with Rin and Re
Introducing a series resistance the solution for high current Beta-fall involves a quadratic solution of 
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Ic ( Iin)Q10=
NVt

Rin
Beta +R e⋅( Beta+1

Beta )
W (x )

 where Beta= BF
1+ Ic / IKF  (46)

 giving 

Ic2( Rin
BF⋅IKF )+ Ic(R e '+ Rin

BF )−Vt⋅W ( x)=0  (47)

The solution is  Ic=√(b2−4ac)−b
2a

 where a,b,c can be identified in the previous quadratic 

equation. 

The Gm is obtained by differentiating the quadratic equation with respect to 'c' using the chain rule 

giving Gm=
(1+ Rp

((Bf +1)⋅Re ' ))
√(R e '+ Rin

(BF+1))
2

+4( Rp⋅Vt⋅W (x)
(BF+1)⋅IKF )

W (x)
1+W (x ) . 

Since the square-root expression is the discriminant √(b2−4ac)  an alternative form can be 
calculated from the quadratic equation √(b2−4ac)=b+2a Ic giving 

Gm=
(1+ Rp

((BF+1) R e ' ))
(R e'+ Rin

(Bf +1))(1+ 2 Ic
IKF )

⋅ W ( x)
1+W (x )

 where Ic has usually already been calculated.

The above equations were tested in earlier LTspice ABM's but they are not included in in the 
LTspice circuit files or the PAK Version 1.0 spreadsheet.

 An alternative approach to model high Current Beta-fall
In Figure 3.1-4 it was noted that the Id5 plot for two series diodes with a shunt Rs across one of the 
diodes gives a high current Beta-fall knee. It may provide an equation solution and may enable to an 
alternate SPICE model for the BJT which includes parasitic resistances in the equations to reduce or 
eliminate annoying non-convergence problems of the present SPICE BJT models. It also means a 
SPICE subcircuit can be formed to add various non-idealities of a BJT such as high current (and 
low current Beta-fall in next section).

 4.1.4  Low current Beta-fall
In the Gummel-Poon model the base current is non-ideal and is modelled effectively by two diodes 
in parallel – one of these diodes carrying current in relation to Ic and the other diode a leakage 
current unrelated to Ic. The 'leakage diode' is modelled as having a high series resistance so its 
current reaches a limit of a percent or less of the first diode when the base-emitter voltage is above 
the knee voltage of approximately 0.6V. This combination generates dual-slopes on the base current 
curve in the Gummel plot. The 'leakage diode' has a higher slope modelled by NE (where NE>NF 
and typically NE~2). 

This is effect is demonstrated in circuit Figure 4.1i (L) using two diodes in series D3 and D4, with 
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D2 representing the collector current part. Figure 4.1j (R) shows the individual currents in each 
branch and the total input current. With these settings the low current Beta knee occurs at around 
0.25V.

No equation solutions are given in the LTspice circuit files or the PAK Version 1.0  spreadsheet for 
low current Beta-fall.

Rs1
{Rs}

DTTD_
D2

Rs2
{Rs}

DTTD_
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DTTD_
D4

V1

0.25

Vin

Plot
Ln(I1+I3)
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Log10( I (D2)) Log10( I (D2)+I (D4))
Log10( I (D4))

  

Figure 4.1i (L). Circuit for generating low current Beta-fall for the base-emitter diode leakage 
using D3 and D4 with D2 representing the collector current part. Figure 4.1j(R) the currents.

 Rs is stepped 0.5R and 1R

This circuit may provide a way to model low current Beta-fall in future equation solution and may 
enable to an alternate SPICE model for the BJT.

 4.2  SE CE with Shunt Voltage Feedback
In this circuit a feedback resistor is added from collector to base for a Common Emitter amplifier as 
shown in Figure 4.2. The derivation of the solution published by Thomas Banwell [ref 1 Banwell 
Fig.12 Eq.21] but without emitter degeneration (Re). The solution below now includes Re .

Iin

Ib

Ic

Q1

Re

RcRf

Rin
Vcc

Vin
Vc

Ve

Figure 4.2. Common Emitter amplifier with base to collector and emitter resistors

Three equations are written. First the input voltage to the base node:
For Rin write  (Vbe+Ve)−Vin= Iin⋅Rin  where Ve= Ie⋅R e (48)

Note Iin is defined as flowing from the power source through Rc and Rf. Although voltage loops 
can be defined arbitrarily, this an intuitive approach (based on the power source). Repeating this for 
the voltage across Rf due to current Iin plus Ib:
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for Rf … Vc−(Vbe+Ve)+ Iin⋅Rf + Ic
Beta

⋅Rf (49)

for Rc … Vcc−Vc= Iin⋅Rc+ Ic⋅Rc+ Ic
Beta

⋅Rc (50)

We first eliminate Vc using (38) and (39) then eliminate Iin using (37). Rearrange (38) and (39)

 Vc=(Vbe+Ve)− Iin⋅Rf − Ic
Beta

⋅Rf  and Vc=Vcc− Iin⋅Rc− Ic⋅Rc− Ic
Beta

⋅Rc  

equating (Vbe+Ve)− Iin⋅Rf − Ic
Beta

⋅Rf =Vcc− Iin⋅Rc− Ic⋅Rc− Ic
Beta

⋅Rc

collecting terms … Ic(Rc+ Rf +Rc
Beta )=Vcc−(Vbe+Ve)− Iin(Rf +Rc)

Substitute Rc '=Rc+(Rf +Rc)/ Beta . Now eliminate Iin 

Ic Rc '=Vcc−(Vbe+Ve)−( Rf +Rc
Rin )((Vbe+Ve)−Vin)  

Since Ve is IeRe=IcRe(Beta+1)/Beta we can now collect Ve into Ic. First get Ve to LHS

Ic Rc '+Ve(1+ Rf +Rc
Rin )=Vcc−(1+ Rf +Rc

Rin )Vbe−( Rf +Rc
Rin )Vin  

then substitute Ve and substitute RTot=Rin+Rf +Rc

 Ic Rc '+ Ic R e( Beta+1
Beta )( RTot

Rin )=Vcc−( RTot

Rin )Vbe−(Rf +Rc
Rin )Vin

Ic(Rc'+R e
RTot

Rin (Beta+1
Beta ))=Vcc−( RTot

Rin )Vbe−(RTot

Rin )Vin  so simplify to

Ic Rc ' '=Vcc−(RTot

Rin )Vbe−( RTot

Rin )Vin  where Rc ' '=Rc'+R e
RTot
Rin ( Beta+1

Beta ) (51)

Next, Vbe can be eliminated using the log form of the diode Equation (23), giving 

Ic Rc ' '=Vcc−(RTot

Rin )NVt⋅ln( Ic
Is +1)−(Rf +Rc

Rin )Vin  (52)

We now proceed to get Equation (41) into the Lambert W-function form of w=ln(x/w) with Ic or w 
terms on the LHS and ln(x/w) terms on the RHS where the log denominator w must match the LHS 
w precisely. Moving terms in front of the log gives 

Ic Rc ' '( Rin
RTot NVt )=−ln( Ic

Is
+1)−( Rin

RTot NVt )(( Rf +Rc
Rin )Vin+Vcc)  

Ic Rc ' ' Rin
RTot NVt =ln( Is

Ic+ Is)−(( Rf +Rc
RTot NVt )Vin+( Rin

RTot NVt )Vcc)
Add Is to both sides

 ( Ic+ Is) Rc ' ' Rin
RTot NVt

=ln( Is
Ic+ Is )−(( Rf +Rc

RTot NVt)Vin+( Rin
RTot NVt)Vcc)+ Is Rc ' ' Rin

RTot NVt

So we can write this as 
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( Ic+Is) Req
NVt

=ln( ( Is Req
Vt )

( Ic+Is )(Req
Vt ))−(( Rf +Rc

RTot NVt )Vin+( Rin
RTot NVt )Vcc)+ Is Req

NVt  where 

Req= Rin Rc' '
RTot

 or Req= Rin
RTot

(Rc( Beta+1
Beta )+ Rf

Beta )+R e( Beta+1
Beta )

(53)

Since we have matched LHS & RHS w terms we can now bring the remaining RHS terms inside the 
log

( Ic+Is) Req
NVt

=ln(( Is Req
NVt )exp((( Rf +Rc

RTot NVt )Vin+( Rin
RTot NVt )Vcc)+ Is Req

NVt )
( Ic+ Is )( Req

NVt ) )  (54)

and write the inverse as

( Ic+Is) Req
NVt

=W (( Is Req
NVt )exp((( Rf +Rc

RTot NVt )Vin+( Rin
RTot NVt )Vcc)+ Is Req

NVt ))  

then solving for Ic gives 

Ic= NVt
Req

W ((Is Req
NVt )exp((( Rf +Rc

RTot NVt)Vin+( Rin
RTot NVt )Vcc)+ Is Req

NVt ))− Is (55)

Expressing in terms of Vk and a common denominator gives 

Ic= NVt
Req W (exp((Rf +Rc

RTot )Vin−Vk+ Rin
RTot

Vcc

NVt )) − Is
 

where Vk=NVt⋅ln( NVt
Is⋅Req) −Is Req and 

Req= Rin
RTot

(Rc( Beta+1
Beta )+ Rf

Beta )+R e( Beta+1
Beta )

56/(56)

LTspice plot Figure 4.2a show this solution is amazingly accurate. Although the derivation is 
tedious we can now use it as a template to write a solution to similar circuits (such as the CFP later).

This solution is similar to Thomas Banwell's but this version now includes local degeneration from 
Re. As noted by Thomas Banwell the seemingly complicated interactions in this circuit actually 
reduce to a few key resistor combinations: Req, (Rf+Rc)/RTot , Rin/RTot and Rf/Rin. (The ratio 
Rf/Rin is mentioned in Section 4.2b below). From this exact solution we can now understand how 
this circuit works in large signal terms – this has been impracticable with simulators or small signal 
analysis. 

The PAK spreadsheet project is for sharing tedious circuit solutions like this and hopefully avoiding 
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the repeating the same solutions unnecessarily. 

 4.2a Calculating the output voltage
Having solved one current Ic we can now find any other current, voltage, gain, power or whatever. 
Vout is now found by back substitution into the original equations. For the output voltage we can 
use 

Vout=Vc=Vcc− Iin⋅Rc−Ic⋅Rc− Ic
Beta

⋅Rc  where Iin= Vbe+Ve−Vin
Rin  and 

Vbe=NVt ln( Ic
Is +1) and Ve= Ie⋅R e= Ic R e(Beta+1

Beta )
 which gives 

Vout=Vcc− Rc
Rin NVt ln( Ic

Is +1)− Rc Re
Rin (Beta+1

Beta ) Ic− Rc
Rin Vin−Rc( Beta+1

Beta ) Ic  

Vout=Vcc−(1+ Re
Rin)(Beta+1

Beta )Rc⋅Ic − Rc
Rin(Vin+NVt ln( Ic

Is
+1)) 57/(57)

-2. 0V -1. 5V -1. 0V -0. 5V 0. 0V 0. 5V 1. 0V 1. 5V 2. 0V
-1V
0V
1V
2V
3V
4V
5V
6V
7V
8V
9V
10V
11V

-1mA
0mA
1mA
2mA
3mA
4mA
5mA
6mA
7mA
8mA
9mA
10mA
11mA

V(vc1) V(vceq) I c(Q1a) I (B7)

Figure 4.2a Common Emitter amplifier with Rf & Rin with Re stepped 1mR, 10R and 100R. 
LTspice is red & brown, while ABM equations are gold & cyan. Vcc=10V, Rc=Rin=1k, 

Rf=10k. Beta=100. Some small differences are visible at saturation.

Figure 4.2a shows a plot for Ic and Vout with Re stepped that includes Ic and Vce saturation. 
Equation (57) was modified to allow a large reverse input voltage. The log term in Equation (57) 
runs out of numeric range when Vin is more negative than -1.2V. An equation that fixes this is 

Vbe≃Min(Max(NVt⋅ln( Ic
Is

+1),0) , Rf +Rc
RTot

(Vin−Vx) + (Vk+IsReq))  

where Vx=
(Vk1−(Rin /RTot )Vcc)

(Rf +Rc)/ RTot

58/(58)

 where Vx is the input voltage where the W(x) argument of Equation (58) is W(e^0) or W(1). The 
inner Max(x,y) function stops using the Ln(f(Ic)) when Vbe passes through zero and the Max(x,0) 
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function keeps it at zero rather than switching to an unwanted large -ve limit when overflow occurs. 
The other function (a straight line) then takes control using the outer Min function. The plot in 
Figure 4.2a is extended to -2V to show that Vc is now correctly calculated beyond -1.2V. Saturation 
for Ic and Vc was obtained using 

Ic=Min1( Ic , IcSat , 0.01⋅IcSat)  & IcSat=
(Vcc−Vt⋅ln (Beta))

R e+Rc (59)

Vc=Max1(Vc , IcSat⋅R e+Vt⋅ln (Beta) ,Vt⋅ln (Beta )) (60)
where the above Min1(x,y,e) and Max1(x,y,e) are User Defined functions in LTspice using 

. function Max1( X ,Y , e) { 0.5⋅( X +Y +√(( X −Y )⋅( X −Y )+4⋅e⋅e)) }  (61)

. function Min1( X ,Y , e) { 0.5⋅( X +Y −√(( X −Y )⋅( X −Y )+4⋅e⋅e)) } (62)
Note two curly brackets are required around the function, also put the dot (period) in front of 
'Function' to make it a SPICE command.

 4.2b Calculating the differential voltage gain
The differential voltage gain dVc

dVin  can be calculated for any Vin by differentiation of Equation 

(57) with respect to Vin, giving 

AvCL=
dVc
dVin =−( Rf

Rin −
1

1+W (57)
Rin+Rf

Rin
Rf +Rc

RTot )  63/(63)

 where W(57) is the Lambert argument used in Equation (57). 

Interestingly, the voltage gain is not defined explicitly by Re as we might expect since it alters the 
gm of the transistor and therefore the internal voltage gain, but it is affected by W(57)). Rf/Rin is 
the standard result for the gain limit of a transresistance stage and an inverting opamp. 

 4.2c Estimates of Distortion HD2 and HD3 
The section above shows that we can now directly calculate the differential current gain and voltage 
gain of a complete BJT circuit. In the above CE example the accuracy is limited only by the models. 
Given the differential gain equation we can now make estimates of second harmonic distortion and 
third harmonic distortion (HD2 & HD3) levels. 

SPICE calculates nonlinear harmonic distortion levels using FFT processing from a number of 
sinewave cycles in the Transient simulation mode. This involves a huge computational effort. Often 
we are after rough estimates of second harmonic distortion and third harmonic distortion from 
trigonometric relationships. The following uses Ed Cherry's equations [ref Cherry JAES 2000, EW 
Jan 1995]. It yields analytic approximations (rather than specific operating point distortions of FFT 
using SPICE) which are more helpful to designers showing how distortions arise and how they are 
related to circuit choices and temperature.

The 2nd and 3rd harmonic distortion figures to be estimated for any AC level and bias voltage using 

 HD2=δG1−δG2
8

⋅100% HD3=δG1+δG2
24

⋅100 %  where (64)

δG1=G1−G0
G0  δG2= G2−G0

G0   (65)

 where and G1 and G2 are the gains at the dip and peak of the AC cycle and G0 is the gain at the 
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zero crossing. These are calculated using Equation (63) where G1 is obtained with Vin=Vdc+Vpk 
and G2 is obtained with Vin=Vdc-Vpk for an AC sinewave superimposed on a DC bias point. Then 
a plot can display HD2 and HD3 as Vdc is varied over a range op bias settings. 

The model used in these equations ignores saturation of the transistor. Section 4.1.1showed how 
saturation can be included to limit the output voltage swing to the available supply voltage and this 
includes limiting the collector current to reflect the Vce minimum voltage limit of a BJT. For THD 
estimates a test for saturation is necessary over the full range of input signal; if there is no saturation 
at any point in the cycle then the above equations estimates are valid, but the slightest saturation 
will invalidate the distortion estimates.

See Section 15 for estimation of THD for Class-AB crossover distortion. 

 4.3  SE CC stage (Common Collector) or Voltage Follower 
This section covers the Voltage Follower (VF) as a special case of the CE stage with no resistor in 
the collector and the output voltage is across the emitter resistor.

2N5551C
Q1

Re

Rin Vcc
Vin Vb

Vout

Figure 4.3. SE Common Collector stage (CC) or Voltage Follower (VF)
The CC solution for the output voltage across Re (Vout=Ve) is easily calculated using Ic from the 
above CE solution with emitter degeneration and Rc=0 (external Rc removed but may still include 
the RcP parasitic term). We get Ic from

 Ic= N⋅Vt
Req

W (exp(Vin−Vk
N⋅Vt )) − Is  where Vk=N⋅Vt⋅ln( N⋅Vt

Is⋅Req) − Is⋅Req  and 

Req= Rin
Beta +R e⋅(1+Beta

Beta )  
(66)

then

Vout= Ic⋅(Beta+1
Beta )⋅R e (67)

If an additional load resistor is placed across Re then we calculate the new Req with RL in parallel 
with the previous Req giving 

Req= Rin
Beta +R e⋅(1+Beta

Beta )∥RL  and then use IL=Vout
RL (68)

The CC solution is different to the CE stage in that the CE solution is not affected by Rc and 
external loading at the collector. But in the CC the external load affects Req and therefore is part of 
the Lambert W inverse solution. This is an important practical issue when designing power 
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amplifiers, which usually use a CC Voltage Follower output stage which means loading variations 
not only affect the output stage solution but also can affect the loading on the preceding VAS stage 
which plays a large part in determining the distortion levels of the overall power amplifier. With a 
CC Voltage Follower output stage Beta variations in the output transistors can affect the loading on 
the VAS stage and equations for output stages therefore need high current Beta-fall to be included 
(if only to see if Beta-fall is significant or not).

Plots are shown in Figure 4.3a with Vce saturation and no added RL. The RHS plots are Vout and 
d(Vout) 

0V 1V 2V 3V 4V 5V 6V 7V 8V 9V 10V 11V 12V
0V

1V

2V

3V

4V

5V

6V

7V

8V

9V

10V

11V

12V

13V

-0. 3

-0. 2

-0. 1

0. 0

0. 1

0. 2

0. 3

0. 4

0. 5

0. 6

0. 7

0. 8

0. 9

1. 0

V(vout )*I (B3)/ I (R1) V(vp1)*I (B3)/ I (R1)
d(V(vp1))*I (B16)/ I (R1) d(V(vout ) )*I (B16)/ I (R1)

 0V 2V 4V 6V 8V 10V 12V
0V

1V

2V

3V

4V

5V

6V

7V

8V

9V

10V

11V

-1. 0mA

-0. 8mA

-0. 6mA

-0. 4mA

-0. 2mA

0. 0mA

0. 2mA

0. 4mA

0. 6mA

0. 8mA

1. 0mA

1. 2mA

d(I c(Q1))*I (B16) / I (R1) d(I (B11))*I (B16)/ I (R1)
V(vp1)*I (B3)/ I (R1) V(vout )*I (B3) / I (R1)
I c(Q1)*I (B15)/ I (R1) I (B11)*I (B15) / I (R1)

Figure 4.3a. Common Collector using the CE solution then calculating Vout from Ve. Right 
shows Vout and d(Vout). Rin 1k, Rc=1m, Re stepped 100R and 1k. Beta=100.
Left shows Ic(Q1) with Beta stepped 10 and 100 and Rin 1k, Rc=1m, Re=1k. 

 4.4  SE CE (or CC) with Current Drive 

Rin Vcc
Q1

Re

Iin
Ve

Vb

Rc
Vc

Figure 4.4. General circuit for current driving a CE stage Iin rather than a voltage source Vin

Figure 4.4 shows a general circuit when current drives a CE stage with Iin rather than a voltage 
source Vin. This is quite common in amplifiers when a CE stage drives another stage and the first 
stage provides a current source along with a shunt resistance. Here the shunt resistance is 
represented by Rin and connected to common. Later in the CE+CC we have Rin connected to Vcc, 
and later in the CFP Rin is the base-emitter resistor Rbe for the second transistor. 

In this solution we generate an equivalent Thévenin input voltage Vb of Vin=Iin·Rin and this 
appears in the equation for Ic1 where Vin appeared. Also Q2 sees the same Req as before, giving
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Ic1= N1⋅Vt
Req

W (exp( Iin⋅Rin−Vk
N1⋅Vt )) − Is1 where Vk1=N1⋅Vt⋅ln( N1⋅Vt

Is1⋅Req) −Is1⋅Req  

and Req= Rin
Beta1+R e⋅(1+Beta1

Beta1 )  
(69)

Figure 4.4b,c shows the Common Emitter current (Ic) and voltage (Vc) plots with current drive 
.using a current source of 1mA/V. 

0.0V 0.2V 0.4V 0.6V 0.8V 1.0V 1.2V 1.4V 1.6V 1.8V 2.0V
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Figure 4.4b,c shows the Common Emitter current (Ic) and voltage (Vc) plots with current 
drive .using a current source of 1mA/V. Rin=1k, Rc=1k and Re stepped 10R, 100R, 1k, 

Beta=100.
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 Figure 4.4d Left shows the Common Emitter Ic and Vc when Beta is stepped 10 & 100 with 
Rin=1k, Rc=1k and Re=100, Figure 4.4e Right shows Ve with Re stepped 10R, 100R, 1k and 

Rin=1k, Rc=1k.

It may seem strange that only Iin·Rin appears the Ic equation since there is nonlinear loading of the 
transistors base. But this shows the utility of the Lambert W solution where you only need to know 
two terms: first the equivalent circuit resistance Req (which is effectively where the base-emitter 
diode has zero resistance which is approached at very high current), and second the input voltage 
which is simply the driving current source multiplied by the input resistance (and ignoring the 
nonlinear part due to the transistor base-emitter circuit). The Lambert W inverse function takes care 
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of the nonlinear loading of the transistor junction for you.

 5.  SE CE Complementary Feedback Pair
This section develops a solution for the two transistor Complementary Feedback Pair (CFP) also 
known as the Szakli pair. This is slightly easier to solve than the Darlington pair so the CFP is 
covered first. 

 5.1 Open Loop SE CE Complementary Pair (no Rbe) 
The complementary pair can be configured in a number of ways. The easiest configuration to solve 
first is when Q2 does not provide current feedback to Q1 via an emitter resistor for Q1 with link X1 
closed and X2 open as shown in Figure 5.1. Also the complementary pair is easier to solve when 
the base-emitter transistor (Rbe) for Q2 is absent (normally present as a speed up resistor).

Q1

Re

VccQ2
PNP

X1
X2

Vin

Ve

Vc1

Ic2NPN

Figure 5.1. Simple Complementary Feedback Pair without Rbe for Q2. Link X1 is closed and 
X2 is open for an open loop solution.

In open loop we can write the equation for Ic1 independent of Ic2 and Ic2 is just Beta2 times Ic1. 
We can write a solution based on Equation (56) as

Ic2=Beta2⋅Ic1  where Ic1= N1⋅Vt
R eq

W 1(exp(Vin−Vk1
N1⋅Vt )) − Is1  where 

Vk1=N1⋅Vt⋅ln( N1⋅Vt
Is1⋅R eq ) − Is1⋅R eq  and 

70/(70)

 Req=R e+ Rin
Beta1+1 (71)

0.4V 0. 5V 0. 6V 0.7V 0. 8V 0. 9V 1.0V
0. 0A

0. 2A

0. 4A

0. 6A

0. 8A

1. 0A

1. 2A

1. 4A I e(Q2a) I (B1)
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Figure 5.1a. Open loop SE CE Complementary Feedback Pair without Rbe. LTspice Ie2 (red) 
and ABM Ie2 (cyan). Re stepped 10R and 100R. Beta1=Beta2=100, Rin=0, RL=0.

 5.2  Closed loop Complementary Feedback Pair (no Rbe)

Q1

Re

VccQ2
PNP

X1

X2

Vin

Ve

Vc1

Ic2NPN

Figure 5.2. Complementary Feedback Pair, Link X2 is closed and X1 is open for a closed loop.

To simplify the analysis Rin is removed. We have Ic2=Beta2·Ic1 where Ic2 feeds back to Q1 adding 
an emitter voltage component of Ic2·Re which subtracts from Vin. First the solution for Q1 is 

 Ic1= N1⋅Vt
R e

W (exp(Vin− Ic2Re−Vk1
N1⋅Vt )) − Is1 (72)

We note Ic2 is a pure current source so other terms are the same as open loop which includes Vk1. 
We need to remove Ic2·Re from the RHS. But how. If we go back one step to the log form 
w=ln(x/w) form, then we can move the Ic2·Re to the LHS, we find,

( Ic1+ Is1) R e
N1⋅Vt =ln((exp(Vin− Ic1⋅Beta2⋅R e−Vk1

N1⋅Vt ))
( Ic1+ Is1) R e

N1⋅Vt
)  where 

Vk1=N1⋅Vt⋅ln( N1⋅Vt
Is1⋅R e ) − Is1⋅R e

(73)

and then moving the RHS “Ic1·Beta2·Re” to the LHS giving,

( Ic1+ Is1)
R e⋅(Beta2+1)

N1⋅Vt =ln((exp(Vin−Vk1
N1⋅Vt ))

( Ic1+ Is1) R e
N1⋅Vt

)  (74)

then balancing the equations by multiplying the logs' denominator and numerator by (Beta2+1) we 
arrive at 
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( Ic1+ Is1)
R e⋅(Beta2+1)

N1⋅Vt =ln( (Beta2+1)(exp(Vin−Vk1
N1⋅Vt ))

( Ic1+ Is1) R e (Beta2+1)
N1⋅Vt

)  

( Ic1+ Is1)
R e⋅(Beta2+1)

N1⋅Vt =ln((exp(Vin+N1Vt ln (Beta2+1)−Vk1
N1⋅Vt ))

( Ic1+ Is1) R e( Beta2+1)
N1⋅Vt

) (75)

So Ic1CL=
N1⋅Vt
R eq W (exp(Vin−Vk1CL

N1⋅Vt ) − Is1)  where

 Vk1CL=N1⋅Vt⋅ln( N1⋅Vt
Is1⋅R eq ) − Is1⋅R eq  and Req=R e⋅(Beta2+1)

76/(76)

To get Ic2 (or Ie2) use 
Ic2=Beta2⋅Ic1CL or Ie2=(Beta2+1)⋅Ic1CL (77)

Next, Rin is introduced by guessing that it adds a component of resistance to Req of Rin/(Beta1+1). 
This was confirmed by simulation and is shown by Figure 5.2a. The derivation with Rin included 
in the above equations have not been done. With Rin present use the updated form for Req as 

Req=R e⋅(Beta2+1)+ Rin
Beta1+1

 
(78)

Figure 5.2b shows the plots for Re is stepped in closed loop and a resistor RL to Vcc. Results agree 
well with LTspice while other parameters were stepped as well.
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Figure 5.2a. Closed loop SE CE Complementary Feedback Pair without Rbe. Vce (Left) and 
Ie2 (Right). Beta1=Beta2=100, Re=100, RL=1k. Rin stepped 1k and 100k.
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Figure 5.2b. Closed loop SE CE Complementary Feedback Pair without Rbe. Vce (Left) and 
Ie2 (Right). Beta1=Beta2=100, Rin=RL=1k. Re stepped 1mR, 10R, 100R.

Tracing the steps the feedback voltage subtracting from Vin due to Ic2 (or Beta times Ic1) is 
transferred to the LHS where it adds to Ic1, then to balance the change due to feedback we need to 
scale the log denominator by the same factor as used for Ic1 on the LHS and this requires the 
numerator to be scaled by the same factor. Then the numerator factor can be merged into an offset 
voltage, which appears a new reduced knee voltage in closed loop called VkCL. 

Now we can see analytically the effect of NFB on the large signal response. Firstly, when we 
compare the open loop case to the close loop case we see the feedback current increases the 
equivalent series resistance Re by Beta2 times, so including the original Re gives a total loop gain 
of (Beta2+1)·Re. This higher resistance means the closed loop gain Ic2/Vin is reduced by the factor 
Beta2/ (1+Beta2) – the expected effect for series voltage negative feedback. 

Secondly, there's the expected reduction in the open loop knee voltage. This is reduced by 
N1·Vt·ln(10) volts; it's the standard 60mV per decade figure. With a typical Beta of 200 this 
involves a reduction of about 140mV due to NFB. Notice that in the (theoretical) limit the effective 
VkCL does go to zero as expected; in other words we can say an infinite loop gain reduces the input 
offset voltage Vk to zero.

 5.3 SE CE Complementary Feedback Pair with Rin & Rf (no Rbe).
Having solved the closed loop complementary pair with Rbe absent we can try solving Figure 5.3 
with Rin and Rf by substitution of Beta's in the above final equations.
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Figure 5.3. SE CE Complementary Feedback Pair with Rf, Rin (no Rbe)

In this circuit RL has been renamed RL because it now appears at the emitter of Q2 and replaces Rc 
in the previous equations with RL. Similarly Vout replaces Vc. In shorthand form we can write the 
changes as Rc→RL and Vc→Vout and Beta→Beta1·(Beta2+1). Notice the emitter current of Q2 is 
(Beta2+1)·Ic1. (Ie2 is also Ic1+Ic2, useful for later). 

Beginning with Ic1 

Ic1= NVt
Req W (exp((Rf +Rc

RTot )Vin−Vk+ Rin
RTot

Vcc

NVt )) − Is
 

Where Vk=NVt⋅ln( NVt
Is⋅Req) −Is Req & RTot=Rin+Rf +RL &

(79)

Req=( Rin
Beta1

⋅( Rc⋅(1+Beta1⋅(Beta2+1))
Rtot

+ Rf
Rtot )+R e ( Beta1⋅(Beta2+1)+1)

Beta1 )  (80)

Having obtained Ic1 we can calculate the load current using Ie2 where 

 Ie2= Ic2 Beta2+1
Beta2  which is Ie2= Ic1⋅(Beta2+1) (81)

The output voltage can now be calculated by substitutions Vc→Vout and Beta→Beta1·(Beta2+1) 
and Ic→Ie2/(Beta2+1) for Vbe1, giving

Vout=Vcc−(1+ R e
Rin)( Beta1( Beta2+1)+1

Beta1(Beta2+1) )RL⋅Ie2 −

Rc
Rin (Vin+NVt ln( Ic1

Is +1))
(82)

Figure 5.3a shows the plots when Re is stepped and results agree well with LTspice. Beta2 was set 
to 1 and B2 to 10, Rin and RL were stepped and and plot matched as well in all cases. Figure 5.3b 
shows the plots when Rf, Rin and Re are all stepped so any regions of error can be spotted.
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Figure 5.3a. SE CE Complementary Feedback Pair with Rin & Rf (no Rbe). Vce Left and Ie2 
Right. Beta1=Beta2=100, Rf=10k, Rin=RL=1k, Re stepped 1mR, 10R, 100R.

Figure 5.3b. As above but stepped Rin with stepped Rf and stepped Re (27 cases) – a “rat's 
nest”. All plots cover the red LTspice plots – all solutions are shown to be accurate.

 5.4  SE CE Complementary Feedback Pair with Rbe (no Rin or Rf)
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Figure 5.4. Common Emitter Complementary Feedback Pair with Rbe (no Rin or Rf). 

Adding a base-emitter resistor (Rbe) bypasses some of the base current from Q2 and this has the 
effect of progressively reducing the net Beta of Q2 as Q1 current falls. Rbe provides a speed up 
path to drain the stored charge in the base of Q2. Without this resistor the base junction charge is 
used by base current to support the collector current. If Rbe is too small the net Beta for Q2 is too 
small and the driver transistor must dissipate much of the power that Q2 otherwise dissipates. 
Notice also in Equation (70) when Rbe is very small the circuit Q2 provides no current gain and the 
circuit reverts to the single transistor solution. But if Rbe is too large the turn off time Q2 is no 
reduced by much and the usefulness of Rbe is lost. There is a similar effect with Rbe extending the 
breakdown voltage Vcemax , where too large Rbe does not improve Vcemax by much and the 
usefulness of Rbe is lost. 

To solve Figure 5.4 with Rbe added we are actually trying to solve a global feedback loop around 
two nonlinear BJT-diode equations. A solution for Figure 5.3 was done by omitting Rbe which 
meant Q2 was a linear current amplifier and there was therefore only one diode equation to solve 
and that we can solve with global feedback present. We can also write the solution with two 
cascaded transistors without overall feedback as a product of two independent diode solutions 
assuming Q1's Early effect is neglected. But now we want a solution for two diode/transistors with 
global feedback. Is this possible? 

We can infer from Equation (76) that an exact explicit solution is not possible in terms of Vin 
because the effective Beta2 due to Rbe appears in the w term for Ic1. We can write w=Req/Vt where 
Req is dependent on Beta2 which varies with Ic1 and hence Vin. It was shown earlier that balancing 
the Lambert W-function must remove any dependency on Vin for the w term. Since Vin necessarily 
appears in the w term in Equation (76) we can infer that the normal Lambert W-function cannot 
provide an exact solution for a CFP circuit with Rbe. Appendix A3 provides a proof of this by 
attempting to balance the Lambert W equations from first principles with Rbe present and it cannot 
be balanced with Rbe present. 

It is surmised that most circuits that use two or more transistors with global feedback are not 
solvable in an exact form using the Lambert W-function approach above. Maybe there is another 
function that can provide a solution? In the mean time it appears that the only circuits that can be 
solved with global feedback in exact form are elementary single transistor circuits or single diode 
circuits or complementary pairs with no Rbe resistors. Open loop circuits devoid of feedback 
around more than one stage can still be expressed in an exact form; the complication is solving the 
global feedback around more than one diode/transistor stage. Of course there are still approximate 
solutions that give very good results. The following example demonstrates one of the better 
approximations for the effect of Rbe in the CE Complementary Feedback Pair.
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An approximated solution for Figure 5.4 circuit can be obtained using Equation (76) by formulating 
an approximation for the effective Beta of Q2 as a function of Vin. Recursion can also be used to 
improve the accuracy of a single approximated equation if more accuracy is needed. It is a time 
consuming process to find a good approximation that do not require recursion for most cases. The 
following approximation presented for Figure 5.4 illustrates these goals for formulating 
approximations. We use simple approximations based on the underlying effects, usually using the 
first derivative to formulate a Newton Raphson improved solution, and this usually avoids empirical 
fitting factors. Sometimes empirical fitting factors are useful to tweak the improved solution.

The approximation chosen for solving Figure 5.4 uses an approximation for effective Beta2 
(Beta2EFF) that is later used in the Lambert W-function solution by replacing Beta2 with Beta2EFF 

which varies with Vin. A switch function is used to turn on Beta2Eff when the voltage across Rbe 
reaches approximately Vk2. The switching point can be calculated reasonably accurately because 
we know Beta2 is effectively zero before Q2 starts to conduct and the input voltage required to 
obtain Vk2 across Rbe can be calculated using 

Vsw=Vt Vk2
Vt Re4( 1

Rbe4+ 1
Beta1⋅Beta2⋅R e )

+Vt⋅ln(Vk2
Vt

⋅Re4( 1
Rbe4

+ 1
Beta1⋅Beta2⋅R e ))+Vk1

 83/(83)

The term Beta1·Beta2·Re caters for very high Rbe values where the Q2 base current determines the 
input voltage needed for Vbe2 to reach Vk2.

Current Ic1 can be calculated at Vin=Vsw using 

I1sw= N1Vt
Re4

W (exp(Vin−Vk1
N1Vt ))  (84)

From these two values we build an approximation for Beta2EFF based on straight line 
approximations for Ic1 and Ic2 after Vsw (once Q2 turns on). Ic1 starts from I1sw at Vsw and is 
approximated by a line with a constant slope of 1/(Beta2Re) due to Ic2 feeding current into Re. Ic2 
starts from zero at Vsw using the Max function and has a slope of 1/Re. The ratio of these two 
currents Ic2/Ic1 gives the correct limits for Beta2Eff with large input voltages, at Vsw, and the 
correct general shape between these limits.

Beta2Eff ≃
Beta2

(1+ I1sw⋅Beta2⋅R e+Vo
Max (Vin−Vsw , 0) )  85/(85)

where Vo is a constant fitting term that improves the approximation for Beta2Eff. 

But Beta2Eff rises quicker toward 100% of Beta2. Including the offset 'tweak' or fitting term Vo 
gives a good fit to the required LTspice Beta2Eff curve (IcQ2/IcQ1) as shown in Figure 5.4a. This 
tweak removes the need for recursion in most cases.
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Figure 5.4a. Shows Beta2Eff from LTspice (pink) and Beta2Eff (brown) from the linear 
approximation for Ic1 and IC2 shown as I(B3). With fitting term Vo (30mV) the Beta2Eff and 

IC2App are now very close to LTspice circuit curves. 
Rbe=100k, Re=100R, Beta1=Beta2=100, no Beta-fall effects or Early effect.

Varying the fitting term Vo for the best fit to the LTspice curve requires 30mV when Rbe is 100k 
and Re is 100R. Beta2Eff and IC2App very closely follow the LTspice curves using this very simple 
approximation. A function was formulated for Vo is to cover a wide range of values for Rbe. It is 
also possible to calculate Vo for any Rbe once the solution for Ic1 has been validated.

An empirical approach can used to find a function for Vo by plotting the optimum choice of Vo 
against (Rbe/Beta2)/Re, where Vo is found using the circuit in with ABM Equations (65)-(67) 
above. The following is provided as an example. Table 5.4 shows the data and resulting values 
using two fitting curves.

Table 5.4. CFP using Beta1=Beta2=100 and Re=100R
Rbe 100 1k 10k 100k 1Meg 10Meg
(Rbe/B2)/Re 0.01 0.1 1.00 10 100 1000
Vo (target) 10 1.0 0.20 30m 5m 1m
Vo1 (fn 1) 20 2.0 0.20 20.7m 2.7m 0.8m
Vo2 (fn 2) 8.0 1.3 0.20 32m 5.0m 0.8m

Vo1=0.2V⋅( 1
Rbe /( Beta2⋅Re )

+ 1
300)  (86)
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Vo2=0.2V⋅( Rbe
Beta2⋅R e)

−0.8
 (87)
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Figure 5.4b Shows Beta2Eff approximate function with Vo2 (cyan) and LTspice effective Beta 

from Ic2/Ic1 (red). Rbe stepped 100R to 1Meg, Re=100R, Beta1=Beta2=100, no Beta-fall 
effects or Early effect.

Writing the solution for Ic1 and Ic2
1. Now we can solve Ic1 for Figure 5.4 by employing Beta2Eff with Equation (76) and Vo2 

equation giving

Ic1= N1⋅Vt
R e⋅(Beta2Eff +1)

W (exp(Vin−Vk1
N1⋅Vt )− Is1)   and 

Vk1=N1 Vt⋅ln( N1⋅Vt
Is1⋅R e (Beta2Eff +1)) − Is1 R e

(88)

Note IL is Ic1+Ic2 since Ic1 splits through Rbe and recombines with Ic2 at the load, giving
Ic2= Ic1⋅Beta2Eff and IL= Ic1⋅(Beta2Eff +1) (89)

Figure 5.4c shows the load current for LTspice for a range of Rbe values from 100R to 1Meg. The 
error is only a few percent over 4 decades of Rbe using a single approximate solution and no 
recursion.
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Figure 5.4c. Shows supply current. LTspice (red) and Ic1+Ic2 using Beta2Eff . Rbe stepped 

100R to 1Meg, Re=100R, Beta1=Beta2=100, no Beta-fall effects or Early effect.

Calculating Vo
As mentioned it is possible to calculate Vo for any Rbe after a solution for Ic1 is known for certain. 
The empirical approach does not guarantee that a variable has been omitted in the formulation 
(which is only a guess). Calculating Vo involves all the relevant terms that influence Vo. But note 
calculating Vo does not remove all the error in the approximation for Beta2Eff. It pins the curve to 
one more point, previously it was pinned at start and end values. 

The Lambert- W-function can be used to first calculate Ic1 when Reta2Eff is half the maximum 
value. This 50% of Beta2 point appears to be the only point that permits a balancing of the 
equations. Solving Q2 with Ic1 splitting half through Rbe and half to Q2 base gives 

Ic1h
2 Rbe=N2⋅Vt ln(Beta2⋅Ic1h /2

Is2 +1)  (90)

Then arranging in the w=ln(x/w) form 

( Beta2⋅Ic1h
2 ) Rbe

Beta2
N2⋅Vt

=−ln( Is2
Beta2⋅Ic1h

2
+ Is2)

(Beta2⋅Ic1h
2

+Is2)Rbe /Beta2
N2⋅Vt

=−ln( Is2
Beta2⋅Ic1h

2
+ Is2)+ Is2⋅Rbe / Beta2

N2⋅Vt (91)

(Beta2⋅Ic1h
2

+Is2)Rbe /Beta2
N2⋅Vt

=−ln( Is2 Rbe / Beta2
N2Vt

exp(−Is2⋅Rbe / Beta2
N2⋅Vt )

(Beta2⋅Ic1h
2 + Is2) Rbe /Beta2

N2Vt )
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The minus sign can be moved to the LHS and balanced in the log giving 

−( Beta2⋅Ic1h
2

+ Is2) Rbe / Beta2
N2⋅Vt

=ln(− Is2 Rbe /Beta2
N2Vt

exp(−Is2⋅Rbe / Beta2
N2⋅Vt )

(Beta2⋅Ic1h
2 + Is2)Rbe /Beta2

N2Vt )  (92)

Now the solution can be written for the Lambert W-function as 

Ic1h= 2⋅N2⋅Vt
Rbe

W (exp( Vk2
N2⋅Vt )) − Is2  & 

Vk2=N2⋅Vt⋅ln( N2⋅Vt
Is2⋅R be /(Beta2+1)) − Is2⋅R be /(Beta2+1)

(93)

Vk2 was used with Rbe/(Beta2+1) rather than Rbe/Beta2 as above but this does not significantly 
affect the fit when Beta2 is relatively large (say >10). The +Vk appears since there is a double 
negative. The factor of 2.7 was found to work slightly better than “2” [why?].

Having found Ic150% at half the full Beta2 value we can work backwards from the Ic1 solution 
[Equation 76] to find Vin50% . Solving for Vin50% gives 

VinH=Vk1+N1Vt(( Ic1h− Is1) N1⋅Vt
R e⋅(Beta2/2+1)

+ln(( Ic1h− Is1)N1⋅Vt
R e⋅(Beta2 /2+1) ))  (94)

lastly calculate Vo from the Beta2Eff  Equation (85) giving 
Vo=VinH−Vsw− Isw⋅R e  95/(95)

0. 4V 0. 6V 0. 8V 1. 0V 1. 2V 1. 4V 1. 6V 1. 8V 2. 0V
0mA

1mA

2mA

3mA

4mA

5mA

6mA

7mA

8mA

9mA

10mA
(I (B8))*( I (B10) / I (R1)) ( - I (Vcc4))*( I (B10) / I (R1))

 

400mV 500mV 600mV 700mV 800mV 900mV
0. 0mA

0. 2mA

0. 4mA

0. 6mA

0. 8mA

1. 0mA

1. 2mA

1. 4mA

1. 6mA
(I (B8))*( I (B10) / I (R1)) ( - I (Vcc4))*( I (B10) / I (R1))

Figure 5.4d shows the plots using calculated Vo at half of Beta2 with Rbe stepped from 1Meg 
to 1k and Re=100R. Q1 and Q2 Beta=100.

Figure 5.4d shows the plots using calculated Vo from for an effective Beta2 of 50%. The plots are 
very similar to Figure 5c which used an empirical function. The use of Equation (95) to calculate 
the offset voltage Vo for the approximate Beta2Eff function has the advantage of no longer needing 
manual fitting which is a big advantage. 

It was also found that the 'Beta1·Beta2·Re' term (Equation (83) which caters for very high Rbe 
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values) could be set to a very high value of times (100Meg) when Vo was calculated. This allows a 

simpler form for Vsw  Vsw=Vt Vk2
Vt

Re4
Rbe4 +Vt⋅ln(Vk2

Vt ⋅ Re4
Rbe4)+Vk1 when Vo is calculated as 

above.

To sum up, it is very pleasing to see that the approximate solution used here does provide a very 
close fit to the SPICE circuit behaviour using the same model parameters. The effective Beta for Q2 
with a base emitter resistor can now be represented with good accuracy and without manual fitting 
factors (when the offset constant Vo is calculated). This method can be applied to other transistor 
pairs involving a resistor (Rbe) across a second transistor in a compound pair. 

The next section completes the CFP by adding shunt feedback. But an intermediate step is needed 
where Rin is added to Q1.

 5.5 SE CE Complementary Feedback Pair with Rin and Rbe (no Rf)

Q6

Re

RL

Rin VccQ7
PNP

Rbe

Vout

Vin
Vb

Ve

Vc1

 

Figure 5.5.Common Emitter Complementary Feedback Pair with Rin and Rbe (no Rf) 

It was originally hoped that Rf and Rin could be introduced simply by substituting Beta2Eff for 
Beta2 in the previous section. This worked well in the previous section allowing an approximated 
solution when Rbe was added. But when Rin is added it was found that Vsw needed an additional 
offset term (Vk2Rin) to track the effect of Rin on the knee voltage for the Beta2Eff function. When 
this was added the Beta2Eff function gave a reasonably good approximation with high Rin values 
(around Beta1·Beta2·Re) and the current was accurate also.

The equations used to allow for Rin are: 

Ie2 '=( Beta2Eff +1)⋅ N1Vt
Req( fVin)

⋅W (exp(Vin−Vk1( fVin)
N1Vt )) − Is1  

where Vk1( fVin)=N1Vt⋅ln( N1Vt
Is1⋅Req( fVin)) − Is1⋅Req ( fVin)  where 

(96)

Req( fVin) = Rin
Beta1 + (Beta2Eff +1)( Beta1+1

Beta1 ) (97)

and the Beta2Eff function is calculated using an offset voltage in Vk2Rin in Vsw and Isw 

Beta2Eff ≃
Beta2

(1+ I1sw⋅Beta2⋅R e0+Vo
Max (Vin−Vsw ,0) )  (98)

Where Re0 is the equivalent emitter resistance before Q2 starts conducting (no feedback) 
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Re0= Rin
Beta1⋅(Beta2+1)

+ R e⋅( Beta1+1)
Beta1  (99)

and 

Vsw=Vk2⋅R e0( 1
Rbe+ 1

Beta1⋅Beta2⋅R e )
+Vt⋅ln(Vk2

Vt
⋅R e0( 1

Rbe
+ 1

Beta1⋅Beta2⋅R e ))+Vk10+Vk2Rin

 (100)

 and 

I1sw= N1Vt
R e0

⋅W (exp(Vin−Vk10−Vk2Rin
N1Vt ))  

Vk10=N1Vt⋅ln( N1Vt
Is1⋅Re0 ) − Is1⋅Re0

(101)

 and

Vo=0.2V⋅( Rbe
Beta2⋅R e0 )

−0.8
 and Vk2Rin=Vk2 Rin

R e0⋅(Beta1+1)⋅Beta2 (102)

Where the 0.2V is a 200mV constant found by empirical fitting as above. Alternatively, the value 
for Vo can be calculated using the 50% beta method above. 

Figure 5.5a shows Rin is stepped from 1k, 100k, 1Meg, 2Meg and the knee voltage shift to the 
right can be seen with the higher input resistance. There is also a reduction in slope. Interestingly, 
with Rf absent the equations do not require a scaling of Vin (see below); it might be expected that 
Vb is the voltage to use rather than Vin, but the Lambert W-function solution does not need this in 
the simple case with Rin as seen in the simple CE solution (Figure 4.1a) where Rin is lumped into 
Req for a solution. However, notice in the single transistor circuit (Figure 4.2) with Rf present there 
is a voltage divider effect on Vin in the equation for Ic Equation (56).
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Figure 5.5a. Common Emitter Complementary Feedback Pair with Rbe and Rin (no Rf). Rin 
is stepped 1k, 100k, 1Meg, 2Meg showing the offset in the knee voltage and a reduction in 
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slope. Red is LTspice. Q1 and Q2 Beta=100.

 5.6  SE CE Complementary Feedback Pair with Rbe, Rf & Rin
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Figure 5.6 Common Emitter Complementary Feedback Pair with Rbe, Rf & Rin

We can now solve currents Ic1 and Ic2 in the circuit of Figure 5.6 with Rf and Rbe by employing 
Beta2Eff with Equation (85). The combined currents through Rbe and Q2's emitter Ie2' as noted 
above is (Ic1+Ic2), which equals Ic1·(Beta2Eff+1), which conveniently allows us to substitute 
Beta→Beta1(Beta2Eff+1). The updated Equations become

Ie2 '=(Beta2Eff +1)⋅ N1Vt
Req ( fVin )

⋅W (exp((Rf +RL
RTot )Vin−Vk1( fVin)+ Rin

RTot
Vcc

N1Vt )) − Is1
 

RTot=Rin+Rf +RL

where Vk1( fVin)=N1Vt⋅ln( N1Vt
Is1⋅Req ( fVin )) −Is1⋅Req( fVin)  and 

(103)

Req( fVin)= Rin
Beta1( Rf

RTot
+

RL(Beta1(Beta2Eff +1)+1)

RTot )
+ R e

Beta1⋅(Beta1(Beta2 Eff +1)+1)
and the output voltage can now be calculated from

Vout=Vcc−(1+ R e
Rin)(Beta1(Beta2Eff +1)+1

Beta1(Beta2Eff +1) )RL⋅Ie2 ' −

Rc
Rin (Vin+N1Vt ln( Ie2 ' /(Beta2Eff +1)

Is1 (Beta2Eff +1
Beta2Eff )+1))

(104)

The Beta2Eff term is calculated from modified equations below substituting 
Vin→Vin'=Vin·(Rf+RL)/RTot . Note Vb due to Vin is reduced by the voltage divider action of 
Rf+RL with RTot as suggested in Equation (56). When Rf is added it was found that Vsw needs a 
further offset term to track the effect of Rf on the knee voltage for the Beta2Eff function so this offset 
voltage was subtracted from Vk2Rin , giving
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Beta2Eff ≃
Beta2

(1+ I1sw '⋅Beta2⋅R e0+Vo'
Max (Vin '−Vsw ' ,0) )  where Vin '=Vin⋅Rf +RL

RTot (105)

and 

Re0= Rin
Beta1⋅(Beta2+1)

+ R e⋅( Beta1+1)
Beta1  (106)

and 

Vsw '=Vk2⋅R e0( 1
Rbe+ 1

Beta1⋅Beta2⋅R e )
+Vt⋅ln(Vk2

Vt
⋅R e0( 1

Rbe
+ 1

Beta1⋅Beta2⋅R e ))+Vk10+Vk2Rin

(107)

 and 

I1sw '= N1Vt
R e0

⋅W (exp(Vin '−Vk10−Vk2Rin
N1Vt ))  and 

Vk10=N1Vt⋅ln( N1Vt
Is1⋅Re0) − Is1⋅Re0 and

(108)

Vo2'=0.2V⋅( Rbe
Beta2⋅R e0 )

−0.8
 & 

Vk2Rin=Vk2 Rin
R e0⋅(Beta1+1)⋅Beta2

− Rin
RTot

⋅Vcc
(109)

In summary the calculations proceed as follows: Calculate constants Vo2' & Vsw' and Isw'. Then 
calculate Beta2Eff at each Vin and then Req(fVin). Then calculate Ie2'. Calculate Vout from Ie2' first 
without saturation. Add Vce saturation to Ie2'. Calculate Vout.

-1. 4V -1.1V -0.8V -0. 5V -0. 2V 0.1V 0.4V 0.7V 1.0V 1.3V 1.6V 1. 9V
0V

1V

2V

3V

4V

5V

6V

7V

8V

9V

10V

11V

0mA

1mA

2mA

3mA

4mA

5mA

6mA

7mA

8mA

9mA

10mA

(I (B19)) / I (R1)*0 V(vp)*1 V(vout )
( I e(Q2)+I (Rbe))*1 I (B23)

Figure 5.6a Common Emitter Complementary Feedback Pair with Rbe, Rf & Rin. Currents 
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rise from left to right and voltages fall. Red is LTspice. Rin is stepped 1k, 10k while Rf is 
stepped 10k ,100k. Re=100 and RL=1k. Q1 and Q2 Beta=100. The divergence for Rin=1k and 

Rf=10k is caused by an underflow error of ln(x). 

Figure 5.6a shows the CE CFP with all the components Rbe, Rf & Rin now added. The currents 
rise from left to right and voltages fall. Rin is stepped 1k,10k while Rf is stepped 10k ,100k, 
Re=100r and RL=1k. The divergence (for Rin=1k and Rf=10k) is caused by an underflow log error 
previously mentioned (this is left for later to debug). Overall currents are quite accurate, the errors 
are due mainly to Vce saturation which uses a very simple approximation.

All the calculated currents appear to be quite accurate with the only visible differences at Vce 
saturation because of the very simple Vce saturation model. This is a very pleasing outcome for an 
approximated solution. The Vo parameter used the empirical formula but Vo could be calculated and 
remove the need for the manual fitting terms (left for later).

 6. Common Emitter + Common Collector pair (VAS+VF)
This section covers a Common Emitter stage with a Voltage Follower Figure 6.2 with shunt voltage 
feedback. This circuit is a simpler version of the Lin Class-AB amplifier Figure 6.0 with a “VAS” 
(Voltage Amplification Stage) stage Q1. In Figure 6.2 Q2 is a Single Ended near-unity gain Voltage 
Follower stage that operates in Class-A stage. In Figure 6.0 the output stage in the Lin amplifier is a 
push-pull Class-AB stage that acts as a Voltage Follower. 

Shunt feedback is used in the Lin amplifier. If we can solve Figure 6.2 then we can use the same 
approach to solve the Lin amplifier with a push-pull stage. The more common 3 stage power 
amplifier topology adds a differential input stage to the original Lin topology. 

Figure 6.0. Dr. Hung Chang Lin “Jimmy Lin” amplifier 
[http://www.semiconductormuseum.com/Transistors/RCA/OralHistories/Lin/Lin_Page7.htm ]

Free eBook EditionFree eBook Edition
p82        Power Amp Kalkulator User Guide PAK-1v0-NM November 1, 2012  Contents 

http://www.semiconductormuseum.com/Transistors/RCA/OralHistories/Lin/Lin_Page7.htm


First the open loop solution for the VAS+VF in Figure 6.1.

 6.1  CE + CC pair no Rf (VAS+VF in open loop) 

Q1

Re1

Rc1

Rin
Vcc

Q2

Re2

Vout

Vin Vb1

Ve1

Vc1

Figure 6.1. Common Emitter plus a Common Collector pair (VAS+VF in open loop) 

In Open loop the solution for Ic2 can be found from Ic1 and Ic1 does not depend on Ic2 since there 
is no overall feedback in this version. Ic1 is the solution of the Common Emitter circuit Figure 4.1. 
Q2 is a Voltage Follower and collector current of Q2 (Ic2) can be calculated using another CE 
solution. This was covered in Section 4.4. 

Figure 6.1a shows Q2 as being current driven by Q1 (Ic1) with Rc1 as “Rin” for a CE stage. Rc1 is 
connected to Vcc so we can use Vcc – Ic1·Rc1 as the input voltage “Vin” with a CE stage Lambert 
W solution. 

Rc1 Vcc
Q2

Re2

Ic1
Vout

Vc1

Vcc

 Figure 6.1a. Redrawn Q2 CC as a CE. The second stage is current driven by Q1 (Ic1) and Vcc 
supplies current through Rc1 to the CE stage

For the first stage we write 

 Ic1= N1⋅Vt
Req1

W (exp(Vin−Vk1
N1⋅Vt )) − Is1  where 

Vk1=N1⋅Vt⋅ln( N1⋅Vt
Is1⋅Req1) − Is1⋅Req1 Req1= Rin

Beta+R e1⋅(1+Beta
Beta )  and  

107(110)

and 

 Ic2= N2⋅Vt
Req2

W (exp(Vcc−Ic1⋅Rc1−Vk2
N2⋅Vt )) −Is2  where 

Vk2=N2⋅Vt⋅ln( N2⋅Vt
Is2⋅Req2 ) − Is2⋅Req2  and Req2= Rc1

Beta2+R e2⋅(1+Beta2
Beta2 )  

(111)
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Figure 6.1b. Left is open loop VAS+VF Vout plots with Rc1 stepped 2k & 10k then Re1 
stepped 10R & 100R. (Re2=1k, Rin=10k, Beta1=Beta2=100). 

Figure 6.1c.Right is Vout in open loop stepped Beta1=10 and 100 then Re1 stepped 10R & 
100R (Re2=1k, Rin=10k, Rc1=10k)

Figure 6.1b shows Vout in open loop. Figure 6.1c shows Vout with Beta1 stepped 10 and 100. 

 6.2  CE + CC pair with Rf (VAS+VF closed loop) [under construction] 

Q1

Re1

Rc1
Rf

Rin
Vcc

Q2

Re2

Ve1

Vc1

Vout

Vin

Figure 6.2. Common Emitter plus CC pair (VAS+VF) with global shunt feedback

A closed loop solution with Rf in Figure 6.2 is not possible as an exact solution. If we can represent 
Q2 as an effective Beta (Beta2Eff) as we did in the CFP then we can obtain an approximate solution.

Using Figure 6.1a we can treat Q2 as a Common Emitter stage with Rc1 like “Rin” and connected 
to an input voltage of Vcc as shown in Figure 6.2a.

Q1

Re1

Rc1
Rf

Rin Vcc
Q3

Re2

Vout
Vin

Vb

Vc1

Ic1

Vcc

 Figure 6.2a. CE+CC redrawn as a CE+CE -- second stage is current driven by Q1

We now run and plot the ratio of Ic2/Ic1 and try to formulate an equation for Beta2Eff to allow a 
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closed loop solution. Figure 6.1b shows the exploratory plot to view the form of a Beta2Eff function 
by plotting Ic2/Ic1 and the current Isc through Rc1 due to Vcc. The equation used is

Beta2Eff =
Ic2

Isc− Ic1  where Isc= Vcc
Rc1 (112)

Figure 6.1b shows the same characteristic curve as the CFP when Rbe was added but it is now 
curving back to the left. There are the abrupt knee voltages (Vsw) seen at 835mV and 890mV. 
There is the plateau to a maximum effective Beta. The maximum Beta occurs when Q1 is 
completely off so the above equation limits to Beta2Eff=Ic2Max/Isc. Notice Ic2Max can be calculated 
using the Lambert solution 

Ic2Max=
N⋅Vt
Req2 W (e

(Vcc−Vk2
N⋅Vt ))  where Vk2=N2⋅Vt⋅ln( N2⋅Vt

Is2⋅Req2) − Is2⋅Req2  and 

Req2= Rc1
Beta2+(1+Beta2

Beta2 )R e2∥(Rf +Rin)

(113)

and so we can calculate the plateau Beta2EffMax using

Beta2EffMax=

N Vt
Req2

⋅W (exp(Vcc−Vk2
N⋅Vt ))

(Vcc / Rc1)
 (114)

-1. 4V -1. 0V -0. 6V -0. 2V 0. 2V 0. 6V 1. 0V
-1mA

0mA

1mA

2mA

3mA

4mA

5mA

6mA

7mA

8mA

9mA

10mA

-1

0

1

2

3

4

5

6

7

8

9

10
I c(Q2a)*( I (B27) / I (R1)) I c(Q2a) / ( I (B28)- I c(Q1a))

Figure 6.1b. Plot of Ic2 (red) and Beta2Eff (gold). Rf is stepped 50k and 100k, Rin=Re=1k, 
Rc1=10k. I(B27) calculates offset current Isc=Vcc/Rc1.

Next, the Vsw and Isw values are calculated for the knee.
e=1   (115)

 7.  Single Ended Darlington stage 
 7.1  Single Ended CE Darlington (no Rbe) 
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Vcc

Re2 RL

Q2

Vin

Rin
Q1

Vout

Fig 7.1. Single Ended Common Emitter Darlington stage (no Rbe)
To solve the Darlington Q1 with Q2 for the simplest case where Re1 is omitted, it is first necessary 
to find the solution or a resistor in series with two base-emitter junctions, effectively two dissimilar 
diodes in series with an equivalent resistance. 

A solution is given in Section 3.3. The solution reduces two diodes to one equivalent diode with an 
equivalent saturation current of √( Is1⋅Is2)  and an equivalent thermal voltage of 2·Vt. 

Plots with a very large Re1 (or Rbe2) are provided in Section 7.3.

 7.2  Single Ended Emitter Follower Darlington (no Rbe) [under construction] 

Vcc

Re2 RL

Q2

Vin

Rin
Q1

Vout

Fig 7.2. Single Ended Emitter Follower Darlington stage(no Rbe)

 7.3  Single Ended CE Darlington with Rbe 
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Vcc

Re2 RL

Q2

Vin
Q1

Re1
 or
Rbe2

Vout

Ve1

Fig 7.3. Single Ended Emitter Follower Darlington stage with Rbe (no Rin)
Figure 7.3 shows the Common Emitter Darlington stage. Equations are solved assuming constant 
Beta's and no Early effect. Re1 is treated as a base-emitter resistor for Q2 (or Rbe2). With Re1 
present we can assume Q1 gain rises to near unit before Q2 begins conduction therefore we can 
calculate Ic2 then Ic1, and finally IL as Ic1+Ic2. 

Ic2 for Q2 was calculated using the diode plus resistor solution on the emitter side 

Ic2= N⋅Vt
Req

W (exp(0.98(Vsp+Vin−Vk2)
NVt ))  where Vk2=Vt ln( Vt

Is12⋅Req)  and 

Req= Rin
Beta1⋅Beta2+Re2(Beta2+1

Beta2 )  and N=2 for two diodes. The scale factor 0.98Vin accounts 

for the slightly less than unity gain of Q1 once Q2 starts conduction. This gain can be estimated 
from Q1's intrinsic emitter resistance (Vt/Ie) at the knee voltage (typically 0.65V) where 

Ie~0.65V/Re1~Vk2/Re1. This gives the gain 
A1≈ Re1

Re1+Vt Re1
2

Vk1  so 

A1Rin=0≈
1

(1+ Vt
2⋅Vk1)  where the factor of 2 allows for twice the current assuming Q2 has just 

turned on. The factor of 2 can be altered so the final gm of Q2 reaches the same gm as the simulated 
circuit and this makes the two IL plots identical. The use of this fixed gain factor approximation 
simplifies the equations but is not a good general solution approach when Re1 is very large.

The required transition from 2V to 1Vt as Re1 as well as the transition of Is12 changing from 
√( Is1⋅Is2)  to Is2 when Re1 is very small (eg Re1~Re2) is handled by a simple empirically relation 

N = 2−x
1−x  which changes N from 2 to 1 as x changes from 0 to infinity. The simplest form is 

x=k⋅Beta2 Re2
Re1 where k is a fitting constant that was found when Re1=Beta2⋅Re2  

requiring k~2. This gives N =(2+2⋅Beta2⋅Re2 /Re1)
(1+2⋅Beta2⋅Re2 / Re1)

and so Vk 12=2⋅Vt⋅ln( Vt
Is12N Re2 )+Vo  

where Is12N=√( Is2( Is2(2−N )+Beta2⋅Is1( N−1))) and Vo= 4.4⋅Vt
1+2⋅Re1 /(Beta2⋅Re2) . The 

term Vo is an additional fitting factor that gives the best fit as Re1 becomes very small which 
approaches 4.4Vt when Re1~Re2. 
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This approach worked reasonably well where Vk12 used the fixed scaling of 2Vt rather than NVt. 
But it involves several fitting terms (later versions may be able to eliminate these like was done for 
the CFP). An alternative approach that gave accurate values for Vk12 at N=1 and 2 was 

Vk 12=2⋅Vt⋅ln( Vt
Is12N Re2 )+(2−N )Vk1  which involves solving a quadratic equation for Vo. 

 7.4  Single Ended Common Emitter Darlington with Rbe 

Vcc

Re2 RL

Q2

Vin

Rin
Q1

Re1

Vout

Ve1

Vb1

Figure 7.4 shows the Common Emitter Darlington stage with Rbe1 and Rin.

One way to approximate the effect of including Rin is to use 

RT=Re2+ 1

( 1
Rin/(Beta1⋅Beta2)

+ 1
(Re1 /Beta2)) which is recognisable as Re2 plus the parallel 

resistances Rin and Re1 (both are referred back to the emitter side of Q2). RT replaces Re2 in the 
earlier empirical Vk12 equation. The equation for N deliberately does not use RT (despite Re2 
appearing in the equation for N). 

An additional voltage offset voltage Vo2 is needed when Rin becomes large as in 

Ic2= N⋅Vt
RT

W (exp( A1(Vsp+Vin−Vk2)−Vo2
NVt ))  where A1 is the voltage divider ratio formed by 

Rin/Beta1 and Re1 or A1= Re1
Re1+Rin / Beta1 and Vo2=700m ln( 1/ A1

1+ln (1/ A1)) . Notice that 

A1 does not involve Re2 – this is because Q1 will always start to turning on before Q2 (since Re1 is 
present).

To complete the Darlington the contribution from the driver transistor is important to the supply 
current and the loading at the input due to Q1 base current.

The collector current for Q1 with Rin is 

Ic1= Vt
Re1+Rin /Beta1

W (exp(2⋅Vsp+Vin−Vk1
Vt ))+ Ic2

Beta2  where

Vk1=Vt⋅ln( Vt
Is1(Re1+Rin /Beta1)) . 
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Notice Ic1 is made up of two parts: firstly the current due to Re1 using Vk1, and second the current 
that Q1 must supply to drive Q2 which is Ic2/Beta2. This approach works well for typical values of 
Re1 and Re2. It assumes that Q1 has switched its gain to nearly 100% its limiting value by the time 
Q2 starts conducting and does not need to appear as a variable in the calculation of IC2, only as a 
fixed gain of 0.99 (now 1.0 for best fit when Rin is large, ie Rin>>Beta1·Beta2·Re2). 

The power rail current is IC1 plus IC2 and is the same as the load current. The total emitter current 
(IRe1+Ie2) is slightly more than the power rail current and load current by the base current of Q1. 
Parasitic emitter and base resistances can be included where Beta1·Re1P+Rb1P can be added to Rin 
while and Re2P+Rb2P/Beta2 added to Re2. 

Gm's for Q1 and Q2 are calculated separately using W(x) with Re1 and W(y) with RT. A component 
of Q2's gm being gm2/Beta2 is also added to Q1 gain to account for some Ic1 driving Q2. Gm for 
the supply rail current and hence the load is the sum of Q1 and Q2 gains. The total gm seen at the 
load can be used to estimate THD.

Figure 7.4a. SE CE Darlington with Re1 stepped 0.33R Highest gain and current), 33R and 
33k (lower slope) (Re2=0.33R, Red is SPICE)

Figure 7.4b. SE CE Darlington with Re2 stepped 0.1R (highest Gm & Ic), 0.33R and 1.0R 
(Re1=33R, Red is SPICE)
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Accuracy in Figure 7.4a where Re1 is stepped from a very low value to a very high value (0.33R to 
33k) and with Re2 fixed at 330mR is very good. Note the slope change for 33k (the lower slope 
curve). In Figure 7.4b where Re2 is stepped while Re1 is fixed at 33R (a typical value since 
Beta2*Re2=33) the accuracy is not maintained around the turn on region for a low Re2 of 100mR. 
This seems to be due to the empirical approximation which does not account for Q2's loading on Q1 
when Q2 starts to turn on when Re2 is a low value, if so then making the fixed constant 0.98, a 
variable involving Q2's during turn on may improve the accuracy when Re2 is small. But with the 
present solution Ic2 a small offset voltage can be applied to shift Ic2 to the right to improve 
accuracy in Ic2 is Re2 is constant at 100mR.

Figure 7.4c shows the SE CE Darlington with Rin stepped from 33mR to 330k while Re1 is fixed 
at a typical value of 33R and Re2 is 330mR. Increasing Rin causes the knee voltage to increase 
slightly. (Note the Gm reduces as Rin is increased). 

Figure 7.4c. SE CE Darlington with Rin stepped from 33mR to 330k (Re1=33R, Re2 330mR, 
Red is SPICE)

 Solution with a high Rin and current drive
In a typical amplifier if the preceding stage is common emitter then it will have a relatively high 
output resistance and this can be represent by Rin shunted to common and a current source driving 
to the base of Q1. Current source drive can be provided using the Norton equivalent Iin =Vin/Rin 

and with Rin shunted to common. The level of peak current needed is Iin pk=
Ic2 pk

Beta1⋅Beta2
.

The above equations for Ic1 and IC2 with current drive become 

Ic2= N⋅Vt
RT

W (exp( A1(Vsp+ Iin⋅Rin−Vk2)−Vo2
NVt ))  and 

Ic1= Vt
Re1+Rin /Beta1

W (exp(2⋅Vsp+ Iin⋅Rin−Vk1
Vt ))+ Ic2

Beta2  where terms for Ic1 and Ic2 have 

been defined above for voltage drive. 

Figure 7.4a shows the SE CE Darlington with current drive and Rin stepped 3k3, 33k and 330k 
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(Re1=33k, Re2 330mR, Red is SPICE). Here Re1 is deliberately very high for a negligible effect. 
The linearisng effect can be clearly seen when current drive is used. Notice that when the shunt 
resistance is increased under current drive the nonlinearity is decreased and the knee voltage is 
reduced. The change in gain from 1A to 5A with Rin = 3k3 is 6%, with Rin =33k it is 1% and 
0.08% with 330k. When Re1 is the usual 33R there is no useful improvement in linearity with 
current drive since Re1 is effectively in parallel with Rin/Beta1 so Re1 does not allow the high 
input resistance of Rin to be seen by Q2.

Figure 7.4a. Darlington pair current and gain with a current source. Rin stepped 3k3, 33k and 
330k. Re1=33k (for negligible effect) and Re2 330mR. Red is LTspice.

 7.5  Single Ended Emitter Follower Darlington with Rbe and Rin [under 
construction]
Figure 7.5 shows an Emitter Follower (EF) Darlington stage.  Emitter resistors are Re1 for driver 
Q1 and Re2 for Q2. Equations are solved assuming constant Beta's and no Early effect. 

Vcc

Re2 RL

Q2

Vin

Rin
Q1

Re1

Vout

Fig 7.5. Single Ended Emitter Follower Darlington stage with Rbe

 8.  The Differential pair 
 8.1 The differential input stage 
Figure 8.1 shows a Differential input stage or the Long Tail Pair (LTP) shown with a 10mV input 
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voltage and the output current is summed using an equation in ABM B1.

Vpos3
35

I2

2mA

R1
62

R2
62

Vin
10mV

Q6
2N5551C Q7

2N5551C

Vpos4
35

B1

I=Ic(Q6) - Ic(Q7)

Ic1 Ic2

Figure 8.1. Differential input stage (aka Long Tail Pair or LTP) 

When no emitter resistors are present and the transistors parasitic base and emitter resistors are 
negligible the current in each transistor is known to follow the Tanh(x) function [ref 9 Alyward] of 

Ic1= Io
2 (tanh( Vin

2Vt )+1)(1+ 1
Beta)  where Io is the tail current and Beta is the average value 

for Q1 and Q2. The factor 1+1/Beta arises from the tail currents adding to Io and the collector 
currents are reduced by the base current related to 1/Beta.

It was assumed that a solution with emitter resistors must involve the Lambert W-function of a 
diode plus resistor and the solution had to give the Tanh(x) function in the limit for Re approaching 
zero. Since the Lambert diode plus resistor solution gives improving exponential behaviour below 
the knee voltage it is reasonable to guess that using W[exp((Vin+Vb)/Vt)] in place of the exp(Vin/

(2Vt)) function used in the Tanh(Vin/(2Vt)) since tanh(x )= exp( x)−exp (−x)
exp( x)+exp (−x) . 

The above equation for Ic1 without Re is Ic1= Io
2 (tanh( Vin

2Vt )+1)(1+ 1
Beta)  which can be 

written as Ic1= Io
2 (exp( x)−exp (−x)

exp( x)+exp (−x)
+1)(1+ 1

Beta )  or 

Ic1= Io
2 ( 2⋅exp(x )

exp( x)+exp (−x))(1+ 1
Beta )  so Ic1= Io( exp( x)

exp( x)+exp (−x))(1+ 1
Beta ) .

Substituting the equations (yet to be stated) for W1 and W2 for the Lambert solution for Q1 with R1 

and Q2 with R2 we can guess that Ic1= Io( W1( x)
W1(x )+W2 (−x))(1+ 1

Beta) . The formulation for 

W1 and W2 that gave good accuracy for the collector over a wide range of Vin and Re and were 
found to be 

W1(x)=W (exp(Vin+Vb
Vt )) where Vb= Io (R1+R2)

2
+Vt+0.8ln((( R1+R2)+Vt / Io)

(Vt / Io) ) . The 

formulation for Ic2 is Ic1= Io( W2 (x )
W1(x )+W2 (−x))(1+ 1

Beta) . The gm for Ic1 can be calculated 

using Gm1= 1
R1+R2+Vt / Io

W1
(1+W1)

W2
(1+W2) . Note Gm2 will be the same as Gm1 which is 

expected since the tail source has negligible conductance or leakage of the emitter currents. It also 
follows that Gm1 gain fall for +Vin must be the same as -Vin with a pure tail current source.
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Figure 8.1a. LTP approximate solution compared to SPICE with Re stepped 1m, 100m, 1R, 
10R, 100R ohms, Beta=100, Is=9e-15A, Io=10mA.

Fig 8.1a LTP approximate solution compared to SPICE with Re stepped 1m, 100m, 1R, 10R, 100R 
ohms, Beta=100, Is=9e-15A, Nf=1, Io=10mA. Beta-fall and Early effect parameters were disabled 
for this plot. Accuracy is maintained over a wide range of emitter resistance demonstrating the 
validity of the approximation.
 
 9.  Current Mirrors

 9.1  Basic current mirror 
Figure 9.1 shows a Basic BJT current mirror. The Lambert W solution is similar to the Widlar 
current mirror published by Banwell [ref 1] and Atlward [ref 10] but this basic current mirror has 
resistor R1 added to emitter of the input transistor Q1 which effectively operates as a diode .

R1 R2

Vcc
I1
IIN

Q1 Q2

  I2
  or
load

Figure 9.1. Basic bipolar current mirror

The ratio of the areas of Q1 and Q2 denoted by k=A2/A1 determines the mirror current gain I2/I1 
provided resistors R1 and R2 are also in the same ratio. The finite beta's of the transistors drains 
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some current from the input giving a mirror current gain that is slightly less than the ratio of the 
transistor areas. The area ratio k for discrete devices is assumed to be the ratio of saturation currents 
where k=Is2/Is1 for Q2 and Q1 respectively (but differences at low currents can arise from 
transistor base leakage effects (modelled by Ise and Ne).

Resistor R2 provides emitter degeneration for Q2 which is needs to be a minimum value to prevent 
thermal runaway; the minimum value depends on Vce of Q2 and collector current Ic2. R1 provides 
linearisation of the mirror current ratio at high currents and is shown below that it requires 
R1≈k·R2.

To start the analysis assume the beta's are very high and the base currents can be neglected. The 
voltage loop equation around the two emitters and R1 and R2 gives 

I2⋅R2− I1⋅R1=Vt ln( I1
Is1+1)−Vt ln( I2

Is2+1)  and usually I2>>Is2 giving 

I2⋅R2− I1⋅R1=Vt ln( I1
I2⋅

Is2
Is1)=Vt ln( k⋅I1

I2 ) . 

Since I1 is the input variable we need the form w ew=x  to find I2(I1) where x is the input variable 
and w is fixed by circuit parameters only. Taking exponential gives 

exp( I2 R2
Vt )⋅exp(− I1 R1

Vt )= k⋅I1
I2 => exp( I2 R2

Vt )= k⋅I1
I2 exp( I1 R1

Vt ) => 

I2⋅exp( I2 R2
Vt )=k⋅I1exp( I1 R1

Vt ) . Now multiply both sides by R2/Vt to make the LHS of the 

form w eW =x  giving I2 R2
Vt exp( I2 R2

Vt )= k⋅I1 R2
Vt exp( I1 R1

Vt ) => 

I2 R2
Vt

exp( I2 R2
Vt )=exp( I1 R1−Vt ln (Vt /(k I1 R2))

Vt )  so W = I2 R2
Vt and 

x=exp( I1 R1−Vt ln (Vt /(k I1 R2))
Vt ) . We can now find I2 using 

I2 R2
Vt =W (exp( I1 R1−Vt ln (Vt /(k I1 R2))

Vt ))  or finally 

I2= Vt
R2⋅W (exp( I1 R1−Vt ln (Vt /(k⋅I1⋅R2))

Vt ))  (116)

 where W (x )≃ln (1+x)(1− ln (1+ln(1+x))
2+ln(1+x ) ) .

To make the mirror linear for all input currents (Betas neglected) we can use the above expression 

I2⋅R2− I1⋅R1=Vt ln( I1
I2⋅

Is2
Is1)=Vt ln( k⋅I1

I2 ) and we want to force the nonlinear RHS to be 

ideally zero, so Vt ln( k⋅I1
I2 )=0  which means ( k⋅I1

I2 )=1  or I2
I1

=k and the LHS is 

I2⋅R2− I1⋅R1=0  and solving for R1 gives R1= I2
I1

⋅R2  which means choosing R1=k⋅R2  
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to be linear at high current as well as low currents.

When Betas are included there is base current to Q2 of Ic2/Beta2 and base current to Q1 of 
Ic1/Beta1. Since I1 is dependent on I2 and we need to know I1 before we can find I2 in our solution 

above so an approximation is used assuming R1 is k·R2 and Ib1+2≈
Ic2

Beta2
+( Ic2 /k )

Beta1  then 

calculate I2 using I1 '≈ I1(1−( k
Beta2

+ 1
Beta1)) giving 

 

I2≈ Vt
R2⋅W (exp( I1 R1(1−( k

Beta2+ 1
Beta1))−Vt ln( Vt

I1 R2(1−( k
Beta2+ 1

Beta1)))
Vt ))  (117)

A simulation with R1 = 6.2R and R2=6.2R and I1 = 10mA gave Ic2 = 9.84266 mA. The transistor 
used Beta=125, Is=9e-15, Nf=1 and parasitic Re and Rb were set to very small values and VAF and 
IKF were very large. The ABM equations are 
B5: I=(I(I1)*R5*(1-(k/Beta2+1/Beta1))-Vt*Ln(Vt/(I(I1)*R6*(1-(k/Beta2+1/Beta1)))))/Vt then 
B6: I=Vt/R6*Ln(1+Exp(I(B5)))*(1-Ln(1+Ln(1+Exp(I(B5))))/(2+Ln(1+Exp(I(B5))))) where
 .param k=Is2/Is1. This gives Ic2 = 9.83425 mA and the error is 0.1%. Another simulation with the 
same parameters as above and same ABM equations but R1 =R2 = 62R gave Ic2 = 9.84253 mA. 
The ABM result for Ic2 = 9.86215 mA and the error is 0.2%.

 9.2  The Wilson current mirror [under construction]

R1 R2

Vcc I1

Q1 Q2

Q3

Ic
or
IL

Ib3

Figure 9.2. The Wilson Current Mirror

 e=1  (118)

 10. Current sources
 10.1  Basic constant current source 
Figure 10.1 shows a Basic constant current source where an LED diode D1 is used as a voltage 
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reference for Q1. The diode knee voltage is around 1.7V for standard LED's and is reported to be 
more temperature stable then 3 silicon diodes in series to give the same reference voltage. 

D1

R1

R2

Q1

Vcc
I2

I1

Figure 10.1. Basic constant current source using an LED voltage reference

This can be solved like the basic current mirror except the diode transistor here has a beta of zero 
(or the collector is open circuit). The LED has a finite equivalent series resistance and this becomes 
the same as R1 in the basic current mirror.

Following the same path as for the current mirror we neglect the beta of Q1 is at first. The voltage 
loop equation around the LED and Q1 emitter via LED Rs1 and Q1 R2 gives 

I2⋅R2− I1⋅Rs1=N1⋅Vt ln( I1
Is1+1)−N2⋅Vt ln( I2

Is2 +1)  where Is1 and N1 are for the LED and 

N2 and Is2 are for Q1. Combining logs and with I1>>Is1 and I2>>Is2 and assuming N2~1.0 gives 

I2⋅R2− I1⋅Rs1=Vt ln(( I1
Is1)

N1)−N2⋅Vt ln( I2
Is2 ) => exp( I2⋅R2− I1⋅Re1

Vt )= I1N1

I2
⋅ Is2

Is1N1  and 

separating I1 and I2 leads to 

I2= Vt
R2

⋅W (exp( I1 Rs1
Vt

−ln( Vt
( I1N1⋅R2⋅Is2/ Is1N1))))  & I1=

(Vcc−V LED)
R1

(119)

 where VLED can be assumed to be an approximate value of 1.7V or for more accuracy calculated 

using a recursive approach such as V LED=N1⋅Vt ln( I1app

Is1 )+ I1app Rs1  where 

I1=
(Vcc−V LED)

R1
. The reduction of I1 to the LED for Q1's base current with a finite beta can be 

accounted for by I1 '≈ I1(1− Is2 / Is1N1

Beta2 )  as explained in the current mirror above.

A simulation with R1 = 33k and R2=620 and Vcc=35V gives I2 = 1.9701 mA and I1 = 1.00283 mA 
and VLED =1.90662 V. The transistor used Beta=125, Is=9e-15, Nf=1 and parasitic Re and Rb were 
set to very small values and VAF and IKF were very large. The Green LED is modelled Using Bob 
Cordell's Green LED [www.cordellaudio.com] where Is=1e-19 A, N1=2.0, Rs1=1.5 R and Eg=2.23 
V. The ABM equations are B7:  I=(((V(Vcc)-Vled)/R1)*Rs1*(1-1/Beta2)-Vt*ln(Vt/(((V(Vcc)-
Vled)*(1-1/Beta2)/R1)**N1*R2*Is2/(IsD**N1))))/Vt then B8: I=Vt/R2*Ln(1+Exp(I(B7)))*(1-
Ln(1+Ln(1+Exp(I(B7))))/(2+Ln(1+Exp(I(B7))))) where .param Vled=N1*Vt*Ln((35-1.7)/
(IsD*R1)). This gives I2 = 1.98662 mA with error of 0.8%, and I1 = 0.986959 mA with error of 
1.6%, and VLED =1.9059 V with error of 0.03% using 1.7V as the initial estimate. (The parameter 
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Eg=2.23 V was not used in these equation). 

LED current source

-500.0E-6

000.0E+0

500.0E-6

1.0E-3

1.5E-3

2.0E-3

2.5E-3
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Vcc [V]

Ic
 [A

]

I2_ [V]
spare -
spare -

Figure 10.1a. Plot from PAK with Vcc stepped. R1 = 33k and R2=620. At Vcc=35V I2 = 
1.987mA. LTSpice I2=1.9701mA (equation error -0.9%).

In Figure 10.1a the Early effect has been disabled and the slope is due to the changing current 
through R1. This slope does not indicate the output resistance of the current source but rather the 
PSRR of the overall circuit.

 10.2  Constant current source with feedback
Figure 10.2 shows a Constant current source with feedback where the current through R1 is 
multiplied by the Beta of Q2 but when the voltage across R2 is sufficient to start Q1 conducting 
then base current is robbed from Q2 until an equilibrium is obtained where both are satisfied.

R1
33k

R2
62

Vpos1
35

Q1
2N5551C

Q2
2N5551C

I2I1

Figure 10.2. Constant current source with feedback
This equation for Ic Q2 in terms of input current I1 via R3 was solved by first assuming the Beta of 
Q2 is very large so the primary relationship between I2 and I1 can be found. The loading effect of 
Q2 beta can be added later.

Assuming the Beta of Q2 is very large then we know Vbe1=Vt ln( Ic1
Is1 +1)  and since
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Vbe1=( I2 – Ic1
Beta1)R2  and combining these we get the first solution 

I2= Ic1
Beta1+ Vt

R2 ln( Ic1
Is1 +1)  provided Beta2 is neglected. 

Q1 base current removes some current from I1 via R1 so we need to increase I1 by a sufficient 
amount. Since a designer does not usually know Beta2 value a worst case and some more is 
assumed. Since there is usually not a problem increasing I1 we can choose I1/I2=0.1 which is 
roughly the inverse of the square-root of the typical Beta2 value. 

If we define the working factor m = I2/I1 then we can find the fraction of current that Q1 collector 
must sink relative to incoming I1 so Q1 has sufficient base current to generate I2. Let k=Ic1/I1 then 

I2
Beta2

=(1−k )⋅I1 so I2
I1

=(1−k )⋅Beta2=m giving k=(1− m
Beta2) . Since Ic1=k·I1 and 

the current through R2 is now Ie= I2( Beta2
1+Beta2)  and neglecting the +1 term in the log gives 

I2=( Beta2
1+Beta2)( k⋅I1

Beta1
+ Vt

R2
ln( k⋅I1

Is1 ))  and 

I2=( Beta2
1+Beta2)( I1

Beta1(1− m
Beta2)+ Vt

R2
ln( I1

Is (1− m
Beta2))) . 

The first term Ia=( Beta2
1+Beta2 )( I1

Beta1(1− m
Beta2 )≈ I1

Beta1
= I2

m⋅Beta1)  will generally be very 

small or around 0.1% of I2. Therefore finally we can generally use 

I2=( Beta2
1+Beta2) Vt

R2
ln( I1

Is (1− m
Beta2))  where m= I2

I1 120/(120)

Note (1− m
Beta2)>0  requires m<Beta2 (as expected).

In a calculation we first estimate Vbe1 from Vk1 using 

Vbe1Est≈Vk1=N1⋅Vt⋅ln( N1⋅Vt
Is1⋅R2)  

This then allows an estimate for Ic2Est=Vbe1Est/R2 and then an estimate for m~Ic2Est /I1Est where 
I1Est~(Vcc-2Vbe1Est)/R1. Now we can use Equation (120) to calculate I2.

Using LTspice ABM with I=(Beta2/(1+Beta2))*Vt/R4*ln(((V(Vcc)-2*Vbe)/R3)/Is1*(1-m/Beta2)) 
where m=10, Beta1=Beta2=125, Is=9e-15, Nf=1, R3=33k, R4=62, and Vt=25.86.  This gives 
I2=10.4967mA while the simulation (with negligible Re, Rb and VA, IKF disabled) gave 
10.5057mA which is to within 0.1%. The value used for Vbe was 0.717V from Vt*ln(10m/Is) and 
the simulated value was 0.723V. This difference hardly affect the accuracy of I2 since Vb1 
essentially determines I2 and Vbe2 only affects the drop across R1 and hence the accuracy of I1.
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Current source with feedback
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Figure 10.2a. Plot from PAK with Vcc stepped. R1 = 33k and R2=62. At Vcc=35V I2 = 
10.50mA. LTSpice I2=10.513mA (equation error -1.2%).

In Figure 10.2a the Early effect has been disabled and the slope is due to the changing current 
through R1. This slope does not indicate the output resistance of the current source but rather the 
PSRR of the overall circuit.

To design a practical feedback current source you first decide what source current I2 you want, then 

choose a workable value for m √( Beta2typ)  then calculate R1=
(Vcc−2Vbeapprox.)

I2 /m
. You then 

calculate R2 using R2=( Beta2
1+Beta2 )Vt

I2
ln( I2 /m

Is (1− m
Beta2)) . If you don't need such high 

accuracy for R2 then simply use R2=I2/Vbe where Vbe is around 640mV to 660mV at room 
temperature for 1mA with a 100mA transistor and changes by 60mV for every decade of current 
change. 

Tip: A multimeter with a diode tester can provide Vbe (usually at 1.5mA) if you connect the 
base and collector together and read the voltage. If you want Vbe at a very high current then 
measure just the base emitter voltage at 1.5mA (giving its Vbe at Ic~Beta/3·1.5mA where Beta/3 
roughly allows for some Beta-fall at high current).

 11. Vbe multipliers
 11.1  The Vbe multiplier 
The Vbe multiplier also called the multiplied diode is used in Class-B power amplifiers for 
temperature information feedback, usually the temperature of the heatsink, to maintain roughly the 
same quiescent current with ambient temperature variations, and also to stabilise the quiescent 
current after turn otherwise the quiescent would slowly increase over a long time and eventually 
destroy the output transistors.

The Vbe multiplier is explained compactly in Bob Cordell's book [ref 11 p40]. The Vbe multiplier 
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is effectively a two terminal device that behaves like a diode with a variable knee voltage 
determined by the divider ratio of Rf and Rbe which is conveniently a trimpot. It is known that it 
generates a variable 'knee voltage' of slightly over (1+Rbe/Rf)Vbe with series resistance that is then 
shunted by Rf plus Rbe.

 
Q1

Rf

Rbe

I1
     Q1

2N5551C

Rf
1.2k

Rbe
471

I1
10mA

+1

 

 Figure 11.1. The Vbe multiplier. Figure 11.1a. Buffered version 

To derive an equation for Vce in terms of an input current I1 in Figure 11.1 (left) it is made easier if 
the set-up current drawn by Rf and Rbe can be neglected, made possible by buffering as in Figure 
11.1a (right). The collector side Collector current can be expressed in terms of an assumed Vce 
where 

Ic= NVt
R eq

W (exp(Vce( Rbe
Rbe+Rf )−Vk

NVt ))− Is
 where R eq=(Rbe∥Rf )

Beta
+

RbP

Beta
+R eP(1+Beta

Beta )  

and Vk=NVt⋅ln( NVt
Is⋅R eq ) − Is⋅R eq . ReP and RbP are the emitter and base parasitic resistances. 

W(x) can be calculated using an approximation such as W (x )≃ln (1+x)(1− ln (1+ln(1+x))
2+ln(1+x ) )  

We want Vceas a function of Iin, so we need to invert the equation above by returning it to the form 

w eW =x  to give Ic R eq
NVt

=W (exp( Vce
NVt ( Rbe

Rbe+Rf )− Vk
NVt ))−Is  and we identify w= Ic R eq

NVt  

and x=exp(exp( Vce
NVt ( Rbe

Rbe+Rf )− Vk
NVt )) . Taking logs of w eW =x  gives ln (w)+w=ln (x )  and 

substituting w and x gives ln( Ic R eq
NVt )+ Ic R eq

NVt = Vce
NVt ( Rbe

Rbe+Rf )− Vk
NVt . From this 

Vce=(1+ Rf
Rbe)(Vk+NVt ln( Ic Req

NVt )+ Ic Req)  where Req and Vk are given above. 

We can now see that the voltage divider requires that Vce is increased by the inverse factor 
(1+Rf/Rbe) to sink all the input current I1. This solution looks a bit like an ideal diode of VD= 
Vt·Ln(Ic/Is+1) except the resistors that set the base voltage enter into the equation as an equivalent 
emitter resistance, and this resistance provides emitter degeneration local type negative feedback. 
The Vbe diode volt drop is scaled up by the inverse of the voltage divider ratio. This is the familiar 
situation to the gain of a non-inverting opamp where Av=1+Rf/Rin where the feedback around the 
opamp inverts the voltage divider ratio of the feed back path.
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What about the equivalent series resistance or dynamic resistance, is it affected by the divider ratio? 

The derivative dIc/dVce can be found using our first equation where dIc
dVce

= 1
R eq

W
1+W  

allowing the equivalent resistance collector to emitter to be found using 

Rce= dVce
dIc =R eq(1+W

W )=Req(1+ 1
W ) . Since Ic=I1 with the buffer and I1 is the input 

variable we found above that w= Ic R eq
Vt  giving Rce=R eq(1+ NVt

Ic⋅R eq)  and thus 

Rce=R eq+ NVt
Ic . The term Vt/Ic is the familiar intrinsic emitter resistance (26 ohms for 1mA or 

2.6 ohms at 10mA). This shows that the equivalent series resistance is not affected by the divider 
ratio. The resistors only involve the net parallel resistance of the divider (not the divider fraction). 

Next, additional loading of the divider can be included as in Figure 11.1 (left). The divider string 

consumes some of the input current where Ic= I1 – Vce
Rf +Rbe . Noting that Vce can be 

approximated to a linear form with Ic such as Vce=(1+ Rf
Rbe)(Vk+ Ic R eq )  where Ic·Req is for 

the values in Figure 11.1 and at 10mA it gives a voltage of 34mV which is slightly more than 1·Vt 
making the Ln(1) which gives almost zero additional voltage to the Vce equation. Substituting Vce 

into the Ic equation gives Ic≈ I1 – (Vk+ Ic R eq)
Rbe = I1− Vk

Rbe− Ic R eq
Rbe  and 

Ic≈ I1

1+ R eq
Rbe

− Vk / Rbe

1+ R eq
Rbe

or Ic≈ I1/Rbe
Rb+R eq

− Vk
Rbe+Req . This current is now used in the 

original Vce equation involving I1 with the buffer, and now without the buffer 

Vce=(1+ Rf
Rb)(Vk+NVt ln( Ic R eq

NVt )+ Ic R eq)  where Ic≈ I1/Rb
Rbe+R eq

− Vk
Rbe+R eq  where 

R eq=(Rbe∥Rf )
Beta

+
RbP

Beta
+R eP(1+Beta

Beta )  and Vk=NVt⋅ln( NVt
Is⋅R eq ) . 

A simulation with Rf = 1k2 (R8 in LTspice) and Rbe = 471 (R9 in LTspice) and I1 = 10mA gave 
Vce = 2.61022 V and Ic = 8.41894 mA. The transistor used Beta=125, Is=9e-15, NF=1 and parasitic 
Re and Rbe were set to very small values and VAF and IKF were very large. The ABM equations 
are: Ic: I=I(I3)*R10/(R10+Re8)-Vk/(R10+Re8) and Vce: 
I=(1+R9/R10)*(NF*Vk+Vt*Ln(I(B3)*Re8/(NF*Vt))+I(B3)*Re8) where Req (Re8 in LTspice) is 
.param Re8=(R9*R10/(R9+R10))/Beta1 and .param Vk=NF*Vt*Ln(NF*Vt/(Is1*Re8)). This gives 
Vce = 2.60997 mA and Ic = 8.4312 mA. The error in Vce is -1% and Ic is +0.5%.

Free eBook EditionFree eBook Edition
p101        Power Amp Kalkulator User Guide PAK-1v0-NM November 1, 2012  Contents 



Basic Vbe multiplier
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Figure 10.3a. Plot from PAK with Iin stepped. Ic is also shown. Rf = 1k2 and Rbe = 471. At Iin 
= 10mA Vce=2.610V. LTSpice Vce=2.654V (equation error -1.0%).

The error at 10mA is acceptable. However, the dynamic resistance is calculated from in Figure 
10.3a results at Iin=10mA and then at 20mA Rce=(2.777-2.610)/(0.02-0.01)=94R. LTspice gives 
(2.895-2.654)/10mA=24R. This large difference in Rce is mainly due to the -1% errors in Vce.

 12.  The Basic Push-Pull output stage 
 12.1  Basic CE push-pull output stage 
Figure 12.1 shows a basic common emitter (CE) amplifier with bias voltage generators (Vsp1 & 
Vsp2) and emitter resistors (R1 and R2). Floating power supplies allow the output current to be 
summed and fed into a ground referenced load resistor. This gives the simplest possible equation 
solution for a push-pull output stage. The load current is IL=Ic1-Ic2 where Ic1 flows into the 
collector of Q1 while Ic2 flows out of the collector of Q2. Initially, the equations are solved for 
Rin=0 and the current gains (Beta) of Q1 and Q2 are constant, their gains are assumed to be the 
same and the Early effect is not included. 

Vpos1

Re1

Vneg1

Vsp1

Re2

Vsp2

RL1

Q1
NJL3281C_

Q2
NJL1302C_

Vin Vout

Fig 12.1. The Basic Push-Pull Common Emitter bipolar output stage

Figure 12.1a shows a family of 'wingspread' gm and IL curves generated by LTspice when the bias 
sources (Vsp1 & Vsp2) are stepped from 480mV to 880mV in 100mV steps. The quiescent current 
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varies from 0.46mA to 638mA. The 3rd curve is an intermediate value of 630mV for a quiescent 
current of 65mA close to the 'optimum bias' (more on THD later). The above equations are 
implemented in LTspice using ABM current sources and the same model parameters are used in the 
equations where Beta's=100, Is=5x10^-12A and Re = 330mR. Other secondary SPICE parameters 
such as IKF, ISE, VAF and VAR were disabled by setting them 1000 times beyond to their normal 
values, ie, IKF=50k, ISE=20x10^-22, VAF=1000k, VAR=4.3k. Notice VAR does have a noticeable 
effect on the forward current and it needs to be disabled as well as VAF to see the primary currents 
and gains in this most basic form. 

These wingspread curves are therefore created by the diode plus series resistance nonlinearity with 
a pure voltage source drive and before many of the other secondary effects modify the plots. 

-1. 0V -0. 8V -0. 6V -0. 4V -0. 2V 0. 0V 0. 2V 0. 4V 0. 6V 0. 8V 1. 0V
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-1Ω3. 5

-1Ω4. 0

-1Ω4. 5

-1Ω5. 0

-1Ω5. 5

-1Ω6. 0( I (B1)- I (B2)) I (Rl 1) d(I (Rl 1)) d( I (B1)- I (B2))

Figure 12.1a. Wingspread plots using ABM equations concurrent with the LTspice circuit. 
Load current (bottom right) and gm with each Vsp stepped (480mV, 580mV, 630mV, 680mV, 

780mV, 880mV) (Red = SPICE, Rin=1mR, Re=330mR, no IKF & Ise & VA).

The accuracy using the 3 term Lambert W function approximation gives around +-1% maximum 
error for Ic and gm over a wide range of current and bias settings. No additional curve fitting 
scaling factors were used. The gm equation solution is calculated directly by an ABM. 
Using the diode plus resistor solution on the collector side for Q1 when Rin =0 is 

 Ic1= N1⋅Vt
R e q1

W (exp(Vin+Vsp1−Vk1
N1⋅Vt )) where Vk1=N1⋅Vt ln( N1⋅Vt

Is1⋅Req1)  and 

Req1=
Rb1P

Beta
+( R e+R e1P )⋅( Beta+1

Beta ) and W (x )≃ln (1+x)(1− ln (1+ln(1+x))
2+ln(1+x ) )  

127(121)

where ReP and RbP are Q1's parasitic emitter and base resistances. Q2 has a similar set of equations 
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except the sign for Vin is reversed. As already mentioned, Ic2 is positive for a PNP transistor; Ic2 is 
the magnitude of collector current. The load current is therefore calculated from IL=Ic1-Ic2. 
Saturation can be added to Ic1 using a simple approximation like 

Ic1Sat=Min(Ic1 , (Vpos−N1⋅Vt⋅ln (Beta1))
RL+Re1+Re1P )  (122)

also added to Ic2 gives approximate saturation to the load voltage. The individual gms for Ic1 is 
also readily calculated using Gm1=1/Req1{W127}/(1+{W127}) and a similar expression for Ic2.

Figure 12.1b shows the Gm total plot for Gm1+Gm2 from Ic1 and Ic2 equations. The equation gain 
plots (green) lie on top of the LTspice gain plots (red obscured) and are more accurate than the gains 
derived by LTspice from Ic1 and Ic2 equations (cyan). This is because the errors in Gm1 and Gm2 
cancel when they are added.

-300mV -200mV -100mV 0mV 100mV 200mV 300mV
-1Ω1. 0

-1Ω1. 5

-1Ω2. 0

-1Ω2. 5

-1Ω3. 0

-1Ω3. 5

-1Ω4. 0

-1Ω4. 5

-1Ω5. 0

-1Ω5. 5

I (B5) / V(1Vref )+I (B6) / V(1Vref ) d( I (Rl 2) )
d( I (Rl 1) ) d( I (B1)- I (B2))

Figure 12.1b. Shows the equations for GmTot (green) obscures the LTspice Gm (red is 
obscured). GmTot is more accurate then IL using these equations.

 12.1.1.  On optimum biasing for Class-B (aka Class-AB)
Section 3.1 (Fig's 3.1d-f) introduced the use of the Diode plus Resistor Lambert W solution for 
representing push-pull. It was stated that optimum bias in a BJT Class-B push-pull circuit occurs at 
approximately one NVt higher than the knee voltage Vk. The knee voltage is determined by the 
transistor area (through the parameter 'Is') and resistances Re and the source resistance Rin making 
up the equivalent total Req. The section shows how to derive the 'one NVt' voltage.

Interestingly, when pure voltage drive is used as in Figure 12.1 the Beta's for Q1 and Q2 do not 
have much effect on the shape of the curves. The only effect is the RbP/Beta part of Req. In terms of 
symmetry of the +ve and -ve sides the matching of Beta's with voltage drive has little effect. It is 
possible to get symmetry with different Beta's by adding some base resistance to the higher Beta 
transistor. Alternatively, the emitter resistance for the higher Beta transistor could be reduced. If the 
internal emitter resistances ReP are not matched then the external Re's can be trimmed for 
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symmetry. Even high current Beta-fall can be trimmed for symmetry with voltage drive. 

Similarly, with voltage drive 'IS' mismatch doesn't affect symmetry – IS's affects Vk1 and Vk2 for 
Vsp1 and Vsp2 respectively so differences in IS's can be trimmed out by an offset voltage in the 
bias circuit. This gives a big advantage for voltage drive of a BJT output stage over non-voltage 
drive. But how low does Rin need to be to constitute voltage drive? One way is to increase Rin until 
a second order effect gives say 10% asymmetry that was otherwise suppressed by pure voltage 
drive. This is checked in the following section where Rin>0.

Calculating the bias point for 'optimum bias' is roughly where the total gm is half the large signal 
gm, that is gm(0) = gmLim . Since both devices are conducting when Vin=0 and assuming they are 

matched their gains double giving gmTot = gmLim . Since gm(0)= 1
R e

W (x )
1+W (x )

= 1
2  we can solve 

for x to find the bias voltage Vsp from Re and Is. Solving for W(x) gives W(x)=1. To find x we need 
to invert this relation, the inverse of an inverse, so we so we simply use the original definition for 

W(x). In this case 1e^1=x giving x=e or ~2.71. Since x=exp(Vsp−Vk+0
NVt )=e1  we get 

(Vsp−Vk )
NVt

=1  so (Vsp-Vk)=NVt. Therefore the bias spread voltage Vsp needs to be Vsp=Vk 

plus one NVt. This gives half the large signal gain at Vin=0 which near optimum bias for minimum 
distortion. 

Interestingly, this bias voltage is transferred to the emitter resistor with a gm of half the full gain at 
high currents. From the Gm equation we know W(x)=1, so Ic1(Vin=0)=(Vt/Req)·W(x)=Vt/Req 
which means one NVt is across Req. The actual voltage measured across the external Re is a 
voltage divider involving Re and Req giving VRe = NVt·(Re/Req).

Optimum bias requires approximately one NVt across each emitter resistor and is referred to as 
“Oliver's condition” [Ref 11 Cordell cites 'BM Oliver HP Jn. Feb 1971'].

Optimum bias for minimum THD is usually more complicated due to the base resistance varying 
with base current and high current Beta-fall. The best bias setting also depends whether unweighted 
or weighted THD is used [ref 19 L|A Vol 4], and whether slight over bias is exploited to pre-empt 
thermal lag distortion (TLD).

Very low external emitter resistances can be used to raise the optimum bias current and this reduces 
the proportion of high order harmonics which our hearing is very sensitive to. In this situation is is 
better to aim for bias at Vk to exploit the inflection point mentioned in relation to Figure 3.1f – this 
further reduces high order distortion compared to Vk plus one NVt biasing and the quiescent heat 
dissipation is nearly halved.

 12.2 Basic Common Emitter Push-Pull output stage with large Rin
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Q4
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Iin=Vin*(1/(Beta1*Re)+1/Rin)
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{Re}

{Vneg}

Vsp3

{Re}
Vsp4

{RL}

Vx Vout

 Figure 12.2. Circuit for current drive with a high Rin

Increasing the drive source resistance Rin in circuit Figure 12.2 has the effect of reducing non-
linearity in the crossover region provided Beta-fall is negligible. When Beta-fall is disabled, as in 
the next two plots, we can observe the effect of current drive, rather than voltage drive in the 
previous section, on the other nonlinearites generated by the basic bipolar transistor push pull 
output stage. 

The equation for the driving current source allow Rin to be varied from a small (but non zero value) 
to very large values relative to a nominal input resistance of the transistors is 

I =Vin⋅( 1
Beta1⋅Re1+ 1

Rin)  (123)

For current drive to be noticeable for reducing crossover distortion the driver source resistance 
needs to be at least 10 times more than the nominal input resistance – namely 330R to 3k3 for the 
Basic CE configuration (8k to 80k for a Basic Voltage Follower). Current drive using this equation 
gives normalised plots with the same limiting gains independent of stepping Rin over many 
decades. In a practical amplifier circuit the driver stages 'Rin' would be the Norton equivalent with 
Rin to ground and current source being the VAS stage.

Figure 12.2c and Figure 12.2d shows increasing Rin linearises the crossover region. This occurs 
with both over-biasing (Figure 12.2c) and under-biasing (Figure 12.2d). But this is only possible if 
IKF for high current Beta-fall and VA for the Early effect are disabled.
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Figure 12.2c (L). Wingspread plots with over-bias Vsp=1220m (giving Iq=1.7A) and 
Figure 12.2d (R) Vsp=460m ( Iq=0.25mA). Rin stepped 33mR, 33R, 3k3. (Red = LTspice). 

Note the linearisation effect with a high Rin (only possible if IKF and VA are disabled).

If weighted distortion is used to asses the relative merits of the voltage drive and current drive 

Free eBook EditionFree eBook Edition
p106        Power Amp Kalkulator User Guide PAK-1v0-NM November 1, 2012  Contents 



approaches to minimising the audibility of crossover distortion then it would seem from Figure 
12.2d (under-biased) that current drive generates more high order distortion than voltage drive 
given the same number of stages to accomplish current drive or voltage drive. Additional 
simulations or bench tests are needed with weighted distortion to confirm this [ref 19 L|A Vol 4].

Interestingly, Figure 12.2c shows slight over-biasing with current drive does not produce very sharp 
gain changes as for under biasing with current drive. So current drive with slight over-biasing may 
not be that much different to voltage drive.

 12.2.1 Equation solutions for the Basic PP output stage when current driven 
with a high Rin
The equations for Rin>0 requires the effective input voltage at the base node (Vx) needs to be 
known since the Lambert solution involves an input voltage to the base-emitter diode plus an 
equivalent resistor in series with this diode.

Since the voltages to the bases are not proportional to Vin any more the crossover region exhibits 
different equivalent resistances depending on whether one or two transistors are conduction. This 
suggests that a switch is needed to model the equivalent series resistance to find the current in one 
transistor. 

In circuit Fig 12.1 with high Rin the net impedance of node Vx to common is a nonlinear function 
of Vin due to the two current dependent conductances of the base-emitter paths to common. The 
overall conductance at node Vx is the sum of the two base-emitter conductances which must then be 
paralleled with Rin. That is Gx=G1+G2+1/Rin, where G1 is conductance of Q1 base-emitter plus 
Re1 (and G2 is likewise for Q2 plus its Re2). The input resistance at this node is 1/Gx. (Capital G is 
used for the large signal function namely Gx(Vin). 

The node resistance 1/Gx defines the voltage gain Vx/Vin for either the voltage driven case or the 
current driven one. It was found that the Lambert solution incorporating a switch functions for the 
equivalent resistances seen by each base-emitter diode gave close enough approximations over a 
wide range of bias points and input resistances. The resulting switch solution shown in Figure 
12.2c,d give a typical accuracy of around +-5% for currents and gains. This is considered adequate 
for comparing relative distortion figures and relative sensitivities to temperature. 

12.2.2 First approach 
At high Vin and with only one transistor conducting, the solution for the collector current following 
Ebers-Moll and Gummel-Poon approach so Rin is referred to the collector side. The equations 

become Ic ( Iin)Q10=
Vt

ReTot
W (x )  where x=exp(( Iin⋅Rin '−Vk )

Vt )  and Vk=Vt ln( Vt
Is⋅ReTot )  & 

W (x )≃ln (1+x)(1− ln (1+ln(1+x))
2+ln(1+x ) )  

Rin' is the net parallel input node resistance which is determined by the bias point (Rp in the above 
equations) and Sw11 (IB11 above) which is ON (Sw=1) for the crossover region and OFF (Sw=0) 
when Q10 turns off. (The Is·ReTot term has been dropped from Ic since Is is typically 4-6 orders of 
magnitude smaller than Ib).

The formulation chosen for ReTot is R eTot=R e+ Rin ' (1+Sw11)
Beta . Interestingly, the term (1+Sw) 
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effectively doubles Rin' within the crossover region which occurs during over biasing with both 
transistors conducting. This may be thought of as the two transistors sharing Rin, so each transistor 
sees (2·Rin/Beta +Re) for the net diode series resistance within the crossover region and both 
transistors conducting. This observation may be helpful for solving other circuits.

The switch functions B1 and B11 use a Lambert solution with both transistors ON. This uses the 
two term approximation which is sufficiently accurate. The input parameter Iin is I(B21). The 
switch function is simply the Gm Lambert value for Ic without the scaling with 1/R and this gives 
the normalised and non-dimensional Gm 'switch' function. 

The term Vk=Vt ln( Vt
Is⋅ReTot )  is split into VkTot=Vt ln( Vt

Is⋅Re)+Vo+ Io⋅Rin '  to separate out the 

terms independent of Rin and those affected by Rin. The Io term is the offset that involves the 
Switch plus an offset needed to ensure the current just before the switch turns OFF will match the 
current when the switch has turned OFF. This is found using the inverse Lambert function (similar 
to the CFP solution in Section 13). Io also includes a 'small' fixed current that is added as a 'fix' to 
ensure that the quiescent current remains reasonably constant for large values of Rin compared to 
Rin=0. 

The joining offset is calculated when Iin (or Vin) satisfies the condition 

Ic ( Iin)Q10=
Vt

ReTot
W (exp(0))  which is a convenient reference point since Ic ( Iin)Q10=

Vt
R eTot

⋅1  and 

this current must be the same for the switch ON and OFF at the particular Iin, which is  or Vin=Vk 
(Iin·Rin'-Vk) =0 the knee point. 

Solving for Io offset using the relation w·e^W=x to give the same x values before and after switching. 

After the switch turns OFF we have Wo in the relation W 0exp (W 0)=x=exp( Io⋅Rin '−Vk
Vt )  

giving Vo=Vk+Vt
(W 1+ln (W 1))
(W 0+ln (W 0))

where W1 is at the same x value as Wo but with the switch 

turned ON. 

Plots were provided above for current drive in Figure 12.2c for over-biased and Figure 12.2d for 
under-biased cases. 

In LTspice the numerical overflow limit for the Exp(x) function can easily be exceeded before the 
full output current was reached. This occurs in the basic output stage when Rin is large (and it also 
occurs with the CFP with low Rin). When the limit is exceeded in LTspice a zero result is displayed 
while the simulation of other circuit currents continues. 

To obtain larger range in the ABM equations the Lambert approximate solution is switched to the 
approximation W(x)~(1-1/Ln(x))·Ln(x) for x>Exp(70). The upper limit value is first computed as 
((1-1/(70)*70)/W(exp(70)) as 'Lcf' (Lambert correction factor) which is also used to improve the 3 
term approximation for large x accuracy by about 1%. The limit applies to x>>10^20 (and is chosen 
for <1% error). This uses the limit W(x) → Ln(x) for large x.  Our diode plus resistor (and 
transistor) circuit equations use W(exp(Y)) so we get W(exp(Y))→ Y-1 when Y is large and Y>100 
the error for W(exp(Y))=Y-1 falls below 1%. 
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The ABM equation for the 3 term Lambert approximation is usually of the form: .function We(Y) 
{(ln(1+Exp(Y))*(1-(ln(1+ln(1+Exp(Y))))/(2+ln(1+Exp(Y))) ))*Lcf} for Y<70 in LTspice, and Lcf 
can be generated as a constant using 
.param Lcf=(70-(1-1/70)*ln(70))/(ln(1+exp(70))*(1-ln(1+ln(1+exp(70)))/(2+ln(1+exp(70))))). 

Since unlimited range is needed the extra over-range function is added (shown in bold) 
.function We(Y) {(ln(1+Exp(Y))*(1-(ln(1+ln(1+Exp(Y))))/(2+ln(1+Exp(Y))) ))*Lcf*(1+Sgn(70-
Y))/2+(Y-(1-1/Y)*Ln(Y))*(1+Sgn(Y-70))/2}
This appears to give a glitch free transition. Equations in Excel and Calc spreadsheets do not appear 
to need the approximation to handle typical large values although the Lcf factor is usually included 
to improve the 3 term Lambert approximation. 

In the ABM circuit equations a calibration factor for Rp is used. This this is determined empirically 
by stepping Rin with Rin very large until the crossover wobble due to equation switching is 
minimised. This is an interesting effect can be observed where an upper limit to the amount of 
improvement that current drive can give. This upper limit changes mainly with Rin but also depends 
the bias setting. For example, the improvements were limited to 3% gain variation in Figure 12.2d 
(under-biased) but only 0.3% for Figure 12.2c (over-biased). This shows that over-biased (gm-
doubling) and with current drive where Rin is very high is linearised ten times better than 
underbiased case. For over-bias the limit occurred when Rin was around 3k3 or 100 times the 
nominal input resistance of Beta·Re or 33 ohms. The underbiased case required ten times higher 
source resistance of 33k before a negligible improvement was seen. 

This suggests current drive reduces crossover distortion far better when over-biased than under-
biased; in this example by two orders of magnitude or 100 fold. This will only apply to a basic 
output stage, when driver transistors are added there are other limitations that reduce the upper limit 
on the amount of improvement possible using current drive. However, this analysis (with no Beta-
fall and no Early effect) is useful as it gives an insight into the theoretical upper limit to what 
current drive can achieve in Class-B power amplifier circuits.

The following sections cover a solution for a bipolar Common Emitter Push-Pull output stage. It 
appears an exact solution is not possible since it involves two diode/transistor resistor solution and 
the standard Lambert W-inverse method does not allow an exact solution. An approximate solution 
is covered later. It was found that this solution is not suitable for modelling low current Beta-fall 
and a better set of equations that allow the addition of low current Beta-fall is under-way.

 12.2.3. Second approach for the basic Push-Pull output stage with large Rin
An alternative approach for developing equations for the basic Push-Pull output stage with large 
Rin is presented here. The First approach gives good plots for the total Gm and the total output 
current over a wide range of Rin values but individual gains and individual currents are not very 
accurate with very large Rin and it also prevents low current Beta-fall from being represented due to 
such large errors in the individual currents.

This second approach starts with the simplest possible circuit with Rin and that is when the Re's are 
removed giving an equivalent circuit of Figure 3.5. Figure 3.5a shows the Gm when Re's are 
removed. Notice how the plots are different to normal 'wingspread' plots (such as Figure 3.1e with 
voltage drive – no Rin). It is found that increasing Vspread with Re=0 does not lead to a peaking of 
the gain at Vin=0 and the gain variations are much wider (10Vt or 20Vt) and therefore has mostly 
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low order harmonic distortion. This is a better form of Class-AB than Figure 3.1f (bias at Vsp=Vk) 
since there is less gain variation when transitioning to the high currents. Notice the gain variation 
becomes very small when Vk+3Vt is used and the quiescent current is about 600mA with Rin=1R 
which gives a non-switching situation where the current is still 40mA with 10V input and the other 
diode is almost 10A. 

Interestingly, higher bias current does not give higher distortion so there is no optimum bias for 
minimum distortion just a trade-off of quiescent dissipation and linearity. This is an ideal situation 
and not achievable in practice but it does give an idea of what the form of an equations might 
represent this behaviour. The d(Id4) plot looks like the Tanh(x) function but not perfectly 
symmetric. The current is therefore close to a Log(Cosh(x))+C function (which is the integral of 
Tanh(x)). 

The next stage is to find a way to morph the Log(Cosh(x))+C function for Id4 to the Lambert W-
solution for Id4 as Vspread is reduced from say Vk+3Vt to zero, similar to Section 8.1 for the 
differential pair. Then Re can be reintroduced and hopefully the solution will give better individual 
Ic solutions for including the low current Beta-fall effect. If you develop this approach then please 
send a solution (see Feedback).

 12.2.4. On the practical use of current drive for linearising power output stages
This method of linearisation has been previously used first by J Faran [ref IRE Jul 1962 Fig.7] then 
Peter Blomley [ref WW Feb 1971] and then Paul Mills with Malcolm Hawksford [JAES Oct 1989]. 
Figure 12.2e shows the circuit used by Faran to reduce crossover distortion. Faran did no use any 
quiescent bias voltage to the output power transistors and still the output waveforms appeared to be 
surprisingly linear (Faran's Fig 3 vs Fig 4). Thermal-lag distortion (TLD) cannot happen with this 
approach. 

 

Figure 12.2e. Top Left is voltage drive (no bias), Bottom Left current drive (Beta asymmetry 
and low current Beta-fall are visible) . Right High impedance drive of an early bipolar output 

stage by J Faran [ref IRE Jul 1962 Fig7].
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Figure 12.2f. Waveforms from Blaser 1963. Fig 4 shows slow cut-off and turn on due to Cbe. 
Fig 5 shows beta variations with Ic (the steeper part is due to beta peaking).

Peter Blomley found that it was helpful to add some bias voltage to the crossover circuit, in his case 
thermal lag distortion was not a problem despite the addition of a quiescent current because the 
crossover took place in a low power stage where junction temperate changes were insignificant and 
the power output halves used CFP arrangement provides good thermal stability.

Malcolm Hawksford's common base current driven output stage Figure 12.2g. This is similar to 
Faran common base using a driver transformer except Hawksford uses a high current opamp as 
current source. Note the driving opamp must supply the full output current at a low voltage of under 
1V peak to peak. Hawksford's output stage is also equivalent to Blomley's except that Blomley uses 
a low current common base splitter and CFP power halves. Hawksford's practical CB output stage 
includes some bias voltage and emitter resistors as does Blomley's. The traces in Figure 12.2e show 
the distorted input voltage to the common base output stage due to the current drive and the 
resulting linear output.

 

Figure 12.2g. Left Malcolm Hawksford's common base current driven output stage. Right 
Faran's common base waveforms (be upper, VL mid, X-Y lower)

Both Bob Cordell and Douglas Self aim to drive the output stage with as low source resistance as 
possible by using a triplet Darlington so the VAS output impedance is small relative to the 
Darlington triplet input impedance [ref 11 Cordell book p64-67]. My simulations of Bob Cordell's 
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triplet Darlington circuits suggest there is a useful linearity gain by adding the extra driver 
transistors of a Triple stage to provide better voltage drive of the output stage. This is probably due 
to the 'shielding' from the effects of Beta-fall and beta asymmetry. The additional phase contribution 
of the extra driver stage does not seem to introduce a significant stability problem (at least in 
simulations) probably because the driver transistor FT's are higher than the driver and power 
transistors.

John Curl who designs all the ParaSound power amplifiers uses a complementary MOSFET driver 
stage for bipolar power transistors to prevent the variable speaker loading affecting the loading of 
the VAS stage [ref 12]. This can achieve the same isolation effect as the Triple Darlington but with 
one less stage. Incidentally, John Curl found MOSFET output transistors were less rugged than 
bipolar transistors. This may be due to long run inductance effects which can be overcome by 
decoupling physically close pairs of output MOSFET's then paralleling those pairs. Anthony Holton 
[www.ausiaudio.com] solved this problem by mounting the upper-MOSFET's on one side of the 
heatsink and the lower-MOSFET's on one side (BTW Anthony uses Bengt Olsson's totem-pole 
output stage from Electronics World Dec 1994 and see Letters Oct 1995 p886-7).

Figure 12.2h. Totem-pole transistors on opposite sides and
decoupled locally solved the problem of earlier versions.

 12.3  The Voltage Follower Basic Push-Pull output stage [under 
construction].

Vin

Vpos

Re1

Vneg

Vsp1

Re2
Vsp2

RL

Q1

Q2

Rin
Vout1

Figure 12.3. Basic Voltage Follower PP output stage with voltage drive and Rin
Figure 12.3 shows the basic push-pull Voltage Follower bipolar output stage. The only difference 
between the CE circuit above is the load common has been moved from the emitter resistors node to 
the power supply centre rail and the Vout take-off point is swapped.

A solution for this circuit is not included in the circuits file but an approximation is used in the 
spreadsheet based on the CE solution where the output current and distortion is is scaled by 1/
(1+Gm·RL). A more appropriate solution would be to incorporate RL into Rin, such as 
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RinEff≈Rin+Beta·RL, and using the pending solution mentioned in Section 12.1.2. This works for 
matched Beta's and no Beta-fall. It should be possible to modify the solution for unmatched Beta's 
and with Beta-fall.

 12.4  Basic Voltage Follower PP output stage with current drive
[under construction]

Q1

Q2

RinIin

Iin=Vin*(1/(Beta1*Re)+1/Rin)

Vpos

Re1

Vneg

Vsp1

Re2

Vsp2

RLVx Vout

Fig 12.4. Basic Voltage Follower PP output stage with current drive
Figure 12.4 shows the basic Voltage Follower Push-Pull bipolar output stage with current drive into 
a termination resistor Rin. The equation for Iin normalises the upper limit Gm to 1/Re independent 
of Rin allowing more relevant plot comparisons when Rin is varied over many decades (as used in 
Figure 12.2c,d). 

Iin=Vin⋅( 1
(Beta1⋅R e )

+ 1
Rin)  (124)

 12.5 Basic Push-Pull amplifier with the Early effect

Vpos

R13
{Re}

Vneg

Vsp+

R14
{Re}

Vsp- 8.0

RL

Q10

Vin

{Rin}
Vout1

Q11

R0
+

R0
-

Figure 14.3. The basic push-pull VF bipolar output stage with the Early effect

The Early effect was added previously to the Single Ended CE stage in Section 4.1.2. The Early 
effect is added here to a Push-pull class-B VF output stage shown in Figure 14.3. This is similar to 
the single ended common emitter stage except that IL is the sum of the two transistors collector 
currents which are modulated by their collector to emitter voltages.

The Early voltage is again modified by the local feedback from the emitter resistors, for Q10 we use 

the “+” superscript Ic+(Vaeff
+ )= Ico+(1+ Vce+

(Va eff
+ ))  where 
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Vaeff
+ (Re)=Va+(1+Re+⋅gm0

+(1+
Vceest

+

Va+ ))  where gm+
0 is calculated along with the Lambert W 

solution for Ico+ . The collector to emitter voltage for Q10 is
Vce+=Vpos−IL (RL+Re++Rep++Rcp+) . Similar equations can be written for Q11 with “-” 

superscripts Ic -(Vaeff
- )= Ico-(1+ Vce-

(Vaeff
- )) and Vce-=Vpos+ IL (RL+Re-+Rep-+Rcp-) . The 

load current is the difference of the two collector currents IL= Ic+ (Va eff
+ )− Ic-(Vaeff

- ) so 

IL= Ico+(1+ Vce+

(Vaeff
+ ))− Ico-(1+ Vce-

(Vaeff
- )) => 

IL= Ico+(1+Vpos− IL (RL+Re++Rep++Rcp+)

(Vaeff
+ ) )− Ico-(1+Vpos+ IL( RL+Re-+Rep-+Rcp-)

(Vaeff
- ) )

. Collecting IL terms on the LHS gives 

IL(1+ Ico+ (RL+Re++Rep++Rcp+ )
Va eff

+ + Ico-(RL+Re-+Rep-+Rcp-)
Vaeff

- )=Ico+(1+Vpos
Vaeff

+ )−Ico-(1+Vneg
Va eff

- )  

finally IL=

Ico+(1+Vpos
Va eff

+ ) − Ico-(1+Vneg
Va eff

- )
(1+ Ico+ (RL+Re++Rep++Rcp+ )

Vaeff
+ +

Ico-(RL+Re-+Rep-+Rcp-)
Vaeff

- )
where 

Vaeff
+ (Re)=Va+(1+Re+⋅gm0

+(1+
Vceest

+

Va+ ))  and Vaeff
- (Re)=Va-(1+Re-⋅gm0

-(1+
Vceest

-

Va- ))
which requires an estimates for Vce+ and Vce- with Ico for Q10 and Q11 using 

Vceest
+ =Vpos−( Ico+− Ico-)(RL+Re++Rep++Rcp+) and 

Vceest
- =Vpos+( Ico+− Ico-)(RL+Re-+Rep-+Rcp-) . 

The Lambert W collector current solutions for Q10 and Q11 (with no Early effect) can be post-
processed, and the solution is exact for Re=0. With typical emitter resistance values there is only a 
small error due to an approximation for Vce (to calculate the effective Early voltage modified by 
the local NFB due to Ro via Re). 

The denominator involves the sum of the collector currents (magnitudes). Interestingly, in Class-A 
(also Class-AB within the gm-doubling region) the sum of the collector currents can be fairly 
constant, where one transistors current ramps up while the other ramps down. In this situation the 
Early effect does not introduce any significant additional distortion. 

Also note that under all biasing situations the numerator does not introduce any nonlinearity from 
the Early effect when Vce varies since the numerator has fixed voltages of Vpos and Vneg. The 
only distortion effect the numerator can add is gain asymmetry where the collector currents can be 
scaled by different amounts, and this occurs if the Early parameters are asymmetric (not matched). 
If Q10 and Q11 have significantly different Early parameters (and yet all other complementary 
parameters are symmetric) then any voltage variations in supply voltages (Vpos and Vneg) will 
intermodulate into the output signal. This can occur when one rail sags due to the collector current, 
and since a capacitor is across the supply rails then this intermodulation distortion will be seen to 
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increase at lower frequencies due to Early parameter asymmetry.
---------------------- --------------------

 13.  Push-pull Complementary Feedback pair (CFP) 
The solution for the Single Ended CFP or Sziklai pair was given in Section 5. The first section 
covers the Push-Pull case with voltage drive (Rin=0) and then Rin is added to cover current drive. 
Equations are first solved assuming all Beta's are constant, also the Early effect is not included at 
this stage.

Figure 13.1 shows a CFP (Sziklai pair) output stage with bias voltage generators (Vsp) and emitter 
resistors R1 and R2. Floating power supplies allow the output current to be summed and fed into a 
ground referenced load resistor. 

The load current is IL=Ie3+Ic1 – (Ic4+Ic2) following the same approach as Section 5.5 where it was 
noted that the sum of Ic1 plus Ic3 combine and flow through Vpos so the current through Rbe1 does 
not need to be mentioned. Emitter resistors for the output transistors Q3,4 are not shown but they 
can be easily included if needed when paralleling output transistors (along with ReP etc).

Vpos

Re1

Vneg

Vsp1

Re2

Vsp2

RL

Q1

Q2

Q3

Q4

Rbe1

Rbe2

Vin Vout

Figure 13.1 Common Emitter Push-Pull CFP output stage (no Rin)
The equations for Figure 13.1 are two duplicate sets of the Single Ended equation in Section 5.5 
where Rbe is included. The spreadsheet uses the same empirical fitting constant Vo for Beta3Eff and 
Beta4Eff. The top half equation labels are appended with 'P' (for Positive)and the lower equations 
with 'N' for Negative). The equation sets are not provided here but can be viewed in Sheet13 where 
labels are used which means the equations are human readable.
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   -500mV -300mV -100mV 100mV 300mV 500mV
-2. 0A

-1. 6A

-1. 2A

-0. 8A

-0. 4A

0. 0A

0. 4A

0. 8A

1. 2A

1. 6A

2. 0A

-1Ω0. 0

-1Ω0. 6

-1Ω1. 2

-1Ω1. 8

-1Ω2. 4

-1Ω3. 0

-1Ω3. 6

-1Ω4. 2

-1Ω4. 8

-1Ω5. 4

-1Ω6. 0

- I (B14)*I (B9) / I (R1) I (B4)*I (B9)/ I (R1) - I (Vpos1)*I (B9) / I (R1)
I (Vneg1)*I (B9) / I (R1) d( I (Rl 1)) d( I (B4)- I (B14))*1

Figure 13.1a. CFP LTspice and equation gain and current plots with Re=0.33R, Rbe=33R and 
Vsp= 655mV. Vsp is stepped 580mV, 630mV, 655mV, 680mV, 780mV. 

CFP (no Rin) Gm's

-0.5

0

0.5

1

1.5

2

2.5

3

3.5

-0.5 -0.3 -0.1 0.1 0.3 0.5

Vin

Gm3_ [A/V]
Gm4_ [A/V]
GmTot [A/V]
spare -
spare -

Figure 13.1b. CFP Spreadsheet plot with Re=0.33R, Rbe=33R and Vsp= 655mV. 

It was found that the CFP is sensitive to small variations in bias voltage near optimum bias with +-
2mV changing the shape of the mid gain wobble from upward to downwards. An offset term is used 
for fine adjustment of the bias voltage for the equation to align the curves as close as possible.

This high sensitivity to Vsp at optimum bias is due to the very small quiescent current through the 
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output pair compared to the basic Bipolar Push-Pull output stage in Section 12. With the same 
emitter resistors of 0.33 ohms the CFP output transistors carry 15mA at optimum bias compared to 
80mA for the basic Bipolar Push-Pull output stage. This operating point is only 5mV above the 
switching voltage (Vsw in Section 5) where the output transistors gain begins to rapidly rise. 

Weighted distortion are needed to asses the relative merits of the CFP compared to the basic Bipolar 
Push-Pull output stage and the Darlington output stage [ref 19 L|A Vol 4]. Figure 13.1a shows that 
more high order distortion is produced by the CFP. Interestingly, removing the base-emitter resistors 
(Reb1 and Rbe2) eliminates the sharp switching in the CFP as shown in Figure 13.1c. 

Figure 13.1c. CFP with Reb1 and Rbe2 removed eliminates sharp switching and returns to the 
shape of a Basic Push-Pull output stage.

Bob Cordell provides an overview of the CFP in his book (p106-108). One major concern with the 
CFP is high frequency stability and the main cause may be that both output transistors are “starved” 
of current at optimum bias and the FT of the output transistors fall at this low current even if low 
value base-emitter resistors are used. In the Darlington output stage there is always one transistor 
that has enough current to keep the FT reasonable but in the CFP both output transistors get 
“starved” passing through the crossover region so the FT falls and instability can result if the 
compensation frequency is not lowered.

Figure 13.1d shows a CFP variant that does not use base-emitter resistors for the output transistors. 
The MOSFET's in the driver transistor emitters allows a relatively high optimum bias of 300mA for 
50W and this combination eliminates high order crossover distortion [ref 17 EW+WW Sep 1995]. 
No problem with the slower turn off of the output transistors was obvious with no base-emitter 
resistors and the biasing stability was excellent. However, an upgrade to modern high frequency 
power transistors with low beta-fall will help. Someone said that the base-emitter resistors generally 
halve the turn-off time and if that is the case then eliminating the base-emitter resistors in a CFP 
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halves the usable bandwidth and halves the usable amount of NFB but without the resistors the very 
high-order crossover distortion is almost eliminated – it appear to be well worth while trade.

 Figure 13.1d. A CFP variant using no base-emitter resistors and a relatively high optimum 
bias of 300mA for 50W eliminates high order crossover distortion.

 14.  Push-Pull Darlington output stage 
 14.1  Push-Pull Common Emitter Darlington output stage 
[under construction]
The first (simplest) Push-Pull Darlington circuit is Common Emitter with Rin=0 and with voltage 
drive. 

Vpos1

{Vpos}

{Re2}
Re2

Vneg1

{Vneg}

Vsp1

Re4
{Re4}

Vsp2

{RL}

RL1

Q1

Q2
Q4

Q3

{Re1}
Re1

{Re3}
Re3

Vin Vout1

Figure 14.1. Push-pull Common Emitter Darlington output stage with no Rin

Figure 14.1 shows an Emitter Follower 'Darlington' output stage with bias voltage generators 
(2·Vsp) and emitter resistors (Re1 and Re2). Floating power supplies allow the output current to be 
summed and fed into a ground referenced load resistor. This simplifies analysis. The load current is 
IL=Ic3+Ic1 - (Ic4+Ic2) where Ic3 flows into the collector of Q3 while Ic4 flows out of the collector 
of Q4. Each half of the Darlington pair was solved in Section 7 with constant Beta's and no Early 
effect. 
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The previous solution was Ic3= N3⋅Vt
Req

W (exp( A1(Vsp1+Vin−Vk3)−Vo3
N3⋅Vt ))  where A1 is the 

voltage divider ratio formed by Rbp1/Beta1 and Re1 or A1= Re1
Re1+Rep1+Rbp1/ Beta1 and 

Vo3≈700m⋅ln( 1 / A1
1+ln (1 / A1)) . Terms for Req, Vk3 and Vo3 were defined in Section 7. 

The driver collector current is approximate since it involves Ic3 (which is an approximation) is 

Ic1= N1⋅Vt
Re1+Rep1+Rbp1/ Beta1

W (exp( 2⋅Vsp1+Vin−Vk1
N1⋅Vt ))+ Ic3

Beta3  where

Vk1=N1⋅Vt⋅ln( N1⋅Vt
Is1( Re1+Rep1+Rbp1 /Beta1)) . Parasitic emitter and base resistances can also 

be included for Q3 Rep3+Rbp3/Beta added to Re2. 

For the complementary transistors the same equations are used but with -Vin in place of +Vin in the 
two equations above. The power rail currents are IC3+IC1 and the load current is the difference 
between the power rail currents. 

The gm equations are given in the listing below The net gm is used to estimate THD.

 

Figure 14.1a. Push-pull Common Emitter output stage voltage drive (Re1=33R, Re2=330m, 
Red=SPICE).  Vsp stepped 480mV, 580mV, 630mV, 680mV, 780mV, 880mV. Right zoom shows 

detail is replicated by the equation solution

 14.2 Darlington Equations for current drive
[under construction]
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{Vpos}

{Re1}

{Vneg}

{2*Vsp}

{Re2}
{2*Vsp}

{RL}

Q1

Q2
Q4

Q3

{Re3}

{Re4}Rin2G1

{2/(Re3*Beta1*Beta3)+1/Rin2}

Vout2

Vin

In a typical amplifier if the preceding stage is common emitter then it will have a relatively high 
output resistance and this can be represent by Rin shunted to common and a current source driving 
to the base of Q1. Current source drive can be provided using the Norton equivalent Iin =Vin/Rin 

and with Rin shunted to common. The level of peak current needed is Iin pk=
Ic2 pk

Beta1⋅Beta3
.

The above equations for Ic1 and IC2 with current drive become 

Ic3= N⋅Vt
Req

W (exp( A1(Vsp+Iin⋅Rin−Vk2)−Vo2
NVt ))  and 

Ic1= N1⋅Vt
Re1+Rep1+Rbp1/ Beta1

W (exp( 2⋅Vsp+ Iin⋅Rin−Vk1
N1⋅Vt ))+ Ic3

Beta3  where terms for Req 

derive from the basic CE Push-Pull output stage with Rin included (which involves a 'switch'). Ic1 
terms were been defined above for voltage drive except the Iin·Rin is the equivalent input voltage.

Figure 14.1b shows the Push-Pull CE Darlington with current drive and Rin stepped 1m, 1k and 
10k with Re1=33 and Re3=330mR. This only shows the LTspice plots since equations for the 
Darlington pair have not been entered into the circuit file (Fig 14s1s2). The current source G is 
programmed using {2/(Re3*Beta1*Beta3)+1/Rin} (for Q1/Q3 pair) to give similar peak gains. This 
plot shows there is significant nonlinearity due to the base-emitter resistors. 

-3. 0V -2. 4V -1. 8V -1. 2V -0. 6V 0. 0V 0. 6V 1. 2V 1. 8V 2. 4V 3. 0V
-1Ω0. 0

-1Ω0. 5

-1Ω1. 0

-1Ω1. 5

-1Ω2. 0

-1Ω2. 5

-1Ω3. 0

-1Ω3. 5 d( I (RL2))

 Figure 14.1b. Push-pull Common Emitter output stage with current drive. Re1=33, 
Re3=330mR. Rin stepped 1m, 1k and 10k, Beta Q1=150 & Q3=100. (Red is SPICE).
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-3. 0V -2. 4V -1. 8V -1. 2V -0. 6V 0. 0V 0. 6V 1. 2V 1. 8V 2. 4V 3. 0V
-1Ω0. 0

-1Ω0. 5
-1Ω1. 0
-1Ω1. 5
-1Ω2. 0

-1Ω2. 5
-1Ω3. 0
-1Ω3. 5
-1Ω4. 0
-1Ω4. 5
-1Ω5. 0

-1Ω5. 5
-1Ω6. 0 d( I (RL2))

 Figure 14.1c. Push-pull Common Emitter output stage with current drive. Re1=33k (for 
negligible effect), Re3=330mR. Rin stepped 1m (lower), 1k and 10k (upper), Beta Q1=150 & 

Q3=100 & no Beta-fall. (Red is SPICE).

Figure 14.1c shows the same Push-pull Common Emitter output stage with current drive but with 
Re1=33k to see its effect on linearity when Rin is stepped 1m (lower), 1k and 10k (upper). When 
Re1 is made deliberately very high (effectively removed) the effect of a high source resistance can 
be seen, here Beta1*Beta3*Re3  ≈ 3k3 (for Q1/Q3 pair), so 1k is still partly voltage drive (and not 
linearity is affected much) but when Rin=10k the effect of current drive becomes apparent. 

Both Figure 14.1b (Re1=33R) and Figure 14.1c (Re1=33k) show the the Darlington driver 
introduces significant nonlinearities when the source resistance is greater than Beta1*Beta3*Re3 
(for Q1/Q3 pair) for current drive to begin. Changing Re1 (Q1 emitter resistor) does not provide 
any relief of nonlinearity when Rin is large. 

An alternative, Locanthi emitter resistor arrangement, where Re1 and Re2 are coupled and not 
connected to the output node (ground or common here), may provide some relief since the driver 
transistors operate in Class-A and do not turn off after the crossover region for Q3,4 is passed (the 
Locanthi circuit is not included in PAK at this stage).

Another alternative, is to driving the CE output stage with a high current buffer to ensure the output 
pair are voltage driven as a Basic output stage (Section 12.1). This option is explored in a Linear 
Audio article [ref 19, L|A Vol.4]. With the floating supply of the Basic CE output stage the buffer 
driving Q3,4 does not need a high voltage supply since only 1-2 volts are needed for the full output 
current swing. Also only about 200mA is needed to drive an output transistor to 10A – the practical 
limit for a single 15A power transistor. This means the buffer could be a high current opamp such as 
the HA5002. A discrete version could use a pair of MOSFET's in class-A to remove the Beta 
dependency on Rin with bipolar drivers. 

The standard Darlington is fine for voltage driven output stages (which usually means using Triple 
Darlinton's) but the Darlington pair deteriorates if the source resistance gets too high (ie much 
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above Beta1*Beta3*Re3 (for Q1 and Q3 pair)

14.2 Basic push-pull CE amplifier with current drive and Beta-fall 
[under construction]
In power amplifiers the current gain of the power transistors can have a significant effect on the 
distortion generated when the source resistance Rin is significant. This section includes the effect of 
Beta variation at high and low currents using similar equations to Gummel-Poon but modified to 
include local feedback (degeneration) by the emitter resistance Re and the source resistance Rin. 

Fig 14.2 shows the effect of both Rin and Beta-fall in circuit Figure 12.1. The effect of Beta-fall is 
made very obvious when Rin is increased. Figure 14.2 is the over-biased case while Figure 14.2a 
shows the underbiased case. 

The accuracy of the equation solution is very good for high Rin, to better than 1%. At very small 
Rin the equations deviate by 3% (seen in upper Gm and lower IL plots in Figure 14.2). 

Figure 14.2. Over-biased plots with high current Beta-fall, Rin stepped 33mR (U), 33R (M) 
and 3k3 (L). IKF=4A, Vsp=740mV (Iq=280mA). LTspice Red gm, Ic1 green & gm1 of Q1 

blue. At high Rin calculted gm1 error prevents low current Beat-fall (a more accurate method 
is needed).
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Figure 14.2a. Under-biased with Beta-fall and Rin stepped 33mR (U), 33R (M) and 3k3 (L). 
IKF=4A, Vsp 540mV (Iq=4mA). Red LTspice gm. High Rin only reduces the gain variation in 

the crossover region. See crossover region detail below.

Figure 14.2b. Same as above showing high Rin crossover region detail. With Rin or 3k3 the 
crossover nonlinearity is almost removed by current drive. Amazing!

There are no Beta-fall equations in the PAK V1.0 circuit files or in the PAK spreadsheet. The above 
plots were generated from early equations and need updating.

 15. THD analysis using Lambert W equations 
 15.1 Low order Harmonic Distortion calculated from gain error
Section 4.2c (Estimates of Distortion HD2 and HD3) explained how Ed Cherry's equations using 
trigonometric expansions of a sinewave multiplied by simple nonlinear functions can be used to 
calculate the 2nd and 3rd harmonic levels from the gain values found at the peak of the sinewave 
input. Unfortunately these are the only two harmonics that can be calculated directly as independent 
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variables from the peak gain deviations [ref 10 Howard Stereophile April 2006].

 15.2 Crossover distortion calculated from gain error at peaks
Since the Lambert W solutions provide explicit functions for all the derivatives it may be possible 
to use the first say m derivatives expressions to solve each harmonic level up to the mth harmonic by 
using a similar approach to Peter Baxandall in his article 'Audio Power Amplifier Design Pt. 6' 
[Wireless World Jan 1994, reprint available from LinearAudio.net]. It may be possible now to write 
a general expression for each harmonic as a function of the input level of a circuit without the high 
memory workload of FFT. Goal seeking can then be applied in a spreadsheet to minimise high order 
distortion in a general power amplifier circuit. For a tentative outline of this method see Section 
15.5.

Until then a simple way has been devised to estimate crossover distortion in Class-AB amplifiers. 
Crossover distortion creates high order distortion at full output voltage and progressively becomes 
lower order distortion as the output swing reduces, and eventually creates low-order Class-A 
distortion when the swing is small enough that the peak current is not more than twice the quiescent 
current. As mentioned, the Lambert W-function solutions for transistor currents give both current 
and gain (gm) in explicit form it is possible to estimate the distortion as THD from the distortion 
energy contained in the deviation from linearity as a fraction of the total energy. 

The total energy is related to the average area under the gm curve and since current is the integral of 
gm area then the current at the peak of the sinewave input is the average area of the nonlinear gm 
curve. Next, the gm at the peak of the sinewave multiplied by the peak input voltage gives a current 
that is different to the actual current at the same peak and this arises because of nonlinearity 
somewhere in the gm curve. The difference between these two current must be related to the 
distortions RMS current. If we assume there is a constant in this relationship then we can write

 THDest=SF⋅∣I pk−Gm⋅Vin pk

I pk
∣ or THDest=SF⋅∣1−

Gm⋅Vin pk

I pk
∣ . 

The absolute value is used to ensure THD is always a positive value (since it is related to ratios of 
power). The scale factor (SF) can be found using simulations and is approximately [YTBD]. 

One problem with this estimate for THD is at optimum bias THDest becomes zero and not a finite 
small value as in actual circuits. The estimate can be improved by adding an offset voltage (HD0) 
and vector summing these so the offset does not affect higher distortion estimates. We then use

 THDest=√(HD0
2+SF⋅(1−

Gm⋅Vin pk

I pk ))
2

where HD0 can estimated from the area under the zero crossing gain 'blip' (as seen in Figure 12a 
middle curve) using 

HDo≈0.5V T∣1−#Pr /(Re1+Re2)/2
GmT 0

∣ if #Pr /(Re1+Re2)/2>GmT 0  else HD0=0 

and term GmT0 is the total gm at the zero crossing, and 1/Re gives the approximate maximum gm at 
high currents, so when #Pr /(Re1+Re2)/2>GmT 0  the quiescent current is high enough to give a 
central gain 'blip in a wingspread plot and thus a null in the original THDest . The factor 0.5VT is an 
empirical scale factor found to fit the THD minimum distortion at optimum bias and this value is 
found by simulations.

The above approach can be refined to first calculate HD2 and HD3 distortions using the gain 
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deviations at the peaks then subtract these (using RMS means) from the THDest values above to give 
the remainder of harmonics for the 4th and higher.

 15.3 Weighting Harmonic Distortion [Under construction]
Crossover distortion generates a distribution of harmonics than vary in a complex way with the 
quiescent current and the output swing fraction of the maximum swing before clipping. It has been 
found that a different scale factor (w-SF) can be applied to the above THDest approach to estimate 
the weighted distortion. The weighted scale factor w-SF appears to be about 30 times the SF for 
unweighted THD estimates, but it can vary from circuit to circuit and the weighting method chosen 
[ref 19 L|A Vol 4]. More work is needed to find general equations for simple weighted THD 
estimates (w-THDest).

The equations used in PAK spreadsheet version 1.0 are only roughly scaled to demonstrate the 
method – the values should be found from spice simulations from the circuit files provided with 
PAK. 

Figure 15.3a is an example calculated THD and weighted-THD distortions at optimum quiescent 
current of 90mA. Note THD is calculated for each input voltage step. The weighted-THD is the top 
curve that is almost flat until small input levels then falls. The unweighted THD rises with reducing 
level, peaks and then falls at low levels. The wieghted-THD correlates better with the level of 
distortion that we hear.

Figure 15.3a shows calculated THD and weighted-THD distortions at optimum quiescent 
current of 90mA. Note THD is calculated at each input voltage step. SPICE does not plot 

multiple THD's like this.

 15.4 Spreadsheet example – Calculated THD and TLD 
The following is an example where crossover distortion is calculated in a Basic output stage with 
voltage drive. The aim in this case was to calculate the amount of distortion increase when the 
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output stage power dissipation changes with RMS input level changes typical of music. This 
variation is call Thermal Lag Distortion (TLD) due to the temperature lag of the bias voltage 
generator compared to the output transistor's junction temperature.

The thermal calculations are largely based on Bob Cordell's book Chapter 14 “Output stage thermal 
design and stability” p277-313 [ref 11]. 

An example is provided in Sheet 15 of PAK v1.0 spreadsheet (2nd block). There is no related 
LTspice circuit file with the V1.0 release pack. The spreadsheet has the rows compressed back to 
the minimum (5 rows) to reduce the spreadsheet file size (since there are so may equations in this 
example).

The first block in Sheet15 demonstrates the use of THD in a Basic output stage with voltage drive. 
It differs from sheet 12 in that currents and gains are estimated at both the (+) and (-) sinewave 
peaks – this is necessary to generate a symmetrical THD plot when the gain plots may be 
asymmetrical due to transistor mismatch etc. This can be demonstrated if you change Re1 (Re+) to 
say 0.5 and leave the other at 0.33. The gm plot now has a step in the crossover region but the THD 
plot remains symmetrical. That's how it needs to be and this requires twice the number of equations 
in each block to do this.

While we are on THD plots the weighted THD plot is seen were to be basically flat over the range 
of swept input voltages (ie the full range of output power). Return the emitter resistors back to 0.33 
each and you will see the unweighted THD increases quite a lot as the input level falls, and peaks at 
about 0.1V input (quite a low power), then falls to zero at even lower power (due to Class-A in this 
region). Now comparing the trend of the weighted THD plot and the unweighted THD plots we find 
the weighted plot is close to how our ear hears this crossover distortion (being not much affected as 
the power level falls) and the unweighted THD plot does not correspond with our listening 
experience and gives an erroneous indication of how good an output stage sounds. For more on 
weighting of crossover distortion in simulations see the Linear Audio article on this [ref19 LA V.4].

Now to the second block that does the TLD calculations. This is done in two sections; first THD 
and w-THD are calculated same as the previous block discussed above. This gives the base line 
distortion before the bias generator is destabilised by a thermal step change.

The second section calculates the thermal model values. You set the music power level (dB) before 
the step and the step size (dB) in cells EH62 and EI62 receptively. The equations then calculate the 
power dissipations before and after the step, then the temperature changes and the bias voltage 
changes. These values depend on the speaker sensitivity (which you can set) and the supply voltage 
and speaker resistance. 

Then the distortion changes are calculated. Also calculated is the amount of negative feedback that 
you need to provide to ensure the THD is reduced below a threshold level in column HO which is 
calculated to roughly fit our hearings threshold to the 2nd harmonic of a 50Hz fundamental at 
different SPL levels.

The weighting factors used for THD and w-THD estimates has not been checked against LTspice 
distortion simulations for PAK v1.0. The equations are provided as an example of how TLD can be 
calculated and plotted. For example, the plot provided (once the rows are expanded back to row 
102) shows the effect of trying to minimise TLD by choosing the best Vspread. 
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Some designers have suggested that TLD can be mitigated by slightly over-biasing the output stage 
when in steady-state so a thermal step does not lead to severe underbiasing situation [ref 11 Cordell 
Book p187?]. But if the over-bias is too much then you get more distortion in steady-state than 
during the occasional step change in music level. And how big (or small) a step change do you need 
for TLD to raise distortion? And how does our TLD choices change when we use weighted THD 
rather than unweighted THD? This spreadsheet is able to give answers and insights into to most of 
these questions.

It was found that the modern TO-264 packages (contact area 317mm^2) have relatively low thermal 
resistances compared to earlier power transistors of the 1970's to 1990's including the TO-3P TO-
247 (183mm^2). This significantly reduces the thermal step size, even to the extent that TLD is 
almost so small that it now does not need complex simulations or these calculations. But it is always 
useful to be able to see whether it is or isn't an important consideration in your particular design. So 
the simulation or calculation exercise is still worthwhile. It gives a feel for what is significant and 
what isn't for designers.

Some notes on the TLD spreadsheet equations:
Notes on calculations Sheet15 2nd block: 
1. 'Vin Sine' (O60) is by an equation from the section where the initial power is set (as 'dBpre' 

mentioned below). Do not enter a value into this 'Vin Sine' column.
2. 'dBpre' (EH60) Set the dB level for the [heat up] phase of the heatsink. This setting should 

be less than or equal to the suggested 'dBnoClip' (EH or EI) levels (for sine or music). You 
can also set dBpre = dBnoClip + dBStep to give a reversed step situation (lower power to 
higher power).

3. 'MusicPDF' (EM60) is preset at 8dB as recommended minimum but can be changed to say 
-16dB for classical (orchestral) music to check for differences between music material.

4. 'ScaleHS' (DQ60) Set a scale factor for a practical heatsink eg ~2x for 6R loading but 
determine this by setting RL to 4R and note how Rsa changes, ScaleHS= Rsa(8R)/Rsa(4R). 
Alternatively, change ScaleHS for acceptable TouchMax.

5. The output transistors are MJL21193/4 and the number of pairs can be set in '#Prs' (U60). 
This can influence the sizing of the heatsink (see below).

6. 'TouchMax' can be set to ensure the heatsink rating required is not too small that it may burn 
someone who touches it. Set this high if you want to disable this.

7. 'StableH?' and 'StableC?' determine whether the thermal loop is stable if the temperature 
sensor is mounted on the power transistors case (ThermalTrak) or on the heatsink (non-
ThermalTrak transistors). If it is not stable then you can increase Re for thermal stability 
(and then maybe increase the number of pairs). Thermal stability is determined directly by 
the supply voltage (Vpos & Vneg).

8. 'TjhPost' (EY60) and 'TjcPost' (FJ60) are separate calculations for ThermalTrak and non-
ThermalTrak transistors. THD calculations are set to non-Thermal Trak devices by using 
Vsp+Hpost' in 'Arg+' (GE60) equation. For ThermalTrack distortion calculations instead 
change to 'Arg+' (GE60) equation to reference Vsp+Cpost.

 15.5 Harmonic analysis of BJT amplifiers using Lambert W
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The following is based on Peter Baxandall's article 'Audio Power Amplifier Design Pt. 6' [Wireless 
World Jan 1994 reprint from LinearAudio.net]. His harmonic distortion analysis of a BJT common 
emitter amplifier is extended to allow general harmonic distortion analysis for the nth harmonic 
using the Lambert W-function. 

The Lambert W-function can provide an explicit solution for BJT amplifiers (see the PAK project 
user Guide) and the Lambert W-function allows the nth derivative to be expressed as a polynomial in 
terms of the solution for the current (in other words, having solved a circuits current using the 
Lambert W-function all the derivatives can also be written from this equation).

The following are the equations given in Peter Baxandall's Pt.6 article:

Ic= Is exp(Vbe
Vt )  (125)

where 'Is' the for base emitter junction diode which determines the collector current. 
In his CE circuit

vout=−RL I q(exp Vin
Vt )⋅exp(β vout

Vt )  (126)

where β is the feedback factor . To obtain the harmonic levels he proposed using the power series
vout=a1 vin+a2 vin

2 +a3vin
3 +…  (127)

And using Maclaurin's theorem to find the coefficients

a1=∣ dvin
d vin∣v in=0

 a2=∣d 2 vin

d vin
2∣vin=0

 etc (128)

These Maclaurin's terms are applied to Eq 2 and equating gives the following coefficients for (3)

a1=
Av

1−β Av
and a2=

1
2!( 1

Vt )
1 Av

(1−β Av )3
and (129)

a3=
1
3!( 1

Vt )
2

AV{ 1
(1−β Av )

+
3∣β Av∣

(1−β Av)
2−

3(β Av)
2

(1−β Av)
3 +

∣β Av∣
3+3∣β Av∣

(1−β Av )
4 −

3(β Av)
2

(1−β Av)
5}  (130)

So we can write the individual harmonic levels if we expand the (Vpk/Vm)^msin^m wt terms in (3)

vout=b1( v pk
Vm )

1

sin (ω1 t)+b2( v pk
Vm )

2

sin(2ω1 t)+…  (131)

We need to find each bn so we multiply the relevant derivative values by the relevant harmonic level 
of sin^m wt and add them all up, the general nth harmonic level is

bn=∑
i=0

m

c i⋅ai  (132)

when m is even only need to use even i, and vice versa and stop at m since there are no higher 
harmonics from the expansion of sin^m wt (m is an integer).

The coefficients of the expansion of sin^m wt can be expanded and written as 
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sinmω t=∑
i=0

m

c isin (iω t)  (133)

Where the coefficients ci have been found using FFT up to m=100 (and to the 100th harmonic). They 
can be arranged into a m×m sparse matrix of coefficients as a library file and called when harmonic 
analysis is required.

For audio power amplifiers with 50Hz fundamental we want to weight the harmonics up to around 
5kHz or the 100th harmonic. The weighting factor can be 1/4.59×n^2.2 for the nth harmonic which can 
be applied to equation 7 (or equation 8).

The coefficients ci are all zero for all odd harmonics when power m is even and vice versa 
coefficients are zero for all even harmonics when m (power) is odd. There are no harmonics above 
the mth harmonic for power m. Separate tables can therefore used for odd and even harmonics. 

Table 1. For odd m powers (m=1,3,5,7,9) and there is no dc component
m↓ f1 f3 f5 f7 f9 f11
1 1 0 0 0 0 0
3 0.75 -0.25 0 0 0 0
5 0.625 -0.3125 0.0625 0 0 0
7 0.5569 -0.3281 0.1094 -0.01562 0 0
9 0.4922 -0.3281 0.1406 -0.03516 0.003906 0

Table 2. For even m powers (m=2,4,6,8,10, 20) where there is also a dc component (f0)
m↓ f0 f2 f4 f6 f8 f10
2 ½ -j½ 0 0 0 0
4 0.375 -j0.5 j0.125 0 0 0
6 0.3125 -j0.4687 j0.1875 -j0.01325 0 0
8 0.273437 -j0.4375 j0.2187 -j0.0625 j0.007812 0
10 0.246094 -j0.4102 +j0.2344 -j0.08789 +j0.01953 -j0.001953

where the j operator denotes a 90° phase shift.

m↓ f0 f2 f4 f6 f8 f10
20 0.176197 -j3.204e-01 +j2.403e-01 -j1.479e-01 +j7.393e-02 -j2.957e-02

cont - f12 f14 f16 f18 f20
- +j9.241e-03 -j2.174e-03 +j3.624e-04 -j3.814e-05 +j1.907e-06

Figure 1. FFT spectrum for sin^20 wt for 1kHz fundamental
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Figure 2. FFT spectrum for sin^100 wt for 1kHz fundamental
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Note how sin^100 wt harmonic levels become vanishingly small by the 50th harmonic and being 20dB 
reduced by the 20th harmonic then reducing at a fast rate. 

Now the application of the Lambert W-function. The Common Emitter circuit has a Lambert W-
function solution for Equation 2 which allows all the derivatives to be expressed in explicit form 
from as a finite series as provided by RM Corless [ref AdvCompMath, RM Corless, On-the-
Lambert-W-function, Aug-1996] his equation 3.5, 3.6 as

d nW (exp( x))
dxn =

qn⋅W (exp (x ))

(1+W (exp (x )))2n−1  n≥1 (134)

where coefficient qn is

qn(w)=∑
k=0

n−1

(n−1
k )(−1)k wk+1   n≥1 (135)

The first derivative is n=1 (LHS) is compared to Baxandall's a1 in Equation 5 (RHS)

d W (exp( x))
dx =

qnW (exp (x ))

1+W (exp( x))
 ↔ a1=

1
β

β Av
1+β∣Av∣

(136)

The second derivative is n=2
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d 2W (exp(x ))

dx2 =
qn W (exp( x))

(1+W (exp (x )))3
 ↔ a2=

1
2!( 1

Vt )
1 1
β

β Av

(1+β∣Av∣)3
(137)

The details for coefficient qn are not sorted as yet but this comparisons show the general form of the 
Lambert W-solution provides the polynomial for evaluating derivatives for a general BJT circuit. 
Therefore the distortion for the nth harmonic can now be obtained (in principle) without using 
specific component values and FFT. 

This will be useful with weighted distortion analysis of power amplifier circuits where harmonics 
from the 7th and above are considered to be non-musical and need to be below the threshold of 
audibility. It is therefore possible to obtain equations for the level of harmonics from the 7th and 
above. This may be easiest by calculating the RMS value for the first 6 harmonics and subtracting 
this from the THD (from gain deviation and peak current) to give the residual for all harmonics 
from the 7th harmonic and above. The first 6 harmonics only requires 14 ci coefficients and the first 
6 derivatives (a1 to a6) which is still doable in a non-macro spreadsheet format. A spreadsheet is 
useful for plotting specific cases without using a simulator and a MathLab package can be used for 
symbolic manipulation with the complicated harmonic level equations.

===================== =====================

Summary of useful features
PAK-1v0-NM 

• A simple and flexible framework for evaluating circuits involving bipolar transistors, such as 
audio power amplifier circuits
• Useful for teaching audio power output stage circuit design and analysis
• Useful for comparing and contrasting different audio power output stage topologies
• Useful for distortion analysis of different audio power output stages
• Useful for thermal analysis of different audio power output stages
• Useful for hybrid circuits using BJT's and MOSFETs and/or valves (tubes)
• Useful for integration into SPICE to overcoming BJT model non-convergence problems.

===================== =====================
[end of Chapter]
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 Appendix A
Various topics

Contents:
1. General solution for  pax+b=cx+d or ax+b=logP (cx+d ) .
2. A General solution for ye y2

=x  (a call for further info).
3. Proof that a CFP circuit is not solvable using ye y=x with overall feedback.

 A1. Appendix A1
General Lambert W-inverse solution from Wikipedia

2. From http://en.wikipedia.org/wiki/Lambert_W-function the general solution for 
 pax+b=cx+d or ax+b=logP (cx+d )  (A11)

 
x=−W

(−a ln p
c ⋅p

b−ad
c )

a ln p − d
c

(A12)

For exponentials p=e so the general solution for eax+b=cx+d or ax+b=ln(cx+d )

=> x=−1
a W (−a

c ⋅e
b−ad

c )− d
c

=>
x=−1

a
W (e

bc−ad−c ln(−c
a

)

c )− d
c

(A13)

----------------------- --------------------------
 A2. Appendix A2
The page at http://mathworld.wolfram.com/LambertW-Function.html includes a reference to 
Gosper, R. W. Jr. "The Solutions of ye y2

= x  or ye^(y^2)=x and ye^y=x." ACM SIGSAM Bull. 32, 8-
10, 1998). 

The solution to 

ye y2
=x  (138)

may be helpful for solving circuits. In the log form it looks like 
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y2=ln( x
y )  (139)

It would be helpful if someone can obtain details of this solution for this project (see Feedback). 
------------------------------- --------------------------

 A3. Appendix A3
Proof that a CFP circuit is not solvable using ye y=x with overall feedback

A lemma (proof) that the Common Emitter Complementary Feedback Pair in closed loop and with 
Rbe can't be solved exactly using the standard Lambert W-function ye y=x .

Q1

Re

VccQ2
PNP

X2

Vin

Ve

Rbe

Ic2NPN

Figure A1. Complementary Feedback Pair closed loop with Rbe for Q2.

With Rbe absent Beta2 for Q2 can be assumed linear. But when Rbe is present the feedback voltage 
Ic2·Re is now a nonlinear function of Ic1. Repeating the steps in Section 5.2 but with this nonlinear 
function of Ic1 we eventually find that the equations for this cascaded solution being a Lambert-
inside-a-Lambert cannot be balanced. It ends up that we get a residual nonlinear term of the form 
Rbe·ln(Ic2·Rbe/Beta2) that cannot be removed from the RHS so the equation cannot be balanced 
and therefore conclude a Lambert W-inverse function cannot be used to solve this circuit in exact 
form when overall feedback is present around two stages and each stage is only solvable using a 
Lambert W-inverse. 

An exact solution is still available in open loop where each stage has its own local feedback loops 
and their own Lambert W-inverse solutions. But when global feedback is used there is a modulation 
of the otherwise constant Req term of a Lambert W solution and this appears to be due to the action 
of overall feedback (the modulation can be seen in the approximation used for the approximate 
solution in Section 5.3. This gives an insight for those who need to formulate approximations for 
circuits involving overall feedback with two or more transistors

The steps involved in the proof are given below. With the NFB link 2 closed we get in the log form 
w=ln(x/e) 
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 ( Ic1+ Is1) R e
N1⋅Vt

=ln(exp(Vin− Ic2⋅R e−Vk1
N1⋅Vt )

( Ic1+ Is1) R e
N1⋅Vt

)  and (A1)

( Ic2+ Is2) Rbe /(Beta2+1)
N2⋅Vt

=ln( exp( Ic1⋅Rbe−Vk2
N2⋅Vt )

( Ic2+ Is2) Rbe /(Beta2+1)
N2⋅Vt

)  (A2)

we want to move Ic2 out of Equation (A1) into the LHS of Equation (A2) and then balance 
Equation (A2) giving Ic2 in terms of Ic1. To do this first use Equation (A2) to solve Ic1 in terms of 
Ic2. Rearranging into the w+log(w) form we get 

( Ic2+ Is2) Rbe /(Beta2+1)
N2⋅Vt

+ln(( Ic2+ Is2) Rbe /(Beta2+1)
N2⋅Vt )=( Ic1⋅Rbe−Vk2

N2⋅Vt )  so (A3

Ic1CL=
N2⋅Vt
Rbe (( Ic2+ Is2) Rbe /(Beta2+1)

N2⋅Vt
+ln(( Ic2+Is2) Rbe /(Beta2+1)

N2⋅Vt )−Vk2) (A4)

Substitute Ic1CL into Equation (A1) gives

( Ic1Cl ( Ic2)+ Is1) R e
N1⋅Vt

=ln(exp(Vin− Ic2⋅R e−Vk1
N1⋅Vt )

( Ic1CL( Ic2)+ Is1) R e
N1⋅Vt

)  (A5)

We have now eliminated Ic1 in (A5) giving a single equation relating Ic2 in terms of Vin. 

We note Ic2 on the RHS now needs to be moved to the LHS and merged with other Ic2 terms. Then 
we work at balancing in the w=ln(x/e) form. Once balanced we can identify w and x terms to solve 
for Ic2 in terms of Vin. 

We can work on expanding (A4) in (A5) only on the LHS (since the denominator is identical)

LHS=(( N2⋅Re
N1⋅Rbe ( Ic2 ' Rbe /(Beta2+1)

N2⋅Vt
+ln( Ic2 ' Rbe /(Beta2+1)

N2⋅Vt )−Vk2))+ Is1)  (A6)

Where Ic2'=Ic2+Is2 for brevity. Now bringing -Ic2·Re/(N1·Vt) from the RHS into (A6) gives a 
modified LHS

 (A7)

Let k=(1 + Rbe/(N2·Vt)). We are trying to balance an equation in the form 

k⋅a⋅I2+ln (b⋅I2)=ln( x
a⋅I2+ln (b⋅I2))  (A8)

where the LHS 'a' term has been scaled by k. We want a 'k·a' term on the RHS and since from 
previous cases we multiply numerator and denominator by some factor we get the form
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k⋅a⋅I2+ln (b⋅I2)=ln( k⋅x
k⋅a⋅I2+k⋅ln (b⋅I2))  (A9)

And now we need to change the LHS to k·Ln(b·I2) by substituting Ln(b·I2)=Ln(k·b·I2)–Ln(k), so 

k⋅a⋅I2+ln (k⋅b⋅I2)=ln( k⋅x
k⋅a⋅I2+k⋅ln (b⋅I2))  (A10)

But this cannot lead to a form that can be expressed as w=ln(x/w) using linear algebra. Therefore 
the Lambert W-inverse cannot provide a solution for this circuit in an exact form. The Wikipedia 
site on the Lambert W-function (at present) shows there is a general solution which does not include 
a log-inside-a-log (a composite-function or a function-of-a-function.

----------------------- --------------------------
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PAK SPREADSHEET USER GUIDE -  INDEX 
 Index 
A ABM (LTspice 

functions) p24,29, 
32, 51,61,67,74,92, 
95-98,101-3,108-9

Algebra p36,133 Amplifier 4,12, 
35,43,44,51,54, 
65,82,99,109, 
112,124

Analytical p4,42, 
87,128

Approximations 
p4,42,62,72,73, 
107,104

Audio 
p12,36,127 
see 
LinearAudio

B Balancing p36,67, 
72,76,132

Banwell p4,35,58, 
60,93

Beta-fall p11,28, 
35,47,51,54,56,*

Bipolar Blomley

C Calculate Cascade p72,131 Cherry p63,123 Class-A p82,114, 
121,124,125

Class-AB p42-
44, 63,82,110, 
114,124

Class-B see 
Class-AB 99 
104,109,113

Complementary Corless p41 Cordell Audio Crossover Current-driven

D Darlington Designing Differential pair Dissipation Distortion Douglas Self 
p111

E Estimates of THD 
63,89,189

Explicit equation 
p35,50,62,72,124

Exponential Extraction

F Faran p110,111 FFT p62,124

G Global feedback p4, 
12,21,72,84,131

H Harmonic Hawksford p110 Hearing Heatsink High-impedance High-power

HF analysis 12,36 Howard, Keith124 Hybrid PA p127

I Insights p4,43,109, 
126,131

Integral

J
K
L Lambert p4,35-8 

41,42,44,45,49-
55,59,62,63,65,*

Loudspeaker LTspice 2,10,23, 
27,30-32,36,40-
47,62,108,109

Lin (Topology) 
p82

Linear Audio 
(bookzine) p2, 
121,125

M Mills MJL21193 Modeling MOSFET

N Naughty (Euphonic 
Distortion) p124

Non-convergence 
p4,57,127

Nonlinear

O Optimum Bias -AB 
p103,105

Orchestral music 
PDF p106

P Pairs (transistors) Patent see 
Blomley Ref.14

Push-Pull Reliability Residual error 
p4,131

Runaway 
(thermal) 
p94,128

Q
R
S SIGSAM p130 Simulate Solution Solvable Sounds Square-Law 

p34,44

Stability p111,112, 
117,125

Steady-state 
p36, 126

Stereophile 
(Howard) p124

Subcircuit 
p57,129

Subthreshold 
ref. 20

T Teaching circuit 
analysis p4,14,127

Temperature THD analysis 
p123-129

THD estimates 
p63,89,189

ThermalTrak 
p39, 127,128

Thermal 
runaway 
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p94,128

Topologies Triple Darlington

U Underbiasing Unweighted 
p105,125, 126

V VAS p33,36,54, 64, 
82-4, 106,111

W Weighted p105-7, 
117,125,126

W-THD p125,126 Widlar p93,128 Wilson p11,35,95 Wikipedia 4,12, 
36,40,44,128, 
130,133

X
Y
Z
*(cont) Beta-fall p11,28, 35,47,51,54,56-58,64,99,105,106,109,110,112,113,117, 122,123.
* (cont) Lambert p4,35-8,41,42,44,45,49-55,59,62,63,65,72,73,76,77,79,83,85,92,93,103,104,107-
110,114,123,130,131,133.
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